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these terms and conditions, return the product, unused and in the original shipping container, within 30 days o
purchase to obtain a credit for the full purchase price.

1. License Grant. Nortel Networks NA Inc. (“Nortel Networks”) grants the end user of the Software (“Licensee”
personal, nonexclusive, nontransferable license: a) to use the Software either on a single computer or, if applic
a single authorized device identified by host ID, for which it was originally acquired; b) to copy the Software so
for backup purposes in support of authorized use of the Software; and c) to use and copy the associated user
solely in support of authorized use of the Software by Licensee. This license applies to the Software only and d
extend to Nortel Networks Agent software or other Nortel Networks software products. Nortel Networks Agent
software or other Nortel Networks software products are licensed for use under the terms of the applicable No
Networks NA Inc. Software License Agreement that accompanies such software and upon payment by the end
the applicable license fees for such software. 

2. Restrictions on use; reservation of rights. The Software and user manuals are protected under copyright laws
Nortel Networks and/or its licensors retain all title and ownership in both the Software and user manuals, inclu
any revisions made by Nortel Networks or its licensors. The copyright notice must be reproduced and included
any copy of any portion of the Software or user manuals. Licensee may not modify, translate, decompile, disas
use for any competitive analysis, reverse engineer, distribute, or create derivative works from the Software or 
manuals or any copy, in whole or in part. Except as expressly provided in this Agreement, Licensee may not c
transfer the Software or user manuals, in whole or in part. The Software and user manuals embody Nortel Ne
and its licensors’ confidential and proprietary intellectual property. Licensee shall not sublicense, assign, or oth
disclose to any third party the Software, or any information about the operation, design, performance, or 
implementation of the Software and user manuals that is confidential to Nortel Networks and its licensors; how
Licensee may grant permission to its consultants, subcontractors, and agents to use the Software at Licensee
provided they have agreed to use the Software only in accordance with the terms of this license.

3. Limited warranty.  Nortel Networks warrants each item of Software, as delivered by Nortel Networks and pro
installed and operated on Nortel Networks hardware or other equipment it is originally licensed for, to function
substantially as described in its accompanying user manual during its warranty period, which begins on the da
Software is first shipped to Licensee. If any item of Software fails to so function during its warranty period, as th
remedy Nortel Networks will at its discretion provide a suitable fix, patch, or workaround for the problem that m
included in a future Software release. Nortel Networks further warrants to Licensee that the media on which th
Software is provided will be free from defects in materials and workmanship under normal use for a period of 9
from the date Software is first shipped to Licensee. Nortel Networks will replace defective media at no charge
returned to Nortel Networks during the warranty period along with proof of the date of shipment. This warranty
not apply if the media has been damaged as a result of accident, misuse, or abuse. The Licensee assumes a
responsibility for selection of the Software to achieve Licensee’s intended results and for the installation, use, 
results obtained from the Software. Nortel Networks does not warrant a) that the functions contained in the so
will meet the Licensee’s requirements, b) that the Software will operate in the hardware or software combinatio
the Licensee may select, c) that the operation of the Software will be uninterrupted or error free, or d) that all d
in the operation of the Software will be corrected. Nortel Networks is not obligated to remedy any Software defe
cannot be reproduced with the latest Software release. These warranties do not apply to the Software if it has
altered, except by Nortel Networks or in accordance with its instructions; (ii) used in conjunction with another 
vendor’s product, resulting in the defect; or (iii) damaged by improper environment, abuse, misuse, accident, o
negligence. THE FOREGOING WARRANTIES AND LIMITATIONS ARE EXCLUSIVE REMEDIES AND ARE 
IN LIEU OF ALL OTHER WARRANTIES EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Licensee is responsib
for the security of its own data and information and for maintaining adequate procedures apart from the Softw
reconstruct lost or altered files, data, or programs.

4. Limitation of liability.  IN NO EVENT WILL NORTEL NETWORKS OR ITS LICENSORS BE LIABLE FOR 
ANY COST OF SUBSTITUTE PROCUREMENT; SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES; OR ANY DAMAGES RESULTING FROM INACCURATE OR LOST DATA OR LOSS OF USE OR 
PROFITS ARISING OUT OF OR IN CONNECTION WITH THE PERFORMANCE OF THE SOFTWARE, EVE
IF NORTEL NETWORKS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT
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SHALL THE LIABILITY OF NORTEL NETWORKS RELATING TO THE SOFTWARE OR THIS AGREEMENT 
EXCEED THE PRICE PAID TO NORTEL NETWORKS FOR THE SOFTWARE LICENSE.

5. Government Licensees. This provision applies to all Software and documentation acquired directly or indirectl
or on behalf of the United States Government. The Software and documentation are commercial products, lice
the open market at market prices, and were developed entirely at private expense and without the use of any 
Government funds. The license to the U.S. Government is granted only with restricted rights, and use, duplica
disclosure by the U.S. Government is subject to the restrictions set forth in subparagraph (c)(1) of the Comme
Computer Software––Restricted Rights clause of FAR 52.227-19 and the limitations set out in this license for c
agencies, and subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause of DFAR
252.227-7013, for agencies of the Department of Defense or their successors, whichever is applicable.

6. Use of Software in the European Community. This provision applies to all Software acquired for use within th
European Community. If Licensee uses the Software within a country in the European Community, the Softwa
Directive enacted by the Council of European Communities Directive dated 14 May, 1991, will apply to the 
examination of the Software to facilitate interoperability. Licensee agrees to notify Nortel Networks of any such
intended examination of the Software and may procure support and assistance from Nortel Networks.

7. Term and termination. This license is effective until terminated; however, all of the restrictions with respect t
Nortel Networks’ copyright in the Software and user manuals will cease being effective at the date of expiration
Nortel Networks copyright; those restrictions relating to use and disclosure of Nortel Networks’ confidential 
information shall continue in effect. Licensee may terminate this license at any time. The license will automati
terminate if Licensee fails to comply with any of the terms and conditions of the license. Upon termination for 
reason, Licensee will immediately destroy or return to Nortel Networks the Software, user manuals, and all co
Nortel Networks is not liable to Licensee for damages in any form solely by reason of the termination of this lic

8. Export and Re-export. Licensee agrees not to export, directly or indirectly, the Software or related technical 
or information without first obtaining any required export licenses or other governmental approvals. Without lim
the foregoing, Licensee, on behalf of itself and its subsidiaries and affiliates, agrees that it will not, without firs
obtaining all export licenses and approvals required by the U.S. Government: (i) export, re-export, transfer, or
any such Software or technical data, or any direct product thereof, to any country to which such exports or re-
are restricted or embargoed under United States export control laws and regulations, or to any national or res
such restricted or embargoed countries; or (ii) provide the Software or related technical data or information to 
military end user or for any military end use, including the design, development, or production of any chemica
nuclear, or biological weapons.

9. General. If any provision of this Agreement is held to be invalid or unenforceable by a court of competent 
jurisdiction, the remainder of the provisions of this Agreement shall remain in full force and effect. This Agreem
will be governed by the laws of the state of California.

Should you have any questions concerning this Agreement, contact Nortel Networks, 4401 Great America Pa
P.O. Box 58185, Santa Clara, California 95054-8185.

LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS AGREEMENT, UNDERSTANDS IT, AND 
AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. LICENSEE FURTHER AGREES THAT THIS 
AGREEMENT IS THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN NORTEL NETWORKS AND 
LICENSEE, WHICH SUPERSEDES ALL PRIOR ORAL AND WRITTEN AGREEMENTS AND 
COMMUNICATIONS BETWEEN THE PARTIES PERTAINING TO THE SUBJECT MATTER OF THIS 
AGREEMENT. NO DIFFERENT OR ADDITIONAL TERMS WILL BE ENFORCEABLE AGAINST NORTEL 
NETWORKS UNLESS NORTEL NETWORKS GIVES ITS EXPRESS WRITTEN CONSENT, INCLUDING AN
EXPRESS WAIVER OF THE TERMS OF THIS AGREEMENT.
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Preface

This guide describes asynchronous transfer mode (ATM) and what you do to
and customize ATM services on a Nortel Networks™ router.

You can use the Bay Command Console (BCC™) or Site Manager to configure 
ATM on a router. In this guide, you will find instructions for using both the BC
and Site Manager. 

Before You Begin

Before using this guide, you must complete the following procedures. For a n
router:

• Install the router (see the installation guide that came with your router).

• Connect the router to the network and create a pilot configuration file (se
Quick-Starting Routers, Configuring BayStack Remote Access, or Connecting 
ASN Routers to a Network).

Make sure that you are running the latest version of Nortel Networks BayRS™ and 
Site Manager software. For information about upgrading BayRS and Site 
Manager, see the upgrading guide for your version of BayRS.
308612-14.00 Rev 00 xix
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Text Conventions

This guide uses the following text conventions:

angle brackets (< >) Indicate that you choose the text to enter based on
description inside the brackets. Do not type the 
brackets when entering the command. 

Example: If the command syntax is:
ping  <ip_address>, you enter:
ping  192.32.10.12

bold text Indicates command names and options and text that
you need to enter.

Example: Enter show ip {alerts | routes }.

Example: Use the dinfo  command. 

braces ({}) Indicate required elements in syntax descriptions 
where there is more than one option. You must choo
only one of the options. Do not type the braces when
entering the command.

Example: If the command syntax is:
show ip {alerts | routes }, you must enter either:
show ip alerts or show ip routes , but not both.

brackets ([ ]) Indicate optional elements in syntax descriptions. D
not type the brackets when entering the command.

Example: If the command syntax is: 
show ip interfaces [-alerts ], you can enter either:
show ip interfaces or show ip interfaces -alerts .

ellipsis points (. . . ) Indicate that you repeat the last element of the 
command as needed.

Example: If the command syntax is:
ethernet/2/1  [<parameter> <value>] . . . , you enter
ethernet/2/1 and as many parameter-value pairs as 
needed.
xx 308612-14.00 Rev 00
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Acronyms

This guide uses the following acronyms:

italic text Indicates file and directory names, new terms, book 
titles, and variables in command syntax descriptions.
Where a variable is two or more words, the words are
connected by an underscore.

Example: If the command syntax is:
show at <valid_route>
valid_route is one variable and you substitute one valu
for it.

screen text Indicates system output, for example, prompts and 
system messages.

Example: Set Trap Monitor Filters

separator ( > ) Shows menu paths. 

Example: Protocols > IP identifies the IP option on th
Protocols menu. 

vertical line ( | ) Separates choices for command keywords and 
arguments. Enter only one of the choices. Do not typ
the vertical line when entering the command.

Example: If the command syntax is:
show ip {alerts | routes }, you enter either:
show ip alerts or show ip routes , but not both.

AAL ATM adaptation layer

ABR available bit rate

AFI authority and format identifier

AIS alarm indication signal

ALC adaptation layer controller

ARE ATM Routing Engine
308612-14.00 Rev 00 xxi
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ARP Address Resolution Protocol

ATM asynchronous transfer mode

BFE Blacker front-end encryption

B-ISDN Broadband Integrated Services Digital Network

BUS broadcast and unknown server

CLP cell loss priority

CPCS common part convergence sublayer

CS convergence sublayer

CSU channel service unit

DCE data communication equipment

DDN Defense Data Network

DSU data service unit

DTE data terminal equipment

ELAN emulated local area network

ER error recovery

FIB forwarding information base

HEC header error control

IETF Internet Engineering Task Force

ILI Intelligent Link Interface

ILMI Interim Local Management Interface

IP Internet Protocol

IPX Internetwork Packet Exchange

ITU-T International Telecommunication Union - Telecommunication
Standardization Sector

LANE local area network emulation

LDP label distribution protocol

LE LAN emulation

LEC LAN emulation client

LECS LAN emulation configuration server
xxii 308612-14.00 Rev 00
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LER label edge router

LES LAN emulation server

LIS logical IP subnet

LLC Logical Link Control

LUNI LAN emulation UNI

MAC media access control

MBS maximum burst size

MCR minimum cell rate

MCS multicast server

MIB management information base

MPC Multi-Protocol over ATM client

MPLS Multiprotocol Label Switching

MPOA Multi-Protocol over ATM

MPS MPOA server

MTU maximum transmission unit

NHRP Next Hop Resolution Protocol

NML Native Mode LAN

NMS network management station

NNI network-to-network interface

OAM Operations and Management

OAM&P Operations, Administration, Maintenance and Provisioning

OC-3 Optical Carrier-level 3

OSI Open Systems Interconnection

OSPF Open Shortest Path First

PCR peak cell rate

PD poll data

PDN Public Data Network

PDU protocol data unit

PHY physical [layer]
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PMD physical medium dependent

PT payload type

PVC permanent virtual circuit

RDI remote defect indication

RIP Routing Information Protocol

RS resynchronization

SAAL signaling AAL

SAP service access point

SAR segmentation and reassembly

SCR sustainable cell rate

SD sequenced data

SDU service data unit

SMDS Switched Multimegabit Data Service

SNAP Subnetwork Access Protocol

SNMP Simple Network Management Protocol

SONET/SDH Synchronous Optical Network/Synchronous Digital Hierarch

SPE synchronous payload envelope

SRM System Resource Module

SSCOP Service Specific Connection Oriented Protocol

SSCS service specific convergence sublayer

STP shielded twisted pair

SVC switched virtual circuit

TOH transport overhead

UNI user-to-network interface

UTP unshielded twisted pair

VBR variable bit rate

VC virtual circuit

VCC virtual channel connection

VCI virtual channel identifier
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Hard-Copy Technical Manuals

You can print selected technical manuals and release notes free, directly from
Internet. Go to support.baynetworks.com/library/tpubs/. Find the product for 
which you need documentation. Then locate the specific category and mode
version for your hardware or software product. Using Adobe Acrobat Reader,
can open the manuals and release notes, search for the sections you need, a
them on most standard printers. You can download Acrobat Reader free from
Adobe Systems Web site, www.adobe.com.

You can purchase selected documentation sets, CDs, and technical publicati
through the collateral catalog. The catalog is located on the World Wide Web 
support.baynetworks.com/catalog.html and is divided into sections arranged 
alphabetically: 

• The “CD ROMs” section lists available CDs.

• The “Guides/Books” section lists books on technical topics.

• The “Technical Manuals” section lists available printed documentation se

VCL virtual channel link

VPC virtual path connection

VPI virtual path identifier

WAN wide area network
308612-14.00 Rev 00 xxv
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How to Get Help

If you purchased a service contract for your Nortel Networks product from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact one of the follow
Nortel Networks Technical Solutions Centers:

Technical Solutions Center Telephone Number

Billerica, MA 800-2LANWAN (800-252-6926)

Santa Clara, CA 800-2LANWAN (800-252-6926)

Valbonne, France 33-4-92-96-69-68

Sydney, Australia 61-2-9927-8800

Tokyo, Japan 81-3-5402-7041
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Chapter 1
Understanding ATM,

ATM Router Redundancy, and OAM

This chapter describes the concepts underlying ATM and, where appropriate
specific ways Nortel Networks implements these concepts on its routers. It 
contains the following information:

Topic Page

ATM General Information 1-2

Classical IP over ATM Concepts 1-28

ATM LAN Emulation Concepts 1-33

ATM Router Redundancy Concepts 1-39

PVC Operations and Management Concepts 1-41

For More Information 1-43

Where to Go Next 1-44
308612-14.00 Rev 00 1-1
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ATM General Information

Asynchronous transfer mode (ATM) is a connection-oriented, cell-based 
technology that relays traffic across a Broadband Integrated Services Digital 
Network (B-ISDN). ATM provides a cost-effective way of transmitting voice, 
video, and data across a network.

ATM Cells

An ATM cell is a fixed-length packet of 53 bytes. It consists of a 5-byte heade
containing address information and a fixed, 48-byte information field. Figure 1-1 
shows a diagram of an ATM cell.

Figure 1-1. ATM Cell

This fixed-length cell size allows you to predict network delays, making ATM 
suitable for carrying real-time information (for example, voice and video) as w
as data.

ATM allows the network to operate at a much higher rate than typical 
packet-switching protocols (for example, X.25), because it provides no error 
protection or flow control. Instead, ATM relies on the source and destination 
devices to perform error-recovery functions such as retransmission of lost pa

48-byte
information field

5-byte
header

ATM0001A
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Cell Header

After dividing the data into 48-byte segments for transmission, the end device
that is, the ATM data service unit/channel service unit (DSU/CSU) or native A
device -- attaches the required header information (Figure 1-2).

Figure 1-2. ATM Cell Header 

The fields in each ATM cell header provide all the information necessary for 
networking. These fields include the following:

• Generic flow control (GFC): The first 4 bits of the cell header contain the 
GFC. The GFC controls traffic flow onto the ATM network by controlling th
user-to-network interface (UNI).

• Virtual path identifier (VPI): The next 8 bits of the cell header (that is, the l
half of byte 1 and the first half of byte 2) contain the VPI. The VPI specifie
virtual path on the physical ATM link. See the next section, “Data 
Transmission,” for additional information about virtual paths.

48-byte
information field

5-byte
header

Generic flow control (GFC) Virtual path identifier (VPI)

Virtual path identifier (VPI) Virtual channel identifier (VCI)

Virtual channel identifier (VCI)

Virtual channel identifier (VCI) Payload type (PT)

Header error control (HEC)

Cell loss
priority

Bytes

2 3 4 5 6 7 8

Bits

1

1

2

3

4

5

ATM0002A  
308612-14.00 Rev 00 1-3



Configuring ATM Services

, 
he 
 
 

ate 

ell 
ns. 
y.

 

 of 

 

.

 
 part 

 up 
• Virtual channel identifier (VCI): The next 16 bits of the cell header (that is
the last half of byte 2, byte 3, and the first half of byte 4) contain the VCI. T
VCI specifies a virtual channel within the virtual path on the physical ATM
link. See the next section, “Data Transmission,” for additional information
about virtual channels.

• Payload type (PT): The next 3 bits (that is, bits 5 through 7 of byte 4) indic
the type of information the cell is carrying (for example, user data or 
management information).

• Cell loss priority (CLP): The last bit of byte 4 indicates the priority of the c
and whether the network can discard the cell under heavy traffic conditio
Setting the bit to 1 indicates the network may discard the cell if necessar

• Header error control (HEC): The last byte of the header field contains the
HEC. Its primary function is to guard against misdelivery of cells due to 
header or single-bit errors. However, the HEC does not gauge the quality
the data in the information field.

Cell Information Field

Following the 5-byte cell header is a 48-byte information field containing user
data. The ATM adaptation layer (AAL) organizes the data in this field. See “ATM 
Layers” on page 1-6 for additional information about the AAL.

Data Transmission

Data transmission (also called cell switching) through the ATM network relies on 
the establishment of logical connections between ATM devices. ATM is a 
connection-oriented service. This means that an ATM device cannot transmit 
information until it establishes a connection with a receiving device. These 
connections consist of virtual channels, virtual paths, and transmission paths

A virtual channel is a logical connection between two communicating ATM 
devices. Each virtual channel can carry a different protocol or traffic type. The
virtual channel transports cells that have a common identifier, the VCI, that is
of the cell header. You can establish virtual channels permanently or set them
dynamically, allowing the network to adjust itself to the traffic demand. 
1-4 308612-14.00 Rev 00
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A virtual path is a set of virtual channels between a common source and 
destination. The virtual channels in a virtual path are logically associated with
common identifier, the virtual path identifier (VPI), that is part of the cell head
You can base cell switching on either the VPI alone, or on a combination of t
VPI and VCI.

Virtual paths enable you to separate network transport functions into those re
to an individual logical connection (virtual channel) and those related to a gro
of logical connections (virtual path).

A transmission path is a physical connection that comprises several virtual pat
each virtual path containing several virtual channels. The transmission path c
support multiple virtual paths across a single connection to the network.

Figure 1-3 shows the relationships between the virtual channel, the virtual pat
and the transmission path.

Figure 1-3. ATM Transmission Components

VP

VP

VP

VC

VC

VC

Transmission Path

VP = Virtual path
VC = Virtual channel
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ATM0006A
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Protocol Prioritization

You can set the priorities for the traffic sent across a synchronous line interfa
using a process called protocol prioritization. The ability to prioritize traffic is 
important for an application that is time-sensitive and that requires a fast resp

For example, a user at router A participating in a Telnet session with router B
requires a more immediate response than does a user at router A performing
transfer with router B.

You must manually start protocol prioritization on an ATM circuit. You can use
protocol prioritization for IP traffic travelling over an ATM PVC.

For more information about protocol prioritization, see Configuring Traffic Filters 
and Protocol Prioritization.

Permanent and Switched Virtual Connections

Virtual channels and virtual paths allow you to establish virtual channel links 
(VCLs). You can create VCLs as either permanent virtual circuits (PVCs) or 
switched virtual circuits (SVCs). After you establish a PVC, you can transfer 
information over it at any time. SVCs activate, through signaling and network
switching, only when there is information ready for transmission.

ATM Layers

The B-ISDN protocol reference model, on which ATM is based, consists of fo
layers (Figure 1-4). Each layer communicates only with the layer directly above
and the layer directly below it.
1-6 308612-14.00 Rev 00
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Figure 1-4. B-ISDN ATM Protocol Reference Model

The following layers relate directly to how Nortel Networks routers support AT

• Physical layer

• ATM layer

• ATM adaptation layer (AAL) 

Physical Layer

In a Nortel Networks Backbone Node (BN®) router, Intelligent Link Interface 
(ILI) pairs provide access and processing. An ILI pair consists of a link modu
and a processor module that work together to process and transmit informati
over a network. Nortel Networks provides an ATM Routing Engine (ARE) link
module in conjunction with an ARE processor.

In addition, Nortel Networks provides a hub version of the ATM ARE ILI pair, t
Model 5782 ATM router. This single hub module, incorporating the ILI functio
of both the link module and processor module, resides in a System 5000BH 
chassis. See Using the Model 5782 ATM Virtual Network Router for more 
information.

The ILI pair and the Model 5782 ATM router are functionally identical, and yo
configure them in much the same way. Unless otherwise noted, the remainde
this guide treats the router ILI pair and the Model 5782 as if they were the sa

Higher protocol layer

ATM
adaptation

layer
(AAL)

Convergence sublayer (CS)

Segmentation and reassembly sublayer (SAR)

ATM layer

Transmission convergence sublayer

Physical medium dependent sublayer (PMD)

Physical
layer

(PHY)

ATM0003A
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Depending on the ATM router type, you can connect directly to an ATM netw
over any of the following physical interfaces:

• Optical carrier level 3 (OC-3)

• Digital service level 3 (DS-3)

• E-3 (the European equivalent of the North American DS-3)

Although Nortel Networks uses raw bandwidth to describe line rates, inheren
overhead within the media limits maximum bandwidth for the line. Use Table 1-1 
to determine the maximum bandwidth for the media you are using.

ATM Layer

The ATM layer defines how two nodes transmit information between them. It i
concerned with the format and size of the cells and the contents of the heade
The addresses of the cells are meaningful only to the two adjacent local nod
(that is, usually not to the end nodes).

ATM Adaptation Layer

The ATM adaptation layer (AAL) converts upper-layer protocol data into format
that are compatible with the requirements of the ATM layer, enabling ATM to 
handle different types of information within the same format.

The AAL is divided into two sublayers: the convergence sublayer (CS) and the 
segmentation and reassembly (SAR) sublayer. These two sublayers convert 
variable-length messages into 48-byte segments, while ensuring the integrity
the data.

Table 1-1. Maximum Bandwidth by Media Type

Media
Raw
Bandwidth (Mb/s)

Maximum
Bandwidth (Mb/s) Maximum Cells/s

OC-3 SONET/SDH 155 149.76 353207

DS-3 (Cbit and M23 
framing)

44.736 40.704 96000

E-3 (G.832 framing) 34.368 33.920 80000

E-3 (G.751 framing) 34.368 30.528 72000
1-8 308612-14.00 Rev 00
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The CCITT (now ITU-T) has defined different types of AALs to handle differe
kinds of traffic. Nortel Networks ATM routers support a CS function compatib
with AAL 5, as defined in Section 1 of the CCITT (now ITU-T) B-ISDN Protocol 
Reference Model (PRM).

In AAL 5, only a trailer attaches to the data from the upper-layer protocols to
create a CS PDU. AAL 5 divides the protocol data unit (PDU) into a 48-octet S
PDU; however, it does not add an SAR header and trailer. This 48-octet SAR 
becomes the payload of the ATM cell (Figure 1-5).

Figure 1-5. ATM Adaptation Layer 5

Note : AAL 5 does not attach an SAR header or trailer to the PDU. 

Service data unit (SDU)

SAR PDU

ATM cell

SDU

SAR PDU
SAR PDU

ATM cell
ATM cell

AAL 5
convergence

sublayer

AAL 5
SAR
layer

ATM
layer

AAL
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Service
class

Trailer
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Service Records and Virtual Circuits

ATM devices communicate using virtual circuits (VCs). These VCs transmit a
receive ATM cells containing upper-layer protocols. Nortel Networks ATM 
routers use service records to provide a way of creating logical interfaces (w
the physical ATM interface) for these upper-layer protocols. In essence, thes
service records allow you to:

• Organize multiple VCs into logical groups.

• Create direct point-to-point connections.

• Assign, delete, and modify upper-layer protocols for just one PVC or for a
group of VCs at any given time.

Supported Protocols

Depending on the data encapsulation type and virtual connection type (PVC, 
or WAN SVC) you choose for the service record, the router supports various 
protocols.

Table 1-2 lists all supported protocols for standard PVCs and SVCs using
LLC/SNAP, NLPID, NULL, LANE 802.3, or LANE 802.5 data encapsulation.

Table 1-2. Protocols Supported for Standard PVCs and SVCs

PVC Using LLC/
SNAP, NLPID, or 
NULL

SVC Using 
LLC/SNAP
or NULL (RFC 
1577)

SVC Using LANE 
802.3

SVC Using LANE 
802.5

WAN SVC 
Using 
LLC/SNAP

Bridge IP Bridge Bridge IP

Spanning Tree RIP Spanning Tree Spanning Tree RIP

Native Mode LAN BGP Native Mode LAN IP IPX

IP OSPF/MOSPF IP RIP RIP/SAP

RIP IPv6 RIP OSPF/MOSPF

EGP AHB BGP BootP

PIM NHRP OSPF/MOSPF NHRP

NHRP RSVP BootP RSVP

RSVP NAT Router Discovery NAT

NAT L2TP IGMP/IGMP Relay L2TP

(continued)
1-10 308612-14.00 Rev 00
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L2TP DiffServ DVMRP DiffServ

DiffServ IPv6 NetBIOS IPX

BGP PIM RIP/SAP

OSPF/MOSPF NHRP Source Routing

BootP RSVP SR Spanning Tree

IGMP/IGMP Relay NAT Translate/LB

DVMRP L2TP LLC2

NetBIOS DiffServ DLSw

DECnet IV DECnet IV APPN

VINES VINES

IPX IPX

RIP/SAP RIP/SAP

OSI XNS

TARP RIP (XNS)

Source Routing AppleTalk

SR Spanning Tree LLC2

Translate/LB DLSw

XNS

RIP (XNS)

Caution: Ethernet and token ring emulated LANs can support different 
protocols. When adding a protocol to a LANE service record with an 
unspecified emulated LAN type, ensure that the protocols you add are 
supported by the emulated LAN (Ethernet or token ring) that you want to join

Table 1-2. Protocols Supported for Standard PVCs and SVCs  (continued)

PVC Using LLC/
SNAP, NLPID, or 
NULL

SVC Using 
LLC/SNAP
or NULL (RFC 
1577)

SVC Using LANE 
802.3

SVC Using LANE 
802.5

WAN SVC 
Using 
LLC/SNAP
308612-14.00 Rev 00 1-11
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Things to Remember

When enabling protocols on a service record, keep the following in mind:

• A PVC service record requires that you add at least one PVC for the serv
record to operate.

• Each ATM service record globally controls:

-- All protocols for any standard PVCs and SVCs that it contains

-- All nonbridging protocols for any hybrid PVCs that it contains

• Selecting LANE to run on an SVC service record defines that service rec
as belonging to an emulated LAN. Any protocols on that service record 
operate as if they were running over a traditional Ethernet or token ring L

• When running IP over a NULL encapsulated PVC service record, you mu
change the Address Resolution parameter to None. You must then add a
adjacent host with the MAC address equal to the VPI/VCI of the PVC. Se
Configuring IP, ARP, RARP, RIP, and OSPF Services for information about 
the Address Resolution parameter.

Rules for Editing Protocols

Depending on the type of virtual circuit you are using, Site Manager requires
to add additional protocols, or delete and edit existing protocols, from specifi
protocol menus.

Use Table 1-3 to locate the appropriate protocol menu for each access mode.

Remember, hybrid PVCs use their service record configurations for nonbridg
protocols and their individual configurations for bridging protocols.

Table 1-3. Locating and Using Site Manager Protocol Menus

Site Manager Menu Location PVCs and SVCs Hybrid PVCs Only

ATM Service Records List window 9 9†

ATM Virtual Channel Link window 9*

* For nonbridging protocols
†For bridging protocols
1-12 308612-14.00 Rev 00
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Data Encapsulation Methods

Nortel Networks ATM routers support multiprotocol encapsulation (as defined
RFC 1483), enabling the router to multiplex (combine) and demultiplex (separ
bridged or routed protocol data units (PDUs).

For transmission, the encapsulation process adds a header from 2 to 8 octet
length to the PDU to allow decoding. The decoding process determines the p
service access point (SAP).

When receiving information, the encapsulation method evaluates the header
determine whether the PDU is a valid routed or bridged cell. If it is valid, the 
encapsulation method then strips the header from the cell and passes the cel
appropriate SAP for routing or bridging.

You can choose from four data encapsulation types:

• LANE

• LLC/SNAP

• NULL

• NLPID

How you assign a data encapsulation type and which type takes precedence
depends on the virtual circuit type and, for PVCs, the order in which you assi
the encapsulation type.

Each ATM device must encapsulate PDUs before sending them to the SAR 
sublayer.

LANE Encapsulation

LANE provides Ethernet (IEEE 802.3) or token ring (IEEE 802.5) encapsulat
of ATM PDUs for transmission over an emulated LAN. You can assign LANE
encapsulation to SVCs only.
308612-14.00 Rev 00 1-13
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LLC/SNAP Encapsulation

Logical Link Control/Subnetwork Access Protocol (LLC/SNAP; RFC 1483) 
allows multiplexing of multiple protocols over a single ATM virtual circuit. In thi
approach, an IEEE 802.2 Logical Link Control (LLC) header prefixes each PD
You can assign LLC/SNAP encapsulation to:

• PVC service records

• SVC service records

• WAN SVC service records

• Individual PVCs

NULL Encapsulation

RFC 1483 refers to NULL encapsulation as “VC-based multiplexing.” This 
method performs upper-layer protocol multiplexing implicitly using ATM virtua
circuits. You can assign NULL encapsulation to:

• PVC service records

• SVC service records

• Individual PVCs that are also members of an LLC/SNAP service record

NLPID Encapsulation

You can use Network Layer Protocol ID (NLPID; RFC 1490) in an ATM 
environment for frame relay/ATM internetworking. You can assign NLPID 
encapsulation to PVC service records.

Note: Assigning LLC/SNAP to an SVC service record automatically uses the
technology defined in RFC 1577, Classical IP and ARP over ATM. For 
information about RFC 1577, see “Classical IP over ATM Concepts” on 
page 1-28.

Note: Assigning NULL to an SVC service record automatically uses the 
technology defined in RFC 1577, Classical IP and ARP over ATM. For 
information about RFC 1577, see “Classical IP over ATM Concepts” on 
page 1-28.
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Understanding ATM, ATM Router Redundancy, and OAM
 

sioned 
c 
ns 

TM 

ure 

r 
 

re 
ds 

 
ust 

 
.

Selecting a Data Encapsulation Method

Generally speaking, the designers of these data encapsulation methods envi
that NULL encapsulation would dominate in environments where the dynami
creation of large numbers of ATM VCs is fast and economical. These conditio
usually exist in private ATM networks.

LLC/SNAP encapsulation is an alternative for environments in which it is not 
practical to have a separate VC for each carried protocol (for example, if the A
network supports only PVCs, or if billing depends heavily on the number of 
simultaneous virtual circuits).

The choice of multiplexing methods that two ATM stations use to exchange 
connectionless network traffic depends on the type of virtual circuit involved: 

• For PVCs, you select the multiplexing method when you manually config
the connection.

• For SVCs, the stations themselves negotiate the multiplexing method by 
sending B-ISDN signaling messages. These messages include “low-laye
compatibility” information that allows negotiation of AAL5 and the carried
(encapsulated) protocol.

Selecting LLC/SNAP Encapsulation

When the same virtual circuit carries several protocols, select LLC/SNAP 
encapsulation. LLC/SNAP encapsulation attaches an LLC/SNAP header befo
the PDU. This header includes information that the receiving ATM station nee
to properly process the incoming PDU. For bridged PDUs, this header also 
includes the type of the bridged media.

Selecting NULL Encapsulation (VC-Based Multiplexing) 

In NULL encapsulation, the carried network protocol is identified implicitly by
the virtual circuit connecting the two ATM stations. Because each protocol m
travel over a separate virtual circuit, there is no need to include explicit 
multiplexing information in the payload of the PDU. For this reason, the 
bandwidth requirements and processing overhead remain minimal.

Note: Routed and bridged PDUs are always encapsulated within the payload
field of the AAL5 CPCS PDU, regardless of the selected multiplexing method
308612-14.00 Rev 00 1-15
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You can either manually configure the carried protocol or let the signaling 
procedures negotiate it dynamically during call establishment.

NULL encapsulated cells do not receive a header in a routed environment. In
bridged environment, the content of the PDU itself includes the necessary 
information for bridging the multiplexed protocols.

Encapsulation Rules for PVCs

How you assign data encapsulation to individual PVCs depends to a degree o
data encapsulation type you assigned to the service record that contains tho
PVCs. Table 1-4 provides suggestions for assigning data encapsulation to PV
and hybrid PVCs that reside on these service records.

When assigning a data encapsulation type to a PVC or group of PVCs, keep
following in mind:

• When you add a PVC, it reads and uses the data encapsulation type spe
in its ATM service record.

• You can globally assign a data encapsulation type to all nonhybrid PVCs
particular service record, or you can assign a data encapsulation type to 
individual group PVCs.

• If you change the data encapsulation value for the service record, all new
PVCs that you add to that service record use the new value.

• You must assign a data encapsulation type to hybrid-mode PVCs individu
You cannot assign data encapsulation to a hybrid-mode PVC using the se
record.

• When you use the copy function, the new PVC uses the data encapsulat
type of the existing PVC.

Table 1-4. Assigning Data Encapsulation to Individual PVCs

Service Record Data 
Encapsulation Type

Individual PVC Data 
Encapsulation Type

Hybrid PVC Data 
Encapsulation Type

LLC/SNAP NULL or LLC/SNAP LLC/SNAP

NULL NULL or LLC/SNAP LLC/SNAP

NLPID NLPID NLPID
1-16 308612-14.00 Rev 00
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• When running IP over a NULL encapsulated PVC service record, you mu
change the Address Resolution parameter to None. You must then add a
adjacent host with the MAC address equal to the VPI/VCI of the PVC. Se
Configuring IP, ARP, RARP, RIP, and OSPF Services for information about 
the Address Resolution parameter.

PVC Access Methods

You can set up PVCs to access an ATM network in the following ways:

• Multiple PVCs per service record

• One PVC per service record

• Hybrid access PVCs

Multiple PVCs

Upper-layer protocols treat each service record on an ATM network interface
single access point. These protocols use a single network address to send all
destined for the network to the ATM network interface. Figure 1-6 shows a 
conceptual drawing of multiple PVCs accessing an ATM network through eac
service record.

Figure 1-6. Multiple PVCs per Service Record
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Configuring multiple PVCs per service record uses network addressing most
efficiently. Although you need to configure each PVC manually, you need onl
define and associate protocols with the ATM network service record. All the 
PVCs that you configure for a given ATM service record carry the protocols th
you select and configure to run on that service record.

A configuration using multiple PVCs per service record works best in either fu
meshed environments or in nonmeshed environments where systems not dir
connected to each other have no need to communicate. You can configure mu
PVCs per service record as long as you do not need to separate protocols by
(that is, all PVCs accept the same protocols).

There are, however, ways to configure upper-layer protocols, such as IP or 
Internetwork Packet Exchange (IPX), to allow systems in nonmeshed networ
fully communicate. See the documentation for these protocols for more 
information.

One PVC

A configuration using one PVC per service record works the same way as on
using multiple PVCs per service record. When you define only one PVC per 
service record, upper-layer protocols treat the ATM network as a series of dir
point-to-point connections, viewing each PVC as an individual network interfa

You can configure each PVC with different protocols and parameter settings. 
allows you to connect to different network sites using, for example, different ty
of data encapsulation (Figure 1-7).

Note: When you configure multiple PVCs per service record, all PVCs use the
data encapsulation type that you set for the ATM service record. See “Data 
Encapsulation Methods” on page 1-13 for more information.
1-18 308612-14.00 Rev 00
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Figure 1-7. One PVC per Service Record

Assigning one PVC per service record allows you to dedicate a PVC to a 
particular protocol, but at the expense of some configuration overhead, mem
and address space.

This type of configuration is best suited to small, nonmeshed configurations o
configurations in which protocols must reside on separate PVCs.

Hybrid Access PVCs

PVCs do not typically allow bridging in nonmeshed environments. If your 
network combines bridging and routing over the same interface, you need to
the service record portion of each PVC for routing, while at the same time 
allowing bridging to operate. To do this, you must define the PVC as a hybrid
bridged VC.

Defining the PVC as a hybrid/bridged VC allows the bridge to view each PVC
a separate bridge interface while allowing the routing protocols to view all PV
as part of the same interface (Figure 1-8).

Note: The maximum number of PVCs you can configure in this way varies, 
depending on the configuration of the router, the number of protocols running
on the circuits, and the number of routing entries.
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Figure 1-8. Hybrid Access PVCs

Use hybrid PVCs when creating nonmeshed network configurations that use
bridging and routing over a single ATM interface. These PVCs work best for 
spanning tree bridging.

Note: When you define a PVC as a hybrid/bridged VC, Site Manager provides
additional Bridge, Spanning Tree, Source Routing (SR), SR Spanning Tree, 
Translational/Learning bridge (Translate/LB), and Native Mode LAN (NML) 
protocol options. These protocols run on the PVC along with the protocols 
defined in the ATM service record.
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Using Hybrid PVCs for Transparent Bridging

In Figure 1-9, traffic is bridged between site A and site B. The bridge (router 1
running on the ATM network interface, and its PVCs are not defined as
hybrid/bridged VCs.

Figure 1-9. Example of a Bridged Network

In this example, when the bridge receives data from site A and does not reco
the destination address, it tries to direct traffic through another bridge port. 
However, because the PVCs are not defined as hybrid/bridged VCs, the ATM
bridge port views the paths to site A and site B as the same. 

A bridge does not send the same data over the bridge port from which it just 
received the data, so the bridge cannot direct the data to site B. To resolve th
problem, you need to designate the PVCs on router 1 as hybrid/bridged VCs

If you define the PVCs as hybrid VCs, each PVC acts as a separate bridge p
This enables the bridge running on the ATM interface to view the traffic from
site A as arriving on a different port from that of site B. When the bridge send
data, it now has access to all its ports, including the port that accesses site B
Therefore, data from site A can reach site B.
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SVC Access Methods

SVCs use signaling messages to dynamically establish, maintain, and clear 
switched virtual connection at the UNI. These messages (as defined by the Q
standard for signaling protocols) allow the router to assess the availability of 
ATM end point (device), establish a connection with that device, maintain tha
connection for the duration of data transfer, and then clear the connection wh
the transfer is complete.

Assigning ATM Addresses

An ATM address is composed of a network prefix and a user part. Nortel 
Networks routers use the autogeneration feature to create the user part of the
address by combining the MAC address of the ATM interface with a unique 
selector byte to create unique addresses (Figure 1-10). You can also enter ATM 
addresses manually.

Figure 1-10. ATM Address Components
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Entering an ATM Address Network Prefix

The ATM address network prefix specifies the ATM domain of which the serv
record is a part. This 13-byte portion of the ATM address can range from 
XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF.

The XX byte must contain a value of 39, 45, or 47. These values define the 
authority and format identifier (AFI). The AFI byte identifies the group 
responsible for allocating the prefix and the format the prefix uses. For more 
information about the AFI byte, refer to the ATM Forum UNI specification.

Entering an ATM address network prefix is optional. If you do not enter a netw
prefix in the specified range, the service record accepts the first prefix value th
receives from the switch.

Entering an ATM Address User Part

The ATM address user part (suffix) consists of a 6-byte end-station identifier a
1-byte selector field. This 7-byte portion of the ATM address can range from 
00000000000000 to FFFFFFFFFFFFFF.

You can either allow the router to generate this value automatically, or you ca
enter the value manually.

ATM Traffic Parameters

The ATM User-Network Interface Specification defines the following traffic 
parameters:

• Peak cell rate (PCR) -- The upper traffic rate limit for an individual VC

• Sustainable cell rate (SCR) -- The upper bound on the conforming averag
rate of an individual PVC or control VC

• Maximum burst size (MBS) -- The maximum length of a cell stream allow
on a particular VC

These parameters help to prioritize and control the traffic on each VC. How y
configure your ATM traffic parameters depends on the characteristics of the 
individual connections that you want to set up (for example, the desired maxim
cell rate, average cell rate, and burst size).
308612-14.00 Rev 00 1-23
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You can change ATM traffic parameters several times before deciding on a 
particular set. The following sections describe the traffic parameters and prov
some basic guidelines for customizing them on an ATM PVC or ATM control V
(that is, the signaling VC or ILMI VC).

Using the PCR

The PCR specifies the upper traffic limit, in cells/second, that the ATM 
connection can support.

How you set the PCR depends on:

• The optical transmission rate of your ATM device

• The amount of traffic you expect on a particular VC

• The rate you want for each VC

When setting the PCR, keep the following considerations in mind:

• Each VC can have its own PCR.

• The PCR cannot exceed the maximum rate for the physical media. For 
example, you cannot exceed 149.76 Mb/s for an OC-3c line.

• The PCR specifies the desired rate for the attached physical media (that 
OC-3c, DS-3, or E-3). It does not specify the rate for the ATM network as
whole. For example, you can specify a full 149.76 Mb/s for each PVC or 
control VC on an OC-3c connection. However, if the VC ultimately conne
to a lower-speed link (for example, T1 or E1), your PCR is limited to the 
maximum rate for that media.

• ATM VCs may fail to operate with PCR values lower than 128 cells/s.

• The E-3 framing mode setting affects the maximum PCR setting.

Note: You do not need to manually configure traffic parameters for SVCs (as
you must for PVCs and control VCs), because SVCs dynamically negotiate 
these parameters before sending data.
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Using the SCR

The SCR is the upper bound on the conforming average rate of an individual P
control VC, or WAN SVC. The average rate is the number of cells transmitted 
over the link divided by the duration of the connection. The duration of the 
connection is the total amount of time it takes from connection setup to 
connection release.

The SCR allows you to define future cell flow on a PVC, control VC, or WAN 
SVC in greater detail than by using only the PCR. The SCR controls the rate 
time -- not at a specific instant of time -- and can help you use your network 
resources more efficiently. In other words, the SCR allows sufficient bandwid
for operation, but does not allow a bandwidth as high as the PCR.

The SCR value maps directly to an MCR (minimum cell rate) value. In other 
words, when you configure the SCR on a device, you actually configure the u
bound of an average rate. Like the SCR, the MCR defines the minimum amou
guaranteed bandwidth allowed for PVCs, control VCs, or WAN SVCs on the 
ATM line. The MCR (that is, SCR) not only controls the rate over time, it 
guarantees this rate.

When setting the SCR, keep the following considerations in mind:

• The SCR maps directly to the MCR.

• The MCR provides guaranteed bandwidth for PVCs, control VCs, or WAN
SVCs while allowing sufficient bandwidth for SVCs to operate.

• To be useful, the SCR must not exceed the PCR. 

• If you know the user average rate, set the SCR approximately 10 percen
higher than this value.

• ATM VCs may fail to operate with SCR values lower than 128 cells/s.

• Entering 0 for the SCR turns off this function and specifies that the ATM 
router uses “best effort” for SCR.

• The E-3 framing mode setting affects the maximum SCR setting.
308612-14.00 Rev 00 1-25
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Using the MBS

The MBS specifies the maximum number of sequential cells allowed on a VC
before that VC must relinquish bandwidth to other VCs waiting to transmit. T
burst occurs at or close to the peak cell rate.

When setting the MBS, we suggest that you select a value larger than the lar
packet your PVC or control VC can transmit (that is, the size of the maximum
AAL CPCS transmit SDU). For example, if your VC accepts packets that are
than 4608 bytes long (PVC default), set your MBS value between 45 and 50 

As a guideline, use this formula to determine your MBS value:

Maximum packet size (in bytes)

48 bytes/cell
=      MBS value (in cells)

For example:

4608 bytes (default)

48 bytes/cell
=     96 cells

ATM0016A
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ARP and Inverse ARP Support

ATM supports the Address Resolution Protocol (ARP), enabling the router to
dynamically resolve IP network layer protocol-to-VPI/VCI address mappings.
ATM learns the address of the virtual circuit by detecting the virtual circuit tha
delivered the ARP response.

ATM also supports Inverse ARP. However, you can use Inverse ARP only if b
the local and remote routers support it.

Nortel Networks uses both proprietary and standard ARP and Inverse ARP fo
PVCs that run IP. The method that the PVC uses depends on how you config
address resolution for the IP interface. See Configuring IP, ARP, RARP, RIP, and 
OSPF Services for additional information about configuring address resolution

Nortel Networks uses standard ARP and Inverse ARP for SVCs running clas
IP (RFC 1577) and SVCs running LAN emulation.

ATM Error Checking

ATM verifies that the VPI/VCI is valid with respect to the PVCs configured for
the ATM circuit. It also verifies the header format. ATM verifies valid SVC 
connection through signaling messages.

Simulated Multicast Packet Support

Simulated multicasting is generally used in certain address resolution techniq
and for applications that require the delivery of identical information to multip
recipients. Nortel Networks ATM routers simulate multicasting by sending a c
of the multicast or broadcast packet to every available virtual circuit on a 
particular logical interface.

Converting Mb/s to Cells/s

Several ATM traffic parameters require you to enter values in cells per secon
(cells/s). To convert to cells/s, divide the number of bits/s by 424 (the number
bits per ATM cell).
308612-14.00 Rev 00 1-27
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Classical IP over ATM Concepts

RFC 1577, Classical IP and ARP over ATM, describes an administrative entity 
within an ATM network called a logical IP subnet (LIS). Each ATM LIS consis
of multiple network devices -- hosts and routers -- connected to the ATM netw
and configured with interfaces to the same IP subnet.

Each LIS operates and communicates independently in an ATM network. A h
connected to an ATM network communicates directly with other hosts in its o
LIS. To communicate with hosts in another LIS, the host must use an IP route
This router can connect to multiple LISs.

An ATM LIS must meet the following requirements:

• All members of the LIS (hosts and routers) must have the same IP netwo
subnet address and mask.

• All members must be directly connected to the ATM network using SVCs

• All members must access hosts outside the LIS through a router.

• All members must be able to communicate by means of ATM with every o
member of the LIS (that is, the virtual connection topology must be fully 
meshed).

Number of bits/second

Number of bits/ATM cell
=      Number of cells/second

For example:

100,000,000 bits/s

424 bits/cell
=     235,849 cells/s

ATM0021A
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An ATM LIS can replace an IP LAN. In Figure 1-11, for example, three IP host 
systems and an IP router have interfaces to an Ethernet LAN. To communica
with each other on the LAN, the devices use the MAC addresses that they ob
using ARP or static routes. For communication beyond the LAN, the devices 
IP addresses.

Figure 1-11. IP Local Area Network

In Figure 1-12, an ATM network replaces the LAN interfaces, creating a LIS. F
communication within the LIS, the devices use ATM addresses obtained usin
ATMARP; for communication beyond the LIS, the devices use IP addresses.

For example, to send a message to host B, host A uses host B’s ATM addres
send a message to a host beyond the LIS, host A uses an IP address to iden
remote host and sends the message to the local router (router A), using the ro
ATM address. The router then forwards the message.
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Figure 1-12. IP Logical IP Subnet
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ATM Address Resolution

An address resolution protocol defines a mechanism that enables an IP route
use the IP address of a network device to learn the physical address of that d
An Ethernet LAN uses ARP as its address resolution scheme. A LIS uses an
address resolution scheme called ATMARP as defined by RFC 1577.

On a LAN, defined as a broadcast medium, a router obtains the physical add
of a network device by broadcasting an ARP request. In a LIS, which uses a 
nonbroadcast ATM medium, a router sends an ATMARP request to an ATMA
server.

Each IP interface on the LIS opens a VC to the ATMARP server and register
IP address and ATM address (Figure 1-12 on page 1-30). Using this information, 
the server builds and maintains a table that maps LIS IP addresses to ATM 
addresses.

A router that needs the ATM address of a host on the LIS sends an ATMARP
request to the server. When the server returns a response containing the add
the router extracts the ATM address of the host from the response and opens
SVC directly to the host using ATM UNI signaling.

If the server does not have an entry for the requested IP address, it returns a
negative acknowledgment, signifying that the destination is unreachable.
308612-14.00 Rev 00 1-31
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Configuring an ATM Service Record for ATMARP

When configuring a service record to act as an ATMARP client or server:

• Define a classical IP service record.

-- Specify SVC as the virtual circuit type for the service record. All netwo
devices on a LIS must connect over SVCs.

-- Specify LLC/SNAP or NULL as the encapsulation type for the service
record. RFC 1577 defines LLC/SNAP as the encapsulation type for 
ATMARP.

For more information about how to create an SVC service record to run 
classical IP, see Chapter 2, “Starting ATM and ATM Router Redundancy.”

• Add IP and IP routing protocols to the circuit.

• Configure ATMARP Mode as either a client or a server.

For a description of the ATM-specific IP parameters necessary for classic
ATMARP operation over ATM, see “ATMARP Parameters” on page A-80.

For full compatibility with RFC 1577, you may have to specify a maximum 
transmission unit (MTU) size of 9188 bytes. See “Defining the Interface MTU
on page 3-3 (for the BCC) or the Site Manager Interface MTU parameter 
description on page A-5 for additional information about setting the MTU size

When configuring the router as a client, you must define the server switch add
The client sends ATMARP requests to the server switch address. 

Note: If you remove and replace a link module that is configured as an 
ATMARP client, the client loses connectivity until the ATMARP server 
registration refresh interval for that client expires (900-second default). This 
loss of connectivity occurs only when the client is configured to autogenerate
the ATM address user part (see “Disabling and Reenabling User Part 
Autogeneration” on page 6-4 for additional information about autogenerating
ATM addresses).
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Configuring an ATM Address for an Adjacent Host

An adjacent host is a network device on the local LIS. You must configure an
ATM address for all hosts on the LIS that do not use ATMARP.

For a description of the IP parameters required for creating adjacent hosts in
classical IP over ATM environment, see “Adjacent Host Parameters” on 
page A-82.

For more information about adding, editing, and deleting adjacent hosts, see
Configuring IP, ARP, RARP, RIP, and OSPF Services.

ATM LAN Emulation Concepts

LAN emulation allows virtual communication of traditional LAN devices and 
applications over an ATM network. An ATM network can run one or more 
emulated LANs. However, each emulated LAN is independent of the others a
devices cannot communicate directly across emulated LAN boundaries.

This section provides general information about LAN emulation as described
the ATM Forum. For more information about LAN emulation, refer to the ATM
Forum document LAN Emulation Over ATM (Version 1.0).

For instructions on how to customize LAN emulation on your ATM router, see
Chapter 7, “Customizing LAN Emulation Service Records and Clients.”

LAN Emulation Connectivity

An emulated LAN can provide Ethernet (IEEE 802.3) or token ring (IEEE 802
connectivity. With an emulated Ethernet or token ring network over ATM, 
software applications can interact as if they were connected to a traditional L

Note: Communication between emulated LANs is possible through routers 
and bridges only (possibly implemented on the same end station).
308612-14.00 Rev 00 1-33



Configuring ATM Services

ch 

 to 

n a 
ss) 

of 
, and 

ted 
trols 

S 

en 
. 

ic 
s of 
LAN Emulation Components

Each ATM domain contains a LAN emulation configuration server (LECS). Ea
emulated LAN comprises a group of LAN emulation clients (LECs), a LAN 
emulation server (LES), and a broadcast and unknown server (BUS). These 
servers provide specific LAN emulation services.

LAN Emulation Configuration Server

The LAN emulation configuration server (LECS) assigns individual LE clients
different emulated LANs. The LECS does this by giving the client the ATM 
address of the LAN emulation server (LES). This method allows you to assig
client to an emulated LAN based on the client’s physical location (ATM addre
or the identity of a LAN destination it represents.

LAN Emulation Clients

The LAN emulation client (LE client or LEC) is the interface, or virtual portion 
an interface, through which an end station forwards data, resolves addresses
provides other control functions. The LE client provides the MAC-level emula
Ethernet or token ring service interface to the upper-layer protocol. It also con
the LAN emulation UNI (LUNI) interface when communicating with other 
devices on the emulated LAN.

The LE client uses the configuration protocol to obtain information from the 
LECS. This protocol allows the LE client to locate the LES and set up a 
bidirectional, control direct virtual channel connection. The LE client 
automatically obtains all of the necessary configuration data (including the LE
address) from the LECS.

LAN Emulation Server

The LES controls and coordinates LE client access to the emulated LAN. Wh
an LE client joins an emulated LAN, it registers its ATM address with the LES
When the LES obtains the ATM address of the LE client, it also obtains the 
client’s physical location (from the MAC address or route descriptor).

LE clients query the LES to obtain the ATM address associated with a specif
MAC address or route descriptor. After an LE client receives the ATM addres
the LE client it wants to reach, the individual clients communicate directly.
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Broadcast and Unknown Server

To emulate a traditional LAN, the emulated LAN must provide the connection
data delivery of a shared network to its LE clients and be able to handle broa
and multicast data. The broadcast and unknown server (BUS) fulfills this 
requirement by distributing all broadcast, multicast, and unknown traffic to an
from all LE clients on an emulated LAN.

For example, when an LE client sets up its initial configuration, it obtains the 
MAC address of the BUS from the LES. Using this MAC address, the LE clie
sets up a multicast send virtual channel connection (VCC) to the BUS. In turn
BUS registers the LE client as part of its emulated LAN.

To broadcast data, an LE client uses the multicast send VCC to transmit 
information to the BUS. The BUS then retransmits the data, through multiple
point-to-point connections or one point-to-multipoint connection, to each LE 
client on the emulated LAN.

Redundant LES/BUS

Nortel Networks ATM routers support LAN emulation server (LES) and broadc
and unknown server (BUS) redundancy. This redundancy reduces the risk of
network failure by overcoming a single point of failure in accessing the LES.
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LAN Emulation States

As defined in the ATM Forum LAN Emulation Over ATM specification, LE clients 
enter various states of communication while attempting to join an emulated L
These states (referred to as “phases” by the ATM Forum) indicate the progre
an LE client as it connects with an emulated LAN (Figure 1-13).

Figure 1-13. LAN Emulation States

Note: The numbers that follow each state appear in the ATM LEC status 
record (wfAtmLecStatusEntry). 

Operational state (7)

 BUS connect state (6)

Initial registration state (5)

Join state (4)

Configure state (3)

LECS connect state (2)

Initial state (1)

After experiencing
any failure, or
terminating its
connection to the
emulated LAN,
the LE client
returns to the
initial state.

If the LE client
loses the BUS
connection, it can
attempt to reconnect.

ATM0034A
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The following sections briefly describe each LAN emulation state. Refer to th
ATM Forum LAN Emulation Over ATM specification for more information about
LAN emulation states.

Initial State

An LE client always starts in the initial state before attempting to connect to t
LECS.

LECS Connect State

An LE client enters the LECS connect state when it attempts to connect to th
LECS.

Configure State

An LE client enters the configure state when it attempts to retrieve the neces
information (that is, the ATM address of the LES, LAN type, LAN name, 
Maximum MTU, and various timeout values) required to join an emulated LA

Join State

An LE client enters the join state when it attempts to join an emulated LAN. 
Joining an emulated LAN requires that the LE client:

• Set up a control VCC to communicate with the LES.

• Send a join request (containing the client MAC address) to the LES.

• Accept a control distributed VCC to receive control data from the LES.

• Receive a valid join response from the LES containing a LAN emulation 
client ID (LECID).

Note: Only one ATM LE client per Nortel Networks ATM router can join an 
emulated LAN at any point in time. However, you can always move a LAN 
emulation client to the appropriate emulated LAN using network managemen
software.
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Initial Registration State

An LE client enters the initial registration state when it attempts to register 
multiple MAC addresses with the LES.

BUS Connect State

An LE client enters the BUS connect state when it attempts to set up a VCC t
BUS.

Operational State

An LE client enters the operational state after successfully completing the 
requirements to join an emulated LAN.

Note: The router LE client provides the MAC address only for its own ATM 
interface. Because it does not register multiple MAC addresses, the router 
never enters this state. The router LE client acts as a proxy for bridge MAC 
addresses not learned on this circuit.
1-38 308612-14.00 Rev 00



Understanding ATM, ATM Router Redundancy, and OAM
 

 
 

nt.
ATM Router Redundancy Concepts

Nortel Networks ATM routers support warm standby router redundancy. This
redundancy protects a network from the irrecoverable failure of an entire ATM
router. You configure routers to be members of a router redundancy group.

Figure 1-14 illustrates router redundancy in a Nortel Networks ATM environme

Figure 1-14. Router Redundancy
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Router redundancy requires at least two routers to be members of a router 
redundancy group. One router acts as the primary router and provides norma
routing/bridging services. The other router acts as the secondary, backup rou
and takes over if the primary router fails.

All members of an ATM router redundancy group must have the following 
characteristics:

• Be the same ATM router type, for example, BCN®, BLN®, or System 5000™.

• Have the same hardware configuration, including CPU and interface mod
types, and slot and port locations of the backed-up interfaces.

• Have the same software configuration. That is, you must be running the s
router software version and have the same loadable modules configured.

• Contain both a primary configuration file and a secondary configuration fi

• Have at least one legacy LAN connection between the routers in the 
redundancy group.

WAN SVC Concepts

ATM WAN SVCs provide an SVC connection that the router dynamically 
establishes for data transfer and then tears down after a configurable inactive
period of time. When configuring ATM WAN SVCs, you provide a static mappi
of an ATM address to IP or IPX protocol addresses on the same service reco

This section provides general information about ATM WAN SVCs. 

For instructions on how to create a WAN SVC service record, see “Adding a 
Service Record for WAN SVCs” on page 2-11. For instructions on how to 
customize WAN SVCs on your ATM router, see Chapter 8, “Customizing WAN
SVC Service Records and WAN SVCs.”

Note: Nortel Networks recommends at least two legacy LAN connections 
between routers in the redundancy group.
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Creating a Network of Adjacent Hosts

You can create a network of routers that are connected by ATM WAN SVCs b
configuring IP or IPX adjacent hosts. On each router, you should configure th
following:

• One WAN SVC service record for each IP subnet or IPX subnetwork

• Adjacent host entries for each router in the same subnet

Each adjacent host you configure has a static mapping to an ATM address. O
you have configured adjacent hosts, you can specify PCR and SCR settings f
WAN SVCs to any particular adjacent host by configuring the traffic shaping 
parameters. 

For information about how to configure traffic shaping, see “Enabling Traffic 
Parameters” on page 8-8.

Routing Updates

The way the router sends routing updates over a WAN SVC differs dependin
the number of adjacent hosts per circuit. If you have configured only one adja
host per circuit, Nortel Networks recommends that you set the routing mode 
dial-optimized so that the router sends routing updates only when data traffic
causes the router to establish an SVC to the adjacent host.

When you have configured multiple adjacent hosts per circuit, the router sho
send routing updates periodically to ensure that all hosts in the subnet have 
complete knowledge of the network topology. In this case, you should use th
normal routing mode instead of dial-optimized routing.

For more information about configuring routing updates, see “Changing the 
Routing Update Policy” on page 8-5.

PVC Operations and Management Concepts

In most ATM networks, if a PVC fails, the remote device does not receive 
notification of the failure at the ATM layer. Instead, the device receives this 
information from a non-ATM source such as a routing protocol that operates 
above the ATM layer. The PVC Operations and Management (OAM) feature 
provides a mechanism by which ATM devices can receive prompt failure 
information.
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PVC OAM has two methods of detecting PVC failure: loopback and alarms. Y
can use either of these methods separately or both methods together. When
OAM loopback cells, the time can decrease to only a few seconds; when usin
OAM alarms, the detection is almost instantaneous.

OAM Loopback

The OAM loopback method uses loopback cells to detect a lost connection. W
OAM loopback is enabled, the PVC sends loopback cells at a designated inte
If a remote device does not return loopback responses, and the PVC loses a
specified number of cells, the service record alerts the upper-layer protocol t
the link is down. The PVC continues to send OAM loopback cells over the ser
record. When it receives a specified number of OAM loopback responses, it 
declares the link operational and begins sending traffic again.

OAM Alarms

If the ATM router connects to an ATM switch that uses OAM alarms, you can
enable alarm detection on the ATM router. With OAM alarms enabled, when 
router receives an alarm indication signal (AIS) alarm from the switch, it alerts
upper-layer protocol that the ATM link is down; it does not wait for an OAM 
loopback response from the remote device.

After receiving an AIS alarm, the router sends a remote defect indication (RD
response to the switch to indicate that it received the alarm. The switch conti
to send AIS alarms until the link is operational again. If the router does not rec
an AIS alarm for 3 seconds, it declares the link operational and begins sendi
traffic again.

Note: For OAM loopback to function properly, you must configure it on all 
PVCs on an interface. Link status is based on the OAM loopback status of al
PVCs on the interface.
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For More Information

For more information about ATM, refer to the following documents:

ATM Forum. ATM User-Network Interface Specification. Version 3.0. September
1993.

ATM Forum. LAN Emulation Over ATM. Version 1.0. January 1995.

Bellcore Document SR-NWT-001763, Issue 1. Preliminary Report on Broadband 
ISDN Transfer Protocols. December 1990.

———, FA-NWT-001109. Broadband ISDN Transport Network Elements 
Framework Generic Criteria. December 1990.

———, FA-NWT-001110. Broadband ISDN Switching System Framework 
Generic Criteria. December 1990.

De Prycker, M. Asynchronous Transfer Mode: Solution for Broadband ISDN. Ellis 
Horwood Limited, 1991.

Grossman, D., E. Hoffman, F. Liaw, A. Malis, A. Mankin, and M. Perez. ATM 
Signaling Support for IP over ATM. RFC 1755. Network Working Group. 
February 1995.

Handel, R., and M. Huber. Integrated Broadband Networks: An Introduction to 
ATM-Based Networks. Reading, Mass.: Addison-Wesley, 1991.

Heinanen, J. Multiprotocol Encapsulation over ATM Adaptation Layer 5.
RFC 1483. Network Working Group. July 1993.

ITU-T. B-ISDN -- ATM Adaptation Layer -- Service Specific Connection Orien
Protocol (SSCOP). Final Draft. March 10, 1994.

Laubach, M. Classical IP and ARP over ATM. RFC 1577. Network Working 
Group. January 1994.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Start ATM. Chapter 2

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for ATM WAN SVC service 
record and WAN SVC parameters.

Chapter 8

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 2
Starting ATM and ATM Router Redundancy

This chapter describes how to create a basic ATM configuration by specifying
values for required parameters only and accepting default values for all other
parameters. This chapter contains the following information:

For overview information about ATM, see Chapter 1, “Understanding ATM, AT
Router Redundancy, and OAM.” 

Starting Configuration Tools

Before configuring ATM, refer to the following user guides for instructions on
how to start and use the Nortel Networks configuration tool of your choice.

Topic Page

Starting Configuration Tools 2-1

Starting ATM Services 2-2

Starting ATM Router Redundancy 2-16

Deleting ATM from the Router 2-22

Where to Go Next 2-23

Configuration Tool User Guide

Bay Command Console (BCC) Using the Bay Command Console (BCC)

Site Manager Configuring and Managing Routers with
Site Manager
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Starting ATM Services

You can use the BCC or Site Manager to start ATM on the router using defau
values for all parameters.

Using the BCC

To start ATM on a router using the BCC:

1. Add ATM to the configuration.

2. Enable ATM signaling (if you plan to define either a LANE or classical IP 
service record).

3. Define an ATM service record.

4. If you defined a PVC service record, add at least one virtual circuit to tha
service record.

5. Enable protocols on the ATM service record.

Adding ATM to the Configuration

To add ATM to the configuration, navigate to the top-level prompt and enter:

atm slot  <slot_number> [module  <module_number>] connector  
<connector_number>

slot_number is the number of the chassis slot containing the link module.

module_number is a convention used for other routers within the System 5000
chassis. You need only enter a module number when configuring an ATM rou
in the System 5000 chassis (that is, the Model 5782 Centillion Multiprotocol 
Engine). The module number for the ATM router is always 1.

connector_number is the number of a connector on the link module.

Note: The top-level prompt for BCC configuration on the System 5000 
platform is “stack.” However, the remainder of this guide uses the “box” 
prompt associated with the BN platform in its examples.
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For example, the following command adds ATM to the BN configuration on
slot 5, connector 1:

box# atm slot 5 connector 1
atm/5/1#

Enabling Signaling (LANE and Classical IP Service Records Only)

To enable signaling on an ATM interface, navigate to the ATM prompt and en

signaling

For example, the following command enables UNI V3.0 (default) signaling on
slot 5, connector 1:

atm/5/1# signaling
signaling/5/1#

Defining an ATM Service Record

Using the BCC, you can define PVC, classical IP, and LANE service records.

Defining PVC Service

To define a PVC service record, navigate to the ATM interface prompt and en

pvc-service  <service_name> encapsulation  <encapsulation_type>

service_name is a unique text string that you assign to the service record.

encapsulation_type is the data encapsulation type that you want the PVC serv
record to use.

For example, the following command defines a PVC service record with the n
“boston” on ATM slot 5, connector 1: 

atm/5/1# pvc-service boston encapsulation llc-snap
pvc-service/boston#

Note: You must add at least one PVC to a PVC service record. Go to “Adding
PVCs” on page 2-4 for instructions.
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Defining Classical IP Service

To define a classical IP service record, navigate to the ATM interface prompt 
enter:

classical-ip-service  <service_name> encapsulation  <encapsulation_type>

service_name is a unique text string that you assign to the service record.

encapsulation_type is the data encapsulation type that you want the classical I
service record to use.

For example, the following command defines a classical IP service record with
name “dallas” on ATM slot 5, connector 1: 

atm/5/1# classical-ip-service dallas encapsulation llc-snap
classical-ip-service/dallas#

Defining LEC Service

To define a LAN emulation client (LEC) service record, navigate to the ATM 
interface prompt and enter:

lec-service  <service_name> 

service_name is a unique text string that you assign to the service record.

For example, the following command defines a LEC service record with the n
“newyork” on ATM slot 5, connector 1: 

atm/5/1# lec-service newyork 
lec-service/newyork#

Adding PVCs

You must add at least one PVC to a PVC service record for that service reco
operate. A PVC is defined by its VPI/VCI pair.

A virtual path is a set of virtual channels between a common source and 
destination. The virtual channels within a virtual path logically associate with 
common identifier. This identifier is called the virtual path identifier (VPI) and 
part of the cell header.
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A virtual channel is a logical connection between two communicating ATM 
entities. Each virtual channel can carry a different protocol or traffic type. The
virtual channel transports cells that have a common identifier. The identifier is
called the virtual channel identifier (VCI) and is part of the cell header.

To add a PVC to a PVC service record, navigate to the ATM PVC service pro
and enter:

pvc vpi <vpi_number> vci  <vci_number>

vpi_number identifies the virtual path of the PVC. The header can contain a 
maximum of 8 VPI bits for a UNI connection. This bit range allows for path 
identifiers from 0 to 255.

vci_number identifies the virtual channel of the PVC. The header can contain 
maximum of 16 VCI bits. This bit range allows for channel identifiers from 32
65535.

For example, the following command adds PVC 0/130 to the configuration on
PVC service record boston:

pvc-service/boston# pvc vpi 0 vci 130
pvc/0/130#

Note: ATM does not allow duplicate VPI/VCI pairs on the same physical 
interface (that is, on the same link module). However, duplicate VPI/VCI pairs
can exist on different physical interfaces (that is, on different link modules).

Note: Following the recommendation of the ATM Forum, virtual channel 
identifiers from 0 to 31 are reserved for signaling and added functionality.
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Adding Protocols to an ATM Service Record

The BCC currently supports only IP and IPX configuration over ATM. Table 2-1 
indicates which service records support the IP and IPX protocols.

Adding IP

To add IP to a service record, navigate to the ATM service record prompt (for
classical IP or LEC service records), or the ATM PVC to which you want to a
IP, and enter:

ip address <address> mask <mask>

address and mask are a valid IP address and its associated subnet mask, expre
in either dotted-decimal notation or in bit notation.

For example, the following command configures an IP address of 2.2.2.2 and
subnet mask of 255.255.255.0 on ATM PVC 0/130:

pvc/0/130#  ip address 2.2.2.2 mask 255.255.255.0
ip/2.2.2.2/255.255.255.0#

Adding IPX

To add IPX to a service record, navigate to the ATM service record prompt (f
LEC service records), or the ATM PVC to which you want to add IPX, and en

ipx address <address>

address is a valid IPX address expressed in either dotted-decimal notation or
bit notation.

Table 2-1. Service Record Protocol Support

Service Record Type IP IPX

pvc-service 9 9

classical-ip-service 9

lec-service 9 9
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For example, the following command configures an IPX address of 0000001a
ATM PVC 0/130:

pvc/0/130# ipx address 0000001a
ipx/0000001a#

Using Site Manager

To start ATM on a router using Site Manager:

1. Create an ATM circuit.

2. Define an ATM service record.

3. Enable protocols on the ATM service record.

4. If you defined a PVC service record, add at least one virtual circuit to tha
service record.

Creating an ATM Circuit

To create an ATM circuit, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Add Circuit window opens.

2. Click on OK to accept the default circuit 
name.

The Select Connection Type window 
opens.

3. Click on ATM. The Initial ATM Signaling Config window 
opens.

4. Click on OK to accept the default settings. The Edit ATM Connector window opens.

5. Go to the next section to define a service 
record on the circuit.

Note: Accepting the defaults in the Initial ATM Signaling Config window 
enables signaling on the interface. If you are running only PVCs on the 
interface, you do not need signaling enabled.
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Defining an ATM Service Record

The Configuration Manager allows you to define service records for a specifi
data encapsulation type. Depending on the data encapsulation type you cho
the Configuration Manager also allows you to select a PVC, SVC or WAN SV
connection type for that service record.

Table 2-2 identifies which data encapsulation types you can apply to permane
and switched virtual circuits. For an explanation of the different data 
encapsulation types, and rules for assigning data encapsulation, see Chapte
“Understanding ATM, ATM Router Redundancy, and OAM.”

Caution: You cannot edit the Data Encapsulation Type or Virtual Connection 
Type parameters after you assign them to a service record. However, you ca
edit the Data Encapsulation Type for individual PVCs.

Table 2-2. Valid Data Encapsulation Types for PVCs, SVCs and WAN 
SVCs

Data Encapsulation Type
Permanent 
Virtual Circuit

Switched Virtual 
Circuit

WAN Switched 
Virtual Circuit

LANE 9

LLC/SNAP 9 9 9

NLPID 9

NULL 9 9
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Adding a Service Record for PVCs

To add a service record for PVCs, complete the following tasks:

Note: The values for some parameters depend on the values of others. If you
change one parameter, you must press the Enter or Tab key to advance from
one parameter cell to another. Pressing either key acknowledges any change
to a parameter. If you neglect this step, the Configuration Manager may not 
provide the appropriate options for other parameters.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on Add . The ATM Service Record Parameters 
window opens.

5. Set the Data Encapsulation Type  
parameter to LLC/SNAP, NLPID, or NULL . 
Click on Help  or see the parameter 
description on A-15.

6. Press the Enter  or Tab key to advance to 
the Virtual Connection Type parameter.

7. Change the Virtual Connection Type  
parameter to PVC. Click on Help  or see 
the parameter description on page A-15.

8. Click on OK. The Select Protocols window opens.

9. Go to “Enabling Protocols on an ATM 
Service Record” on page 2-13.
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Adding a Service Record for Classical IP

To add a service record for classical IP, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on Add . The ATM Service Record Parameters 
window opens.

5. Set the Data Encapsulation Type  
parameter to LLC/SNAP  or NULL . Click 
on Help  or see the parameter description 
on page A-15.

6. Click on OK. The Select Protocols window opens.

7. Go to “Enabling Protocols on an ATM 
Service Record” on page 2-13.
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Adding a Service Record for LANE

To add a service record for LANE, complete the following tasks:

Adding a Service Record for WAN SVCs

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on Add . The ATM Service Record Parameters 
window opens.

5. Click on OK. The Select Protocols window opens.

6. Go to the next section, “Enabling Protocols 
on an ATM Service Record.”

Note: The values for some parameters are contingent on the values of others
If you change one parameter, you must press the Enter or Tab key to advanc
from one parameter cell to another. Pressing either key acknowledges any 
changes to a parameter. If you neglect this step, the Configuration Manager 
may not provide the appropriate options for other parameters.
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To add a service record for WAN SVCs, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on Add . The ATM Service Record Parameters 
window opens.

5. Set the Data Encapsulation Type  
parameter to LLC/SNAP. Click on Help  or 
see the parameter description on A-15.

6. Press the Enter  or Tab key to advance to 
the Virtual Connection Type parameter.

7. Change the Virtual Connection Type  
parameter to MUXED_SVC. Click on Help  
or see the parameter description on 
page A-15.

8. Change the WAN SVC Routing Mode  to 
Normal  or Dial-Optimized . Click on Help  
or see the parameter description on 
page A-15.

9. Click on OK. The Select Protocols window opens.

10. Go to “Enabling Protocols on an ATM 
Service Record” on page 2-13.

Note: After you create a WAN SVC service record, to complete the WAN 
SVC configuration you must also configure IP or IPX adjacent host entries for
all routers to be connected to this router with WAN SVCs. For information 
about how to configure an IP adjacent host, see Configuring IP, ARP, RARP, 
RIP, and OSPF Services. For information about how to configure an IPX 
adjacent host, see Configuring IPX Services.
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Enabling Protocols on an ATM Service Record

Depending on the data encapsulation type and virtual connection type (PVC 
SVC) that you choose for the service record, the router supports various prot

You can select and configure protocols immediately after you create a servic
record, or you can exit the Select Protocols window and add protocols at a la
time.

Adding Protocols Immediately After Creating a Service Record

To add protocols to a service record immediately after creating it, complete th
following tasks:

Site Manager Procedure

You do this System responds

1. In the Select Protocols window, click on 
the protocols you want to add.

A check mark appears in the box for each 
protocol that you select.

2. Click on OK. For each protocol you select, the 
Configuration Manager displays a 
protocol-specific window prompting you 
for required information.

Click on Help  for any parameter, or see 
the appropriate protocol-specific guide.
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Adding Protocols to an Existing Service Record

To add protocols to an existing service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the service record to which you 
want to add protocols.

The Protocols menu selection becomes 
active.

5. Click on Protocols . The Protocols menu opens.

6. Choose Add/Delete . The Select Protocols window opens.

7. Click on the protocols that you want to 
add.

A check mark appears in the box for each 
protocol that you select.

8. Click on OK. For each protocol you select, the 
Configuration Manager displays a 
protocol-specific window prompting you 
for required information.

Click on Help  for any parameter, or see 
the appropriate protocol-specific guide.
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Adding PVCs

You must add at least one virtual circuit to a PVC service record for that serv
record to operate. When you finish configuring the protocols for a PVC servic
record, the ATM Virtual Channel Link window opens.

To add a PVC to a PVC service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record to which 
you want to add a virtual circuit.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on Add . The ATM Virtual Channel Link 
Parameters window opens.

7. Set the VPI Number parameter. Click on 
Help  or see the parameter description on 
A-21.

8. Set the VCI Number  parameter. Click on 
Help  or see the parameter description on 
page A-21.

9. Click on OK. You return to the ATM Virtual Channel 
Link window.

10. Click on Done . You return to the ATM Service Records 
List window.

11. Click on Done . You return to the Edit ATM Connector 
window.

12. Click on Done . You return to the Select Connection Type 
window.

13. Click on Done . You return to the Configuration Manager 
window.
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Starting ATM Router Redundancy

This section describes how to start ATM router redundancy. For more informa
about ATM router redundancy, see “ATM Router Redundancy Concepts” on p
1-39. For general information about router redundancy and detailed descripti
of router redundancy parameters, see Configuring Interface and Router 
Redundancy.

To configure router redundancy, you first create a template router redundanc
group configuration file. After creating this group configuration file, you then u
it to create each member configuration file twice: once as a primary file, which
router uses when it boots as the primary member of the redundancy group, a
again as a secondary file, which the router uses in its role as a secondary me

Note: You can configure router redundancy in Site Manager local mode only.

Note: The Clear function allows you to clear all protocols from all circuits on 
which you configured router redundancy. The Clear function does not, 
however, delete the configured router redundancy information.

The Clear function is useful when converting a primary router redundancy 
configuration file to a secondary configuration file, because a typical 
secondary configuration does not include any of the protocols contained in th
primary configuration.
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Creating a Group Configuration File

To create a redundancy group configuration file template, complete the follow
steps. All group members will use the values you configure in this file.

Site Manager Procedure

You do this System responds

1. In the Site Manager window, choose 
Tools .

The Tools menu opens.

2. Choose Router Redundancy . The Router Redundancy menu opens.

3. Choose Group Configuration . The file selection window opens.

4. Enter template.cfg as the file name.

5. Click on OK. The Select Router Model window opens.

6. Select a router and click on Confirm . The Configuration Manager window 
opens.

7. Click on an empty slot. The Module List window opens.

8. Choose a LAN module (for example, 
Ethernet, token ring, or FDDI) and click on 
OK.

The Configuration Manager window 
opens.

9. Click on the connector you want to 
configure for router redundancy.

The Add Circuit window opens.

10. Click on OK. The Select Protocols window opens.

11. Select Router Redundancy .

You can also select other protocols that 
you want to configure.

12. Click on OK. Site Manager asks if you want to add 
VLAN circuits.

13. Click on No. The Router Redundancy Circuit window 
opens.

14. Set the Primary MAC Address 
parameter. Click on Help  or see 
Configuring Interface and Router 
Redundancy for details.

15. Click on OK. The R.R. Group Global Parameters 
Configuration window opens.

(continued)
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For detailed descriptions of router redundancy parameters not described in t
section, see Configuring Interface and Router Redundancy.

16. Set the Bid Duration  parameter to at least 
90 seconds. Click on Help  or see the 
parameter description in Configuring 
Interface and Router Redundancy.

17. Click on OK. The Configuration Manager window 
opens.

18. Click on the slot that contains the ATM 
module.

The Module List window opens.

19. Choose the ATM module type that resides 
on the router and click on OK.

The Configuration Manager window 
opens.

20. Click on the ATM1 connector that you want 
to configure for router redundancy.

The Add Circuit window opens.

21. Click on OK. The Select Connection Type window 
opens.

22. Click on ATM. The Initial ATM Signaling Config window 
opens.

23. Click on OK. The Edit ATM Connector window opens.

24. Click on Configure ATM Router 
Redundancy .

The Router Redundancy Circuit window 
opens.

25. Click on OK. You return to the Edit ATM Connector 
window.

26. Click on Done . You return to the Select Connection Type 
window.

27. Click on Done . You return to the Configuration Manager 
window.

28. Click on File . The File menu opens.

29. Choose Save. You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Creating Member Configuration Files

After creating a group configuration file, you use that file to create a primary a
secondary configuration file for each member of an ATM router redundancy 
group.

Creating a Primary Configuration File

To create a primary configuration file, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Site Manager window, choose 
Tools .

The Tools menu opens.

2. Choose Router Redundancy . The Router Redundancy menu opens.

3. Choose Member Configuration . The file selection window opens.

4. Select the group configuration file, 
template.cfg.

5. Click on Open File . The Configuration Manager window 
opens.

6. Choose Protocols . The Protocols menu opens.

7. Choose Router Redundancy . The Router Redundancy menu opens.

8. Choose Member Configuration . The R.R. Member Global Parameters 
Configuration window opens.

9. Click on OK. The Configuration Manager window 
opens.

10. Choose File . The File menu opens.

11. Choose Save As . The Save Configuration File window 
opens.

12. Enter a file name (for example, alpha.pri) 
and click on Primary Save .

You return to the Configuration Manager 
window.
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Creating a Secondary Configuration File

To create a secondary configuration file, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Site Manager window, choose 
Tools .

The Tools menu opens.

2. Choose Router Redundancy . The Router Redundancy menu opens.

3. Choose Member Configuration . The file selection window opens.

4. Select the primary configuration file.

5. Click on Open File . The Configuration Manager window 
opens.

6. Choose Protocols . The Protocols menu opens.

7. Choose Router Redundancy . The Router Redundancy menu opens.

8. Choose Member Configuration . The R.R. Member Global Parameters 
Configuration window opens.

9. Set the Primary Configuration File Path  
parameter. Click on Help  or see 
Configuring Interface and Router 
Redundancy for details.

10. Click on OK. The Configuration Manager window 
opens.

11. Choose Protocols . The Protocols menu opens.

12. Choose Router Redundancy . The Router Redundancy menu opens.

13. Choose Clear. Site Manager clears all protocols except 
router redundancy from circuits with 
router redundancy configured.

14. Choose File . The File menu opens.

15. Choose Save As . The Save Configuration File window 
opens.

16. Enter a file name (for example, alpha.sec) 
and click on Secondary Save .

You return to the Configuration Manager 
window.
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Downloading Member Configuration Files to the Routers

After creating a primary and secondary configuration file for each member of
ATM router redundancy group, you must download those files to each router.

See Configuring and Managing Routers with Site Manager for instructions on 
downloading files.

When downloading the configuration files, keep the following in mind:

• Nortel Networks recommends that the routers all have the same primary 
secondary configurations.

• You should name the secondary configuration file config. The router boots 
using the config file if it restarts.

• Each router must have a unique member ID.

• Each router should have a unique priority.

If the primary and secondary routers have identical configurations, you can re
the primary and secondary file configurations, using a different member ID. If
configurations differ, you can modify the nonredundant parts of the configura
before saving the configuration file.
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Deleting ATM from the Router

You can use the BCC or Site Manager to delete ATM from the router.

Using the BCC

To delete ATM from the router, navigate to the ATM prompt and enter:

delete

For example, the following command deletes ATM from slot 5, connector 1:

atm/5/1# delete
box#

Using Site Manager

To delete ATM from the router using Site Manager, complete the following tas

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on Protocols .

The Protocols menu opens.

2. Choose ATM. The ATM menu opens.

3. Choose Delete ATM . Site Manager asks whether you really 
want to delete ATM.

4. Click on OK. Site Manager deletes ATM from the 
router. You return to the Configuration 
Manager window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for ATM WAN SVC service 
record and WAN SVC parameters.

Chapter 8

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 3
Customizing an ATM Interface

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change som
these values. This chapter describes how to customize interface (or “line”) de
and includes the following information:

Topic Page

Disabling and Reenabling the ATM Driver 3-2

Defining the Interface MTU 3-3

Defining the Data Path Notify Function 3-5

Defining the SVC Inactivity Timeout 3-7

Assigning the Framing Mode 3-9

Defining the Clocking Signal Source 3-10

Specifying DS-3 Line Buildout 3-11

Turning DS-3 and E-3 Scrambling On and Off 3-12

Enabling and Disabling Per-VC Clipping 3-14

Disabling and Reenabling an ATM Interface 3-15

Disabling and Reenabling Signaling on an Interface 3-17

Autogenerating ATM Addresses 3-18

Defining the Maximum Number of VPCs 3-21

Defining the Maximum Number of VCCs 3-21

Where to Go Next 3-22
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Disabling and Reenabling the ATM Driver

By default, when you create an ATM circuit, the line driver is enabled. You ca
disable and reenable the line driver for the specific connector without removi
the physical line from the ATM receptacle.

Using the BCC

To disable the line driver, navigate to the atm prompt (for example,
box; atm/11/1 ) and enter:

state disabled

For example, the following command disables the line driver on the ATM 
connector:

atm/11/1# state disabled
atm/11/1 #

To reenable the line driver, navigate to the prompt and enter:

state enabled

For example, the following command reenables the line driver on the ATM 
connector:

atm/11/1#  state enabled
atm/11/1#
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Using Site Manager

To disable or reenable the line driver, complete the following tasks:

Defining the Interface MTU

The maximum transmission unit (MTU) is the largest possible unit of data tha
physical medium can transmit. By default, the interface allows an MTU size o
4608 octets. This value can handle most packet sizes. However, you can set
MTU to any value from 1 to 9188 octets.

Using the BCC

To modify the interface MTU, navigate to the atm prompt (for example,
box; atm/11/1 ) and enter:

mtu <integer>

integer is the MTU size in octets.

For example, the following command sets the MTU size to 9188 octets:

atm/11/1#  mtu 9188
atm/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to disable or 
reenable.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the Enable  parameter. Click on Help  
or see the parameter description on 
page A-5.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Using Site Manager

To modify the MTU value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the Interface MTU  parameter. Click on 
Help  or see the parameter description on 
A-5.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Defining the Data Path Notify Function

The data path notify function specifies whether the router disables the interfa
between the driver and the higher-level software (the data path interface) wh
you disconnect the cable from the ATM interface.

If you enable this function (the default), when you disconnect the cable from 
interface, the router disables the data path interface after a time you specify.

If you disable this function, the router does not disable the data path interface
continues to send information to the higher-level software.

When you enable the data path notify function, you can also change how long
want the ATM router to wait before disabling the data path interface. By defa
when the state of the physical interface changes from operational to 
nonoperational, the router waits 1 second. However, you can set this timer to
value from 0 to 3600 seconds.

Using the BCC

To disable the data path notify function, navigate to the atm prompt (for exam 
box; atm/11/1 ) and enter:

dp-notify disabled

For example, the following command disables the data path notify function on
ATM interface:

atm/11/1#  dp-notify disabled
atm/11/1#

To reenable the data path notify function, navigate to the atm prompt and ent

dp-notify enabled

To change the data path notify timeout value, navigate to the atm prompt and
enter:

dp-notify-timeout  <integer>

integer is the amount of time (in seconds) that the router can wait before the d
path notify function activates.
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For example, the following command sequence reenables the data path notif
function on the ATM interface and sets the data path notify timeout value to 2
seconds:

atm/11/1#  dp-notify enabled
atm/11/1#  dp-notify-timeout 2400
atm/11/1#

Using Site Manager

To disable or reenable the data path notify function or to change the data pat
notify timeout value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the Data Path Enable parameter. 
Click on Help  or see the parameter 
description on A-6.

4. Set the Data Path Notify Timeout 
parameter. Click on Help  or see the 
parameter description on page A-6.

5. Click on OK. You return to the Select Connection Type 
window.

6. Click on Done . You return to the Configuration Manager 
window.
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Defining the SVC Inactivity Timeout

When you enable the SVC inactivity timeout function (the default), the router
automatically terminates any SVCs that have not received or transmitted any 
If you disable the SVC inactivity timeout function, all SVCs on the line remain
open until you close them by another method.

When enabled, the SVC inactivity timeout function also requires a timer value
This timer value specifies how long you want the ATM router to wait before 
disabling inactive SVCs. By default, if the router does not receive or transmit 
cells for 1200 seconds, the inactive SVCs are disabled. However, you can se
timer to any value from 60 to 3600 seconds.

Using the BCC

To disable the SVC inactivity timeout function, navigate to the atm prompt (fo
example, box; atm/11/1 ) and enter:

vc-inactivity-control disabled

For example, the following command disables the SVC inactivity timeout 
function on the ATM interface:

atm/11/1#  vc-inactivity-control disabled
atm/11/1#

To reenable the SVC inactivity timeout function, navigate to the atm prompt a
enter:

vc-inactivity-control enabled

To change the SVC inactivity timeout value, navigate to the atm prompt and e

vc-inactivity-timeout  <integer>

integer is the amount of time (in seconds) that the router can wait before it 
disables inactive SVCs.

For example, the following command sequence reenables the SVC inactivity
timeout function on the ATM interface and sets the SVC inactivity timeout val
to 2400 seconds:

atm/11/1#  vc-inactivity-control enabled
atm/11/1#  vc-inactivity-timeout 2400
atm/11/1#
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Using Site Manager

To enable or disable the SVC inactivity timeout function or to modify the SVC
inactivity timeout parameter, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the SVC Inactivity Timeout Enable 
parameter. Click on Help  or see the 
parameter description on page A-7.

4. Set the SVC Inactivity Timeout (Secs) 
parameter. Click on Help  or see the 
parameter description on page A-7.

5. Click on OK. You return to the Select Connection Type 
window.

6. Click on Done . You return to the Configuration Manager 
window.
3-8 308612-14.00 Rev 00



Customizing an ATM Interface
 

face 
s 
 

ng 
Assigning the Framing Mode

You can assign various framing modes to an ATM line, depending on the inter
type your device uses. Refer to Table 3-1 to match the appropriate framing mode
to the correct interface type. You can assign the following transceiver framing
modes to the ATM line.

By default, the ATM line uses SONET framing for OC-3 interfaces, Cbit frami
for DS-3 interfaces, and G.832 framing for E-3 interfaces.

Using the BCC

To change the framing mode, navigate to the atm prompt (for example,
box; atm/11/1 ) and enter:

framing-mode  <mode>

mode is one of the following framing modes:

• sdh • g832

• sonet • cbitnofallback

• cbit • clearchannel

• g751

For example, the following command sets the framing mode to SDH:

atm/11/1#  framing-mode sdh
atm/11/1#

Table 3-1. Supported Framing Modes for ATM Interfaces

Framing Mode

Interface
Type SDH SONET DS3_CBIT E3_G751 E3_G832 CBITnofallback ClearChannel

OC-3 9 9

DS-3 9 9 9

E-3 9 9
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Using Site Manager

To assign the framing mode to an ATM line, complete the following tasks:

Defining the Clocking Signal Source

You can specify either an internal or external clocking source for time signals
Internal clocking uses the router clock; external clocking uses the line clock.

Using the BCC

To change the source of the ATM clocking signal, navigate to the atm prompt
example, box; atm/11/1 ) and enter:

clock-signal-source <source>

source is either internal (default) or external.

For example, the following command changes the ATM clocking signal sourc
external:

atm/11/1#  clock-signal-source external
atm/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the Framing Mode parameter. Click 
on Help  or see the parameter description 
on page A-8.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Using Site Manager

To change the clocking signal source for the ATM line, complete the following
tasks:

Specifying DS-3 Line Buildout

On modules that use a DS-3 interface, you can specify how the router condit
signals to migrate attenuation. Specify a short line (the default) for a line less
225 feet (ft) long. Specify a long line for a line length of 225 ft or more.

Using the BCC

To change the DS-3 line buildout, navigate to the atm prompt (for example, box; 
atm/11/1 ) and enter:

ds3-line-build-out <length>

length is either short (default) or long.

For example, the following command changes the DS-3 line buildout to long:

atm/11/1#  ds3-line-build-out long
atm/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the Clocking Signal Source 
parameter. Click on Help  or see the 
parameter description on page A-8.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Using Site Manager

To modify the DS-3 line buildout, complete the following tasks:

Turning DS-3 and E-3 Scrambling On and Off 

Some ATM network equipment can exhibit sensitivity to certain bit patterns (f
example, 101010... or 000000...). This sensitivity can cause problems on the 
network. Turning on the DS-3 and E-3 scrambling function (the default settin
randomizes the bit pattern in the cell payload sufficiently to guarantee cell 
synchronization.

Although some equipment can operate with scrambling disabled, Nortel Netw
recommends that you scramble the cell payload.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the DS3 Line Build Out parameter. 
Click on Help  or see the parameter 
description on page A-9.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.

Caution: ATM devices with different settings for scrambling cannot 
communicate. For example, if you configure a router to enable scrambling an
configure a hub to disable scrambling, the router and hub cannot communica
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Using the BCC

To turn off DS-3 and E-3 scrambling, navigate to the atm prompt (for example
box; atm/11/1 ) and enter:

scrambling off

For example, the following command turns off scrambling on the ATM connec

atm/11/1#  scrambling off
atm/11/1#

To turn scrambling back on, navigate to the atm prompt and enter:

scrambling on

For example, the following command turns the ATM connector scrambling ba
on:

atm/11/1#  scrambling on
atm/11/1#

Using Site Manager

To turn DS-3 scrambling on or off, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the DS3 Scrambling parameter. Click 
on Help  or see the parameter description 
on page A-9.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Enabling and Disabling Per-VC Clipping

Per-VC clipping provides an added traffic-shaping option that allows you to 
modify how your ATM line responds to oversubscribed traffic. By default, per-V
clipping is disabled on a line. However, you can enable or disable per-VC clip
at any time.

When enabled, this option clips frames intended for an oversubscribed VC w
the number of frames in memory exceeds a predetermined limit.

Using the BCC

To enable per-VC clipping, navigate to the atm prompt (for example,
box; atm/11/1 ) and enter:

clipping enabled

For example, the following command enables per-VC clipping on the ATM 
interface:

atm/11/1#  clipping enabled
atm/11/1#

To disable per-VC clipping, navigate to the atm prompt and enter:

clipping disabled

For example, the following command disables per-VC clipping on the ATM 
interface:

atm/11/1#  clipping disabled
atm/11/1#

Note: Changing the state of this parameter tears down all active VCs on the 
interface. The new state takes effect after VC connections are reestablished.
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Using Site Manager

To enable or disable per-VC clipping, complete the following tasks:

Disabling and Reenabling an ATM Interface

By default, the ATM interface is enabled when you create the circuit. Howeve
you can disable or reenable the interface at any time.

When the interface is enabled, traffic can flow over the interface. When the 
interface is disabled, traffic cannot flow over the interface.

Using the BCC

To disable the ATM logical interface, navigate to the ATM interface prompt (fo
example, box; atm/11/1; atm-interface/11/1 ) and enter:

state disabled

For example, the following command disables the ATM interface:

atm-interface/11/1#  state disabled
atm-interface/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes . The ATM/ARE Line Driver Attributes 
window opens.

3. Set the Per-VC Clipping parameter. Click 
on Help  or see the parameter description 
on page A-10.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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To reenable the ATM interface, navigate to the ATM interface prompt and ent

state enabled

For example, the following command reenables the ATM interface:

atm-interface/11/1#  state enabled
atm-interface/11/1#

Using Site Manager

To disable or reenable the ATM interface, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Interface Attributes . The ATM Interface Attributes window 
opens.

3. Set the Administrative State parameter. 
Click on Help  or see the parameter 
description on page A-11.

4. Click on Done . You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Disabling and Reenabling Signaling on an Interface

By enabling ATM signaling (the default setting), you can configure switched 
features (for example, SVCs and LAN emulation) on the interface. If you do n
intend to configure any switched features on the interface (that is, you want t
interface to run only PVCs), disabling ATM signaling makes additional system
resources available.

To disable or reenable signaling on the ATM interface, complete the following
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Interface Attributes . The ATM Interface Attributes window 
opens.

3. Set the Enable ATM Signaling parameter. 
Click on Help  or see the parameter 
description on page A-11.

4. Click on Done . You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Autogenerating ATM Addresses

You can automatically generate the user part (suffix) of SVC ATM addresses
When autogenerating this portion of the ATM addresses, you can use either 
ATM hardware MAC address or a MAC address override value as the end-sta
identifier.

Enabling or Disabling the Hardware MAC Address Feature

If enabled, the hardware MAC address feature uses the MAC address of the 
interface when automatically generating the ATM address user part. Disabling
feature uses the MAC address override value (see the next section) when 
automatically generating the ATM address user part.

Using the BCC

To disable the hardware MAC address feature, navigate to the ATM interface
prompt (for example, box; atm/11/1; atm-interface/11/1 ) and enter:

use-hardware-mac disabled

For example, the following command disables the use of the hardware MAC 
address:

atm-interface/11/1#  use-hardware-mac disabled
atm-interface/11/1#

To reenable the hardware MAC address feature, navigate to the ATM interfac
prompt and enter:

use-hardware-mac enabled

For example, the following command reenables the use of the hardware MAC
address:

atm-interface/11/1#  use-hardware-mac enabled
atm-interface/11/1#

Note: If you disable the hardware MAC address feature, you must enter a 
MAC address override value.
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Using Site Manager

To disable or reenable the use of the hardware MAC address, complete the 
following tasks:

Entering a MAC Address Override Value

The MAC address override value redefines the hardware MAC address for th
interface. It also defines the end-station identifier for the interface when 
automatically generating the user part (suffix) of an SVC ATM address.

Using a MAC address override value is very helpful when you want to hot-sw
ATM link modules. For example, when hot-swapping ATM link modules, you c
enter the MAC address of the original ATM link module as the MAC address 
override value for the new ATM link module. This allows you to keep the 
information already configured on the existing ATM link module while 
maintaining the integrity of the existing client information on the network.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on Interface Attributes . The ATM Interface Attributes window 
opens.

3. Set the Use Hardware MAC Address 
parameter. Click on Help  or see the 
parameter description on page A-12.

4. Click on Done . You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
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Using the BCC

To change the MAC address override value, navigate to the ATM interface pro
(for example, box; atm/11/1; atm-interface/11/1 ) and enter:

mac-override <mac_address>

mac_address is the MAC address you want this interface to use.

For example, the following command changes the MAC address for the ATM
interface:

atm-interface/11/1#  mac-override 000011111aaa
atm-interface/11/1#

Using Site Manager

To change the MAC address that the ATM interface uses, complete the follow
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Interface Attributes . The ATM Interface Attributes window 
opens.

3. Set the MAC Address Override 
parameter. Click on Help  or see the 
parameter description on page A-13.

4. Click on Done . You return to the Select Connection Type 
window.

5. Click on Done . You return to the Configuration Manager 
window.
3-20 308612-14.00 Rev 00



Customizing an ATM Interface
 

 the 

mpt 

that 

mpt 
Defining the Maximum Number of VPCs

You can define the maximum number of virtual path connections (VPCs) that
ATM interface can have.

To change the maximum number of VPCs, navigate to the ATM interface pro
(for example, box; atm/11/1; atm-interface/11/1 ) and enter:

vpcs-maximum <integer>

integer is the maximum number of VPCs the ATM interface can use.

For example, the following command limits the number of VPCs to 128:

atm-interface/11/1#  vpcs-maximum 128
atm-interface/11/1#

Defining the Maximum Number of VCCs

You can define the maximum number of virtual channel connections (VCCs) 
each ATM virtual path can have.

To change the maximum number of VCCs, navigate to the ATM interface pro
(for example, box; atm/11/1; atm-interface/11/1 ) and enter:

vccs-maximum <integer>

integer is the maximum number of VCCs each virtual path can use.

For example, the following command limits the number of VCCs to 128:

atm-interface/11/1#  vccs-maximum 128
atm-interface/11/1#
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Where to Go Next

Use the following table to determine where to go next:

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM . Chapter 2

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for ATM WAN SVC service 
record and WAN SVC parameters.

Chapter 8

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 4
Customizing Signaling

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change som
these values. This chapter describes how to customize signaling details and 
includes the following information:

Topic Page

Defining Signaling 4-2

Defining Signaling Timers 4-16

Defining ILMI 4-29

Defining Control VCs 4-39

Defining SSCOP/Signaling AAL 4-61

Where to Go Next 4-72
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Defining Signaling

ATM signaling allows the router to dynamically establish, maintain, and clear
switched virtual connection at the UNI. Using a series of messages, as define
the Q.2931 standard for signaling protocol (Figure 4-1), the router:

1. Assesses the availability of an ATM end point (device)

2. Establishes a connection with that device

3. Maintains that connection for the duration of the data transfer

4. Clears the connection when the transfer is complete

Figure 4-1. SVC/PVC Signaling Protocol Stack

Nortel Networks ATM routers support ATM signaling functions as defined in t
ATM Forum ATM User-Network Interface specification (Versions 3.0, 3.1, and 
4.0).

Q.2931

Q.SAAL

Protocol

Data 
encapsulation

ATM adaptation layer
(AAL5)

ATM layer

Physical layer

ATM0039A
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Disabling and Reenabling Signaling

By default, signaling is enabled on an interface when you create the signalin
object (BCC) or when you create the circuit (Site Manager). However, you ca
disable and reenable signaling on an interface at any time.

Using the BCC

To disable signaling, navigate to the signaling prompt (for example,
box; atm/11/1; signaling/11/1 ) and enter:

state disabled

For example, the following command disables signaling on the ATM connecto

signaling/11/1#  state disabled
signaling/11/1#

To reenable signaling, navigate to the signaling prompt and enter:

state enabled

For example, the following command reenables signaling on the ATM connec

signaling/11/1#  state enabled
signaling/11/1#

Note: Disabling ATM signaling on an interface automatically sets the data 
encapsulation type to LLC/SNAP and the virtual connection type to PVC for 
any new service records.
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Using Site Manager

To disable or reenable signaling, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Enable  parameter. Click on Help  
or see the parameter description on 
page A-44.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Assigning the UNI Signaling Protocol Standard

The UNI signaling protocol standard specifies how the interface defines Serv
Specific Connection Oriented Protocol (SSCOP) frames. The ATM Forum 
Versions 3.0, 3.1, and 4.0 methods of defining SSCOP frames are incompati

You must assign the same protocol standard for both the router interface and
switch interface to which this interface connects. 

Accept the default, ATM Forum UNI Version 3.0, if the switch interface uses 
ATM Forum UNI Version 3.0 to define SSCOP frames. Change the UNI signa
standard to UNI Version 3.1 or 4.0 if the switch interface uses ATM Forum UN
Version 3.1 or 4.0, respectively, to define SSCOP frames.

Using the BCC

To change the UNI version, navigate to the signaling prompt (for example,
box; atm/11/1; signaling/11/1 ) and enter:

uni-version <version>

version is the UNI signaling version, either v30 (default), v31, or v40.

For example, the following command changes the UNI signaling protocol 
standard to Version 3.1.

signaling/11/1#  uni-version v31
signaling/11/1#
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Using Site Manager

To change the UNI version, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Protocol Standard parameter. 
Click on Help  or see the parameter 
description on page A-45.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Specifying the Maximum Number of SVC Applications

You can specify the maximum number of SVC applications that you want to 
operate on the circuit. The number of applications corresponds to the numbe
LANE or IP (RFC 1577) clients allowed for the circuit.

By default, you can have up to 20 SVC applications on the circuit. However, 
can specify a value from 1 to 32767.

Using the BCC

To change the maximum number of SVC applications, navigate to the signali
prompt (for example, box; atm/11/1; signaling/11/1 ) and enter:

svc-applications-maximum <integer>

integer is a value from 1 to 32767.

For example, the following command sets the maximum number of SVC 
applications on the ATM circuit to 100.

signaling/11/1#  svc-applications-maximum 100
signaling/11/1#
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Using Site Manager

To modify the maximum number of SVC applications on the circuit, complete
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Max Number of SVC 
Applications parameter. Click on Help  or 
see the parameter description on 
page A-45.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Setting Connection Thresholds

Connection thresholds allow you to control the number of point-to-point 
connections, point-to-multipoint connections, and parties in a multipoint 
connection allowed on the circuit at any given time.

Setting the Maximum Number of Point-to-Point Connections

By default, you can have up to 1000 simultaneous point-to-point connections
circuit at any given time. However, you can specify a value from 0 to 32767 
connections.

Using the BCC

To change the maximum number of point-to-point connections, navigate to th
signaling prompt (for example, box; atm/11/1; signaling/11/1 ) and enter:

point-to-point-maximum <integer>

integer is a value from 0 to 32767.

For example, the following command sets the maximum number of point-to-p
connections on the ATM circuit to 2000:

signaling/11/1#  point-to-point-maximum 2000
signaling/11/1#
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Using Site Manager

To modify the maximum number of point-to-point connections on the circuit, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Max Point to Point Connections 
parameter. Click on Help  or see the 
parameter description on page A-46.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Setting the Maximum Number of Point-to-Multipoint Connections

By default, you can have up to 40 simultaneous point-to-multipoint connectio
on a circuit at any given time. However, you can specify a value from 0 to 327
connections.

Using the BCC

To change the maximum number of point-to-multipoint connections, navigate
the signaling prompt (for example, box; atm/11/1; signaling/11/1 ) and enter:

point-to-multipoint-maximum <integer>

integer is a value from 0 to 32767.

For example, the following command sets the maximum number of 
point-to-multipoint connections on the ATM circuit to 100:

signaling/11/1#  point-to-multipoint-maximum 100
signaling/11/1#
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Using Site Manager

To modify the maximum number of point-to-multipoint connections on the 
circuit, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Max Point to Multipoint 
Connections parameter. Click on Help  or 
see the parameter description on 
page A-46.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Setting the Maximum Number of Parties in Multipoint Connections

By default, you can have one party in each multipoint connection on a circuit
any given time. However, you can specify a value from 0 to 32767 parties.

Using the BCC

To change the maximum number of parties in multipoint connections, naviga
the signaling prompt (for example, box; atm/11/1; signaling/11/1 ) and enter:

parties-multipoint-maximum <integer>

integer is a value from 0 to 32767.

For example, the following command sets the maximum number of parties in
multipoint connections to 2:

signaling/11/1#  parties-multipoint-maximum 2
signaling/11/1#

Using Site Manager

To modify the maximum number of parties allowed in multipoint connections,
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Max Parties in Multipoint 
Connections parameter. Click on Help  or 
see the parameter description on 
page A-47.

5. Click on Done . You return to the Edit ATM Connector 
window.

(continued)
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Setting the Minimum Memory Threshold

The minimum memory threshold defines the minimum percentage of buffer 
memory required to enable a new call. The default value is 20 percent, but yo
specify a percentage from 10 to 100 percent in increments of 10 (for example
percent, 30 percent, and so on).

Using the BCC

To change the minimum memory threshold, navigate to the signaling prompt
example, box; atm/11/1; signaling/11/1 ) and enter:

minimum-memory-threshold <value>

value is a percentage from 10 to 100 (in increments of 10).

For example, the following command sets the minimum memory threshold va
to 30 percent:

signaling/11/1#  minimum-memory-threshold 30
signaling/11/1#

Using Site Manager

To change the minimum memory threshold, complete the following tasks:

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

(continued)

Site Manager Procedure  (continued)

You do this System responds
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Defining Signaling Timer Resolution

The signaling timer resolution specifies how much time has elapsed (in tenths
second) between successive timer events.

Using the BCC

To change the signaling timer resolution, navigate to the signaling prompt (fo
example, box; atm/11/1; signaling/11/1 ) and enter:

signaling-timer-resolution <value>

value is the amount of time (in tenths of a second) that you want the signaling
timer resolution to use.

For example, the following command sets the signaling timer resolution to 20

signaling/11/1#  signaling-timer-resolution 2048
signaling/11/1#

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Min Memory Threshold 
parameter. Click on Help  or see the 
parameter description on page A-47.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Defining Signaling Timers

You can change the default values for signaling timers. Table 4-1 provides the 
BCC name, Site Manager name, default value, range, and description for ea
timer.

Caution: Nortel Networks strongly recommends that you use default timer 
values. These values work properly under most ATM network conditions. 
However, if you do change any of the timer values, you must also change the
values at the other end of the UNI (that is, at the local ATM switch).

Table 4-1. Signaling Timer Descriptions

BCC
Name

Site 
Manager 
Name

Default
Value Range Description

alert-rx-timer T301 180 180 to 
1024

Specifies the Alert Received timer value (in 
seconds). This timer begins when the circuit 
initiates a call/connection request by receiving an 
ALERT message over the signaling VC.

The Alert Received timer stops when the circuit 
receives a CONNECT message (indicating 
connection) from the network.

If the circuit does not receive a CONNECT 
message within the allotted time, it clears the 
connection.

This timer can be used with UNI Version 4.0 and 
later.

(continued)
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setup-tx-timer T303 4 1 to 24 Specifies the Setup Sent timer value (in seconds). 
This timer begins when the circuit initiates a call/
connection request by sending a SETUP message 
over the signaling VC.

The Setup Sent timer stops when the circuit 
receives a CONNECT message (indicating 
connection), a CALL PROCEEDING message 
(indicating that the network received the SETUP 
message), or a RELEASE COMPLETE message 
(indicating the rejection of the SETUP message) 
from the network.

If the circuit does not receive one of these 
messages within the allotted time, it transmits the 
SETUP message again. If the circuit still does not 
receive a response, it clears the connection.

setup-ack-rx-timer T304 30 30 to 120 Specifies the Setup Acknowledgement timer value 
(in seconds). This timer begins when the circuit 
receives a SETUP ACK message after initiating a 
call/connection request, and restarts when the 
circuit sends an INFO message over the signaling 
VC. .

The Setup Acknowledgement timer stops when the 
circuit receives a CONNECT message (indicating 
connection), a CALL PROCEEDING message 
(indicating that the network received the SETUP 
message), or an ALERT from the network.

If the circuit does not receive one of these 
messages within the allotted time, it clears the 
connection.

This timer can be used with UNI Version 4.0 and 
later.

(continued)

Table 4-1. Signaling Timer Descriptions  (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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release-tx-timer T308 30 1 to 180 Specifies the Release Sent timer value (in 
seconds). This timer begins when the circuit sends 
a RELEASE message to initiate clearing of an SVC. 
Sending a RELEASE message places the network 
in the Release Request state.

The Release Sent timer stops when the circuit 
receives from the network either a RELEASE 
message (that is, both the circuit and the network 
sent RELEASE messages at the same time) or a 
RELEASE COMPLETE message.

If the timer expires before the circuit receives one of 
these messages, the circuit transmits the RELEASE 
message again. If the circuit still does not receive a 
response, the circuit releases the call reference and 
begins a restart procedure.

datalink-connect-
timer

T309 10 1 to 540 Specifies the SAAL Data Link Connect timer value 
(in seconds). This timer begins when a signaling 
AAL malfunction occurs.

The SAAL Data Link Connect timer stops when the 
circuit reestablishes SAAL (that is, when the circuit 
sends an AAL-ESTABLISH-REQUEST and 
receives an AAL-ESTABLISH-CONFIRM message).

If the timer expires before the circuit can reestablish 
SAAL, the circuit clears the connection.

call-proceeding-
rx-timer

T310 10 1 to 60 Specifies the Call Proceeding Received timer value 
(in seconds). This timer begins when the circuit 
receives a CALL PROCEEDING message from the 
network.

If the signaling VC does not receive a CONNECT or 
RELEASE message before this timer expires, it 
clears the connection for that virtual circuit.

(continued)

Table 4-1. Signaling Timer Descriptions  (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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connect-tx-timer T313 4 1 to 24 Specifies the Connect Sent timer value (in 
seconds). This timer begins when the circuit sends 
a CONNECT message to the network.

The Connect Sent timer stops when the circuit 
receives a CONNECT ACKNOWLEDGE message 
from the network (indicating the completion of the 
ATM connection for that interface).

If the timer expires before the circuit receives a 
CONNECT ACKNOWLEDGE message, the circuit 
clears the connection.

restart-request-tx-
interface-timer

T316 120 1 to 720 Specifies the Restart Request Sent on Interface 
timer value (in seconds). This timer begins when 
the circuit sends a RESTART message to the 
network. The circuit uses the RESTART message to 
return all VCs on the interface to the idle condition.

The Restart Request Sent on Interface timer stops 
when the circuit receives a RESTART 
ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a 
RESTART ACKNOWLEDGE message, the circuit 
can retransmit the RESTART message (see 
“Setting the Number of Allowable Restart 
Messages” on page 4-25). If the circuit still does not 
receive a response, the circuit enters the null state 
until the appropriate maintenance action is taken.

(continued)

Table 4-1. Signaling Timer Descriptions  (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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restart-request-tx-
channel-timer

T316c 120 1 to 720 Specifies the Restart Request Sent on Channel 
timer value (in seconds). This timer begins when 
the circuit sends a RESTART message to the 
network. The circuit uses the RESTART message to 
return this individual VC on the interface to the idle 
condition.

The Restart Request Sent on Channel timer stops 
when the circuit receives a RESTART 
ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a 
RESTART ACKNOWLEDGE message, the circuit 
can retransmit the RESTART message (see 
“Setting the Number of Allowable Restart 
Messages” on page 4-25). If the circuit still does not 
receive a response, the circuit enters the null state 
until the appropriate maintenance action is taken.

status-enquiry-tx-
timer

T322 4 1 to 24 Specifies the Status Enquiry Sent timer value (in 
seconds). This timer begins when the circuit sends 
a STATUS ENQUIRY message to the network. This 
message checks the validity of a call by requesting 
the call state (that is, active, in progress, or null).

The Status Enquiry Sent timer stops when the 
circuit receives a STATUS message from the 
network.

If the timer expires before the circuit receives a 
STATUS message, the circuit can retransmit the 
STATUS ENQUIRY message (see “Setting the 
Number of Allowable Status Enquiries” on 
page 4-26). If the circuit still does not receive a 
response, the circuit clears the call.

(continued)

Table 4-1. Signaling Timer Descriptions  (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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disconnect-timer TDisc 4 1 to 180 Specifies the SAAL Data Link Disconnect timer 
value (in seconds). This internal timer alerts upper 
layers that the link is down. The timer begins if the 
entire link goes down for any reason.

When the link goes down, the SAAL sends a 
DISCONNECT REQUEST message to the 
upper-layer application manager. The SAAL sends 
a disconnect request every time the SAAL Data 
Link Disconnect timer expires and continues to 
send this message until the link becomes 
operational.

alerting-rx-timer T397 180 180 to 
1024

Specifies the Alerting Received timer value (in 
seconds). This timer begins when the circuit 
receives an ALERTING or ADD PARTY ALERTING 
message over the signaling VC. 

The Alerting Received timer stops when the circuit 
receives an ADD PARTY ACKNOWLEDGE 
message. The first time that the timer expires, the 
circuit sends a DROP PART or RELEASE message. 
When the timer expires a second time, the timer will 
not restart.

This timer can be used with UNI Version 4.0 and 
later.

(continued)

Table 4-1. Signaling Timer Descriptions  (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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drop-party-tx-
timer

T398 4 1 to 24 Specifies the Drop Party Sent timer value (in 
seconds). This timer applies to multipoint 
connections only and begins when the circuit sends 
a DROP PARTY message to a party (the receiver of 
the message) on the network.

The Drop Party Sent timer stops when the circuit 
receives a DROP PARTY ACKNOWLEDGE 
message (indicating that the end point used for the 
party has been released) or a RELEASE message 
(indicating that the end point used for the party has 
been released and there are no remaining parties).

The first time that the timer expires, the circuit 
sends a DROP PARTY ACKNOWLEDGE or a 
RELEASE message. When the timer expires a 
second time, it will not restart.

add-party-tx-
timer

T399 14 1 to 84 Specifies the Add Party Sent timer value (in 
seconds). This timer applies to multipoint 
connections only and begins when the circuit sends 
an ADD PARTY message to a party (the receiver of 
the message) on the network.

The Add Party Sent timer stops when the circuit 
receives an ADD PARTY ACKNOWLEDGE 
message (indicating the connection to the party), an 
ADD PARTY REJECT message (indicating the 
inability to add the party), or a RELEASE message 
(indicating the inability to add the party and the 
absence of any remaining parties).

The first time that the timer expires, the circuit 
sends a DROP PARTY or a RELEASE message. 
When the timer expires a second time, it will not 
restart.

If the timer expires before the circuit receives an 
ADD PARTY ACKNOWLEDGE, ADD PARTY 
REJECT, or RELEASE message, the circuit clears 
the party. 

Table 4-1. Signaling Timer Descriptions  (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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Using the BCC

To change a timer value, navigate to the signaling timers prompt (for example
box; atm/11/1; signaling/11/1; timers/11/1 ) and enter:

<timer_name> <integer>

timer_name is the BCC name for the timer (see Table 4-1 for the names and 
descriptions of signaling timers).

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the disconnect timer to 8 seco

timers/11/1#  disconnect-timer 8
timers/11/1#

Using Site Manager

To change a signaling timer value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

(continued)
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4. Set one or more of the following timers:
• T301
• T303
• T304
• T308
• T309
• T310
• T313
• T316
• T316c
• T322
• TDisc
• T397
• T398
• T399
Click on Help  or see the parameter 
descriptions beginning on page A-50.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Defining Retransmissions

The ATM circuit can retransmit a specified number of RESTART and STATUS
ENQUIRY messages before it considers the link down. You can control how m
of these messages the circuit retransmits.

Setting the Number of Allowable Restart Messages

By default, the circuit can retransmit three RESTART messages before it 
considers the link down. However, you can set the number of RESTART mess
that the circuit can send to a value from 1 to 100.

Using the BCC

To change the number of times the ATM circuit can retransmit RESTART 
messages, navigate to the signaling timer prompt (for example,
box; atm/11/1; signaling/11/1; timers/11/1 ) and enter:

restarts-retransmitted <integer>

integer is the number of times a circuit can retransmit RESTART messages.

For example, the following command changes the number of times to 8:

timers/11/1#  restarts-retransmitted 8
timers/11/1#

Using Site Manager

To change the number of times the circuit can retransmit RESTART message
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

(continued)
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Setting the Number of Allowable Status Enquiries

By default, the circuit can retransmit three STATUS ENQUIRY messages befo
considers the link down. However, you can set the number of STATUS ENQU
messages that the circuit can send to a value from 1 to 100.

Using the BCC

To change the number of times the ATM circuit can retransmit STATUS 
ENQUIRY messages, navigate to the signaling timer prompt (for example,
box; atm/11/1; signaling/11/1; timers/11/1 ) and enter:

status-enquiries <integer>

integer is the number of times a circuit can retransmit STATUS ENQUIRY 
messages.

For example, the following command changes the number of times to 8:

timers/11/1#  status-enquiries 8
timers/11/1#

4. Set the Num Restarts ReXmitted  
parameter. Click on Help  or see the 
parameter description on page A-62.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the number of times the circuit can retransmit STATUS ENQUIRY
messages, complete the following tasks:

Disabling and Reenabling Restarts

By default, signaling sends restart messages automatically when a link come
from being in a down state. However, you can specify whether or not you wa
signaling to send these restarts messages.

To disable automatic restart messages, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1 ) and enter:

send-restart disabled

For example, the following command disables restart messages on the ATM 
connector:

signaling/11/1#  send-restart disabled
signaling/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Num Stat Enquiries ReXmitted  
parameter. Click on Help  or see the 
parameter description on page A-63.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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To reenable automatic restart messages, navigate to the signaling prompt an
enter:

send-restart enabled

For example, the following command reenables restart messages on the ATM
connector:

signaling/11/1#  send-restart enabled
signaling/11/1#

Pacing Calls

You can define how the circuit paces its calls. By default, this feature is set to
(off); the circuit transmits call setups at line rate. However, you can set this va
from 0 to 2,147,483,647 calls per second.

To change how the circuit paces its calls, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Set the Num Messages/Sec for Call 
Pacing  parameter. Click on Help  or see 
the parameter description on page A-63.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Defining ILMI

In a switched ATM network, an ATM device must register its ATM address wit
an ATM switch. The router uses the Interim Local Management Interface (ILM
to send and receive initial registration data to and from an ATM switch. Using
series of ILMI SNMP set  and get  commands, the router:

1. Initializes its ATM address table for the interface (the switch also initializes
address table for the interface)

2. Receives the ATM address network prefix from the switch

3. Combines this network prefix with its own user part (suffix)

4. Transmits the entire address to the switch

Disabling and Reenabling ILMI

By default, ILMI is enabled on an interface when you enable signaling. Howe
you can disable and reenable ILMI on an interface at any time.

Using the BCC

To disable ILMI, navigate to the ILMI prompt (for example,
box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

ilmi disabled

For example, the following command disables ILMI on the ATM connector:

ilmi/11/1#  ilmi disabled
ilmi/11/1#

To reenable ILMI, navigate to the ILMI prompt and enter:

ilmi enabled

For example, the following command reenables ILMI on the ATM connector:

ilmi/11/1#  ilmi enabled
ilmi/11/1#
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Using Site Manager

To disable or reenable ILMI on an interface, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Set the Enable  parameter. Click on Help  
or see the parameter description on 
page A-64.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Modifying ILMI Timers and Retry Counters

You can modify the following timers and their associated counters for ILMI:

• ILMI Get Request timer and retry count

• ILMI Get Next Request timer and retry count

• ILMI Set Request timer and retry count

Setting the ILMI Get Request Timer

The ILMI Get Request timer specifies the amount of time allowed for the circ
to receive a GET_RESPONSE message after sending a GET_REQUEST 
message. By default, the circuit waits 3 seconds for a response. However, yo
set this timer to a value from 1 to 120 seconds.

Using the BCC

To change the ILMI Get Request timer value, navigate to the ILMI prompt (fo
example, box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

get-timer  <integer>

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the ILMI Get Request timer to
seconds:

ilmi/11/1#  get-timer 6
ilmi/11/1#
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Using Site Manager

To change the ILMI Get Request timer value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Timer parameter. Click 
on Help  or see the parameter description 
on page A-65.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Setting the ILMI Get Request Retry Count

The ILMI Get Request retry count specifies the number of times the circuit ca
retransmit the ILMI GET_REQUEST message before it considers the link do
By default, the circuit can retransmit three ILMI GET_REQUEST messages. 
However, you can set the number of retries to a value from 1 to 100.

Using the BCC

To change the ILMI Get Request retry count value, navigate to the ILMI prom
(for example, box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

get-retry-count <integer>

integer is the count value that you want the timer to use.

For example, the following command changes the ILMI Get Request retry co
to 6:

ilmi/11/1#  get-retry-count 6
ilmi/11/1#

Using Site Manager

To change the ILMI Get Request retry count value, complete the following ta

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Retry Count  parameter. 
Click on Help  or see the parameter 
description on page A-66.

(continued)
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Setting the ILMI Get Next Request Timer

The ILMI Get Next Request timer specifies the amount of time allowed for the
circuit to receive a GET_NEXT_RESPONSE message after sending a 
GET_NEXT_REQUEST message. By default, the circuit waits 3 seconds for
response. However, you can set this timer to a value from 1 to 120 seconds.

Using the BCC

To change the ILMI Get Next Request timer value, navigate to the ILMI prom
(for example, box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

get-next-timer  <integer>

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the ILMI Get Next Request tim
to 6 seconds:

ilmi/11/1#  get-next-timer 6
ilmi/11/1#

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the ILMI Get Next Request timer value, complete the following tas

Setting the ILMI Get Next Request Retry Count

The ILMI Get Next Request retry count specifies the number of times the circ
can retransmit the ILMI GET_NEXT_REQUEST message before it considers
link down. By default, the circuit can retransmit three ILMI 
GET_NEXT_REQUEST messages. However, you can set the number of retr
a value from 1 to 100.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Next Timer  parameter. 
Click on Help  or see the parameter 
description on page A-66.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Using the BCC

To change the ILMI Get Next Request retry count value, navigate to the ILMI
prompt (for example, box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

get-next-retry-count <integer>

integer is the count value that you want the timer to use.

For example, the following command changes the ILMI Get Next Request re
count to 6:

ilmi/11/1# get-next-retry-count 6
ilmi/11/1#

Using Site Manager

To change the ILMI Get Next Request retry count value, complete the followi
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Next Retry Count  
parameter. Click on Help  or see the 
parameter description on page A-66.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Setting the ILMI Set Request Timer

The ILMI Set Request timer specifies the amount of time allowed for the circu
receive a SET_RESPONSE message after sending a SET_REQUEST mess
By default, the circuit waits 3 seconds for a response. However, you can set 
timer to a value from 1 to 120 seconds.

Using the BCC

To change the ILMI Set Request timer value, navigate to the ILMI prompt (fo
example, box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

set-timer  <integer>

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the ILMI Set Request timer to
seconds:

ilmi/11/1#  set-timer 6
ilmi/11/1#

Using Site Manager

To change the ILMI Set Request timer value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Set Timer  parameter. Click 
on Help  or see the parameter description 
on page A-67.

5. Click on Done . You return to the Edit ATM Connector 
window.

(continued)
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Setting the ILMI Set Request Retry Count

The ILMI Set Request retry count specifies the number of times the circuit ca
retransmit the ILMI SET_REQUEST message before it considers the link dow
By default, the circuit can retransmit three ILMI SET_REQUEST messages. 
However, you can set the number of retries to a value from 1 to 100.

Using the BCC

To change the ILMI Set Request retry count value, navigate to the ILMI prom
(for example, box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

set-retry-count <integer>

integer is the count value that you want the timer to use.

For example, the following command changes the ILMI Set Request retry co
value to 6:

ilmi/11/1#  set-retry-count 6
ilmi/11/1#

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the ILMI Set Request retry count value, complete the following tas

Defining Control VCs

Control VCs are dedicated VPI/VCI pairs reserved for signaling and ILMI 
messages. These VCs remain in an operational state as long as signaling is 
enabled on the ATM interface.

Having dedicated PVCs defined for signaling and ILMI allows the ATM router
send and receive initial registration data to and from an ATM switch.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM Signaling Parameters window 
opens.

4. Set the ILMI Set Retry Count  parameter. 
Click on Help  or see the parameter 
description on page A-67.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Caution: Because most ATM devices use standard VPI/VCI pairs for 
signaling, Nortel Networks recommends that you not change the control VC 
values. However, you can redefine the signaling and ILMI control VCs for 
your specific network.
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Changing VPI Numbers

By default, the VPI for both the signaling and ILMI control VC is 0. However, 
you can change the VPI number to any value from 0 to 255.

Using the BCC

To change the signaling VPI number, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1 ) and enter:

vpi <integer>

integer is the VPI number that you want the signaling VC to use.

For example, the following command changes the signaling VPI number to 8

signaling/11/1# vpi 8
signaling/11/1#

To change the ILMI VPI number, navigate to the ILMI prompt (for example,
box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

vpi <integer>

integer is the VPI number that you want the ILMI VC to use.

For example, the following command changes the ILMI VPI number to 8:

ilmi/11/1#  vpi 8
ilmi/11/1#
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To change the signaling VPI number, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the VPI parameter. Click on Help  or 
see the parameter description on 
page A-48.

6. Click on Done . You return to the ATM Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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To change the ILMI VPI number, complete the following tasks:

Changing VCI Numbers

By default, the VCI for the signaling control VC is 5 and the VCI for the ILMI 
control VC is 16. However, you can change the VCI number to any value from
to 65535.

Using the BCC

To change the signaling VCI number, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1 ) and enter:

vci <integer>

integer is the VCI number that you want the signaling VC to use.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the ILMI VPI parameter. Click on Help  
or see the parameter description on 
page A-64.

6. Click on Done . You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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For example, the following command changes the signaling VCI number to 3

signaling/11/1#  vci 32
signaling/11/1#

To change the ILMI VCI number, navigate to the ILMI prompt (for example,
box; atm/11/1; signaling/11/1; ilmi/11/1 ) and enter:

vci <integer>

integer is the VCI number that you want the ILMI VC to use.

For example, the following command changes the ILMI VCI number to 32:

ilmi/11/1#  vci 32
ilmi/11/1#

Using Site Manager

To change the signaling VCI number, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the VCI parameter. Click on Help  or 
see the parameter description on 
page A-49.

6. Click on Done . You return to the ATM Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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To change the ILMI VCI number, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the ILMI VCI parameter. Click on Help  
or see the parameter description on 
page A-65.

6. Click on Done . You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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Modifying Control VC Traffic Parameters

You can modify the following traffic parameters for both the signaling and the
ILMI control VCs:

• Peak cell rate (PCR)

• Sustainable cell rate (SCR)

• Maximum burst size (MBS)

For additional information about traffic parameters, see “ATM Traffic Paramete
on page 1-23.

Setting the PCR

The peak cell rate (PCR) specifies the upper traffic limit, in cells/s, that the AT
connection can support.

By default, the PCR is set to 4716 cells/s. Table 4-2 lists the valid ranges for each
Nortel Networks ATM router.

For additional information about the PCR, see “Using the PCR” on page 1-24

Table 4-2. Valid PCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 128 to 353,207

Model 5782 Centillion MPE 128 to 353,207

ATM ARE DS-3 ILI pairs 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 128 to 72,000
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Using the BCC

To change the PCR value for the signaling VC, navigate to the signaling VC 
prompt (for example, box; atm/11/1; signaling/11/1; signaling-vc/11/1/0/5 ) and 
enter:

pcr <integer>

integer is the PCR value that you want the signaling VC to use.

For example, the following command changes the PCR value to 8000:

signaling-vc/11/1/0/5#  pcr 8000
signaling-vc/11/1/0/5#

To change the PCR value for the ILMI VC, navigate to the ILMI VC prompt (fo
example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16 ) and enter:

pcr <integer>

integer is the PCR value that you want the ILMI VC to use.

For example, the following command changes the ILMI VC PCR value to 800

ilmi-vc/11/1/0/16#  pcr 8000
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the signaling PCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Xmit Peak Cell Rate (cells/s)  
parameter. Click on Help  or see the 
parameter description on page A-68.

6. Click on Done . You return to the ATM Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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To change the ILMI PCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Xmit Peak Cell Rate (cells/s)  
parameter. Click on Help  or see the 
parameter description on page A-68.

6. Click on Done . You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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Setting the SCR

The sustainable cell rate (SCR) is the upper bound on the conforming averag
of an individual PVC or control VC. The average rate is the number of cells 
transmitted over the link divided by the duration of the connection. The duration 
of the connection is the total amount of time it takes from connection setup to 
connection release.

By default, the SCR is set to 4716 cells/s. Table 4-3 lists the valid ranges for each
Nortel Networks ATM router. To disable the SCR, set the value to 0.

For additional information about the SCR, see “Using the SCR” on page 1-25

Using the BCC

To change the SCR value for signaling VCs, navigate to the signaling VC pro
(for example, box; atm/11/1; signaling/11/1; signaling-vc/11/1/0/5 ) and enter:

scr <integer>

integer is the SCR value that you want the signaling VC to use.

For example, the following command changes the signaling VC SCR value to
8000:

signaling-vc/11/1/0/5#  scr 8000
signaling-vc/11/1/0/5#

Table 4-3. Valid SCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 0, 128 to 353,207

Model 5782 0, 128 to 353,207

ATM ARE DS-3 ILI pairs 0, 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 0, 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 0, 128 to 72,000
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To change the ILMI SCR value, navigate to the ILMI VC prompt (for example 
box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16 ) and enter:

scr <integer>

integer is the SCR value that you want the ILMI VC to use.

For example, the following command changes the ILMI VC SCR value to 800

ilmi-vc/11/1/0/16#  scr 8000
ilmi-vc/11/1/0/16#

Using Site Manager

To change the signaling SCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Xmit Sustainable Cell Rate 
(cells/s) parameter. Click on Help  or see 
the parameter description on page A-69.

6. Click on Done . You return to the ATM Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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To change the ILMI SCR value, complete the following tasks:

Setting the MBS

The maximum burst size (MBS) specifies the maximum number of sequentia
cells allowed on a VC before that VC must relinquish bandwidth to other VCs
waiting to transmit. This burst occurs at or close to the peak cell rate.

When setting the MBS, you should select a value larger than the largest pack
your control VC can transmit (that is, the size of the maximum AAL CPCS 
transmit SDU). For example, if your VC accepts packets that are less than 46
bytes long (PVC default), set your MBS value between 45 and 50 cells.

By default, the MBS is set to 40 cells. However, you can set the MBS to any v
from 1 to 65535 cells.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Xmit Sustainable Cell Rate 
(cells/s)  parameter. Click on Help  or see 
the parameter description on page A-69.

6. Click on Done . You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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For additional information about the MBS, see “Using the MBS” on page 1-26
For information about setting the maximum AAL CPCS transmit SDU size, se
“Modifying the Maximum AAL CPCS SDU Size” on page 4-55.

Using the BCC

To change the MBS value for signaling VCs, navigate to the signaling VC pro
(for example, box; atm/11/1; signaling/11/1; signaling-vc/11/1/0/5 ) and enter:

tx-burst-size <integer>

integer is the MBS value that you want the signaling VC to use.

For example, the following command changes the MBS value to 80 cells:

signaling-vc/11/1/0/5#  tx-burst-size 80
signaling-vc/11/1/0/5#

To change the MBS value for ILMI VCs, navigate to the ILMI VC prompt (for 
example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16 ) and enter:

tx-burst-size <integer>

integer is the MBS value that you want the ILMI VC to use.

For example, the following command changes the MBS value to 80 cells:

ilmi-vc/11/1/0/16#  tx-burst-size 80
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the signaling control VC MBS value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Xmit Burst Size (cells)  
parameter. Click on Help  or see the 
parameter description on page A-70.

6. Click on Done . You return to the ATM Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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To change the ILMI control VC MBS value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Xmit Burst Size (cells)  
parameter. Click on Help  or see the 
parameter description on page A-70.

6. Click on Done . You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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Modifying the Maximum AAL CPCS SDU Size

The maximum AAL CPCS SDU value defines the maximum packet size you 
intend the control VC to transmit or receive.

Setting the Transmit SDU Size

Nortel Networks suggests that you accept the default value of 4608 bytes for
maximum AAL CPCS SDU size that the control VC supports in the transmit 
direction. Most packet sizes fall well within this limit. However, you can set th
transmit SDU size to any value from 1 to 65,535 bytes.

Using the BCC

To change the transmit SDU size for the signaling control VC, navigate to the
signaling VC prompt (for example, box; atm/11/1; signaling/11/1;
signaling-vc/11/1/0/5 ) and enter:

tx-sdu-maximum <integer>

integer is the maximum SDU size that you want the signaling VC to transmit.

For example, the following command changes the maximum transmit SDU siz
65,535 bytes:

signaling-vc/11/1/0/5#  tx-sdu-maximum 65535
signaling-vc/11/1/0/5#

To change the transmit SDU size for the ILMI control VC, navigate to the ILM
VC prompt (for example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16 ) and 
enter:

tx-sdu-maximum <integer>

integer is the maximum SDU size that you want the ILMI VC to transmit.

For example, the following command changes the maximum transmit SDU siz
65,535 bytes:

ilmi-vc/11/1/0/16#  tx-sdu-maximum 65535
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the maximum transmit SDU size for the signaling control VC, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Maximum AAL CPCS Transmit 
SDU Size parameter. Click on Help  or see 
the parameter description on page A-71.

6. Click on Done . You return to the ATM Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select ConnectionType 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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To change the maximum transmit SDU size for the ILMI control VC, complete
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Maximum AAL CPCS Transmit 
SDU Size parameter. Click on Help  or see 
the parameter description on page A-71.

6. Click on Done . You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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Setting the Receive SDU Size

Nortel Networks suggests that you accept the default value of 4608 bytes for
maximum AAL CPCS SDU size that the control VC supports in the receive 
direction. Most packet sizes fall well within this limit. However, you can set th
receive SDU size to any value from 1 to 65,535 bytes.

Using the BCC

To change the receive SDU size for the signaling control VC, navigate to the 
signaling VC prompt (for example, box; atm/11/1; signaling/11/1;
signaling-vc/11/1/0/5 ) and enter:

rx-sdu-maximum <integer>

integer is the maximum SDU size that you want the signaling VC to receive.

For example, the following command changes the maximum receive SDU siz
65,535 bytes:

signaling-vc/11/1/0/5#  rx-sdu-maximum 65535
signaling-vc/11/1/0/5#

To change the receive SDU size for the ILMI control VC, navigate to the ILMI
VC prompt (for example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16 ) and 
enter:

rx-sdu-maximum <integer>

integer is the maximum SDU size that you want the ILMI VC to receive.

For example, the following command changes the maximum receive SDU siz
65,535 bytes:

ilmi-vc/11/1/0/16#  rx-sdu-maximum 65535
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the maximum receive SDU size for the signaling control VC, comp
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling . The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Maximum AAL CPCS Receive 
SDU Size parameter. Click on Help  or see 
the parameter description on page A-71.

6. Click on Done . You return to the ATM Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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To change the maximum receive SDU size for the ILMI control VC, complete 
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI) .

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Maximum AAL CPCS Receive 
SDU Size parameter. Click on Help  or see 
the parameter description on page A-71.

6. Click on Done . You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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Defining SSCOP/Signaling AAL

As defined by the ATM Forum, the SSCOP (or Q.SAAL) resides between the
ATM adaptation layer and the Q.2931 signaling layer. SSCOP/SAAL reliably 
transports signaling messages between peer Q.2931 entities over the ATM 
adaptation layer (Figure 4-2).

Figure 4-2. SVC/PVC Signaling Protocol Stack

Nortel Networks routers support SSCOP/SAAL functions as defined in the AT
Forum ATM User-Network Interface specification (Versions 3.0 and 3.1).

Q.2931

Q.SAAL

Protocol

Data 
encapsulation

ATM adaptation layer
(AAL5)

ATM layer

Physical layer

ATM0039A
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Disabling and Reenabling SSCOP/SAAL

By default, SSCOP/SAAL is enabled on an interface when you create the cir
However, you can disable or reenable this signaling on an interface at any tim

Using the BCC

To disable SSCOP on the interface, navigate to the SSCOP prompt (for exam
box; atm/11/1; signaling/11/1; sscop/11/1 ) and enter:

state disabled

For example, the following command disables SSCOP on the ATM interface:

sscop/11/1#  state disabled
sscop/11/1#

To reenable SSCOP, navigate to the SSCOP prompt and enter:

state enabled

For example, the following command reenables SSCOP on the ATM interfac

sscop/11/1# state enabled
sscop/11/1#
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Using Site Manager

To disable or reenable SSCOP, complete the following tasks:

Defining the Link Connection Arbitration

Link connection arbitration defines whether SSCOP/SAAL initiates link 
connections (active, the default value) or waits for connections (passive).

Using the BCC

To make link connection arbitration passive, navigate to the SSCOP prompt (
example, box; atm/11/1; signaling/11/1; sscop/11/1 ) and enter:

link-connect-arbitration passive

For example, the following command specifies that SSCOP waits for connect

sscop/11/1#  link-connect-arbitration passive
sscop/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL) . The ATM Signaling AAL Records List 
window opens.

4. Set the Enable  parameter. Click on Help  
or see the parameter description on 
page A-72.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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To change link connection arbitration to active, navigate to the SSCOP prom
and enter:

link-connect-arbitration active

For example, the following command specifies that SSCOP initiates connect

sscop/11/1#  link-connect-arbitration active
sscop/11/1#

Using Site Manager

To set the SSCOP link arbitration state, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL) . The ATM Signaling AAL Records List 
window opens.

4. Set the Link Connection Arbitration 
parameter. Click on Help  or see the 
parameter description on page A-72.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Modifying SAAL Timers

You can change the default values for SSCOP/SAAL timers. For each timer, 
Table 4-4 provides the BCC name, Site Manager name, default value, range, 
description.

Note: Nortel Networks recommends that you leave these timers set to their 
default values unless instructed to change them by Nortel Networks Custome
Service or your switch provider.

Table 4-4. SSCOP/SAAL Timer Descriptions

BCC Name

Site 
Manager 
Name

Default 
Value Range Description

poll-timer Poll Timer 7 1 to 120 Specifies the SSCOP poll timer value (in tenths of a 
second). This value sets the allowable time between 
POLL PDU transmissions.

The poll timer ensures that the receiver continues to 
return a solicited status (STAT) PDU to the sender on a 
regular basis. The timely receipt of STAT PDUs restarts 
the poll timer and allows for more efficient transmission 
error recovery.

keep-alive-
timer

Keep Alive 
Timer

20 1 to 120 Specifies the SSCOP keep alive timer value (in tenths of 
a second). This value sets the allowable time between 
POLL PDU transmissions if there are no pending 
sequence data (SD) PDUs.

The keep alive timer is generally greater than the poll 
timer and greater than the length of one round-trip delay.

(continued)
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Using the BCC

To change an SSCOP timer value, navigate to the SSCOP prompt (for exam
box; atm/11/1; signaling/11/1; sscop/11/1 ) and enter:

<timer_name> <integer>

timer_name is the BCC name for the timer (see Table 4-4 for the names and 
descriptions of SSCOP timers).

integer is the time value (in tenths of a second) that you want the timer to use

For example, the following command changes the poll timer to 2 seconds.

sscop/11/1# poll-timer 20
sscop/11/1#

no-response-
timer

No 
Response 
Timer

70 1 to 120 Specifies the SSCOP no response timer value (in tenths 
of a second). This value sets the allowable time between 
the receipt of STAT PDUs.

So as not to interrupt the flow of data, SSCOP does not 
require a reply to every POLL PDU. This can cause 
problems in detecting a failed connection. To alleviate 
this problem, the no response timer runs parallel to the 
poll timer. If both the no response timer and the poll 
timer expire, SSCOP clears the connection.

The no response timer value must equal at least the sum 
of the keep alive timer plus the length of one round-trip 
delay.

connection-
control-timer

Connection 
Control 
Timer

10 1 to 120 Specifies the SSCOP connection control (CC) timer 
value (in tenths of a second). This value sets the 
allowable time between the transmission of begin 
(BGN), END, resynchronization (RS), and error recovery 
(ER) PDUs, as long as the sender has not received an 
acknowledgment to any of these PDUs.

The CC timer must equal at least the length of one 
round-trip delay.

Table 4-4. SSCOP/SAAL Timer Descriptions  (continued)

BCC Name

Site 
Manager 
Name

Default 
Value Range Description
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Using Site Manager

To change an SSCOP/SAAL timer value, complete the following tasks:

Defining PDU Values

SSCOP/SAAL allows you to customize several values that control PDUs.

Setting the SSCOP Maximum Connection Control Value

The SSCOP maximum connection control value sets the maximum number o
times the sender can transmit a BGN, END, RS, or ER PDU.

By default, the sender can transmit up to four of these messages. However, y
can set this parameter to any value from 1 to 20 messages.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL) . The ATM Signaling AAL Records List 
window opens.

4. Set one or more of the following 
parameters:
• Poll Timer
• Keep Alive Timer
• No Response Timer
• Connection Control Timer
Click on Help  or see the parameter 
descriptions beginning on page A-73.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Using the BCC

To change the maximum connection control value, navigate to the SSCOP pr
(for example, box; atm/11/1; signaling/11/1; sscop/11/1 ) and enter:

connect-control-maximum <integer>

integer is the count value that you want the controller to use.

For example, the following command changes the maximum connection con
value to 6:

sscop/11/1#  connect-control-maximum 6
sscop/11/1#

Using Site Manager

To change the maximum connection control value, complete the following tas

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL) . The ATM Signaling AAL Records List 
window opens.

4. Set the Max Connection Control  
parameter. Click on Help  or see the 
parameter description on page A-75.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Setting the SSCOP Maximum Poll Data Value

The SSCOP maximum poll data value sets the maximum value of the poll da
state variable before transmitting a POLL PDU. The poll data state variable 
increments upon transmission of a sequenced data PDU and resets to 0 upo
transmission of a POLL PDU.

By default, the maximum poll data value sets the poll data state to 25. Howev
you can set this parameter to any value from 1 to 120.

Using the BCC

To change the maximum poll data value, navigate to the SSCOP prompt (for
example, box; atm/11/1; signaling/11/1; sscop/11/1 ) and enter:

pd-before-poll-maximum <integer>

integer is the count value that you want the controller to use.

For example, the following command changes the maximum poll data value t

sscop/11/1#  pd-before-poll-maximum 50
sscop/11/1#

Using Site Manager

To change the maximum poll data value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL) . The ATM Signaling AAL Records List 
window opens.

4. Set the Max PD Before Poll  parameter. 
Click on Help  or see the parameter 
description on page A-75.

5. Click on Done . You return to the Edit ATM Connector 
window.

(continued)
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Setting the SSCOP Maximum STAT PDU Value

The SSCOP maximum STAT PDU value sets the maximum number of list 
elements allowed in a STAT PDU.

The sending device uses this value for segmentation purposes. When the nu
of list elements exceeds this value, the STAT message segments. As a gener
the default value, 67, causes the STAT PDU to fill six ATM cells using
AAL 5. You can set this value to any odd integer from 3 to 119.

Using the BCC

To change the maximum number of list elements allowed in a STAT PDU, 
navigate to the SSCOP prompt (for example, box; atm/11/1; signaling/11/1; 
sscop/11/1 ) and enter:

stat-pdu-elements-maximum <integer>

integer is the maximum number of elements (any odd number from 3 to 119) 
allowed in a STAT PDU.

For example, the following command changes the maximum number of STAT
PDU elements to 81:

sscop/11/1#  stat-pdu-elements-maximum 81
sscop/11/1#

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the maximum number of list elements allowed in a STAT PDU, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL) . The ATM Signaling AAL Records List 
window opens.

4. Set the Max STAT PDU Elements  
parameter. Click on Help  or see the 
parameter description on page A-76.

5. Click on Done . You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for ATM WAN SVC service 
record and WAN SVC parameters.

Chapter 8

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 5
Customizing PVC Service

Records and PVCs

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change som
these values.

This chapter describes how to customize PVC service record parameters an
to define the PVCs that operate on PVC service records. It includes the follow
information:

Topic Page

Disabling and Reenabling a PVC Service Record 5-2

Defining the Service Record MTU 5-3

Deleting a Service Record 5-6

Designating a PVC as Hybrid/Bridged 5-7

Disabling and Reenabling a PVC 5-9

Modifying ATM Traffic Parameters 5-11

Modifying the Maximum AAL CPCS SDU Size 5-17

Assigning a Data Encapsulation Type 5-20

Changing PVC OAM Parameters 5-22

Copying a PVC 5-23

Deleting a PVC 5-24

Where to Go Next 5-26
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This chapter describes how to customize existing PVC service records and P
For instructions on how to define a new PVC service record and PVC, see 
Chapter 2, “Starting ATM and ATM Router Redundancy.”

Disabling and Reenabling a PVC Service Record

By default, you enable a service record when you add it to the interface. How
you can disable and reenable a specific service record at any time. Disable t
service record to stop traffic flow over it and any of its VCs. Otherwise, enable
service record.

Using the BCC

To disable a PVC service record, navigate to the service record prompt (for 
example, box; atm/11/1; pvc-service/boston ) and enter:

state disabled

For example, the following command disables the PVC service record:

pvc-service/boston#  state disabled
pvc-service/boston#

To reenable a PVC service record, navigate to the prompt and enter:

state enabled

For example, the following command reenables the PVC service record:

pvc-service/boston#  state enabled
pvc-service/boston#
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Using Site Manager

To disable or reenable a PVC service record, complete the following tasks:

Defining the Service Record MTU

The MTU is the largest possible unit of data that the PVC service record can
transmit. By default, the service record allows an MTU size of 4608 octets. T
value can handle most packet sizes. 

The MTU size is typically determined by the driver. However, you can overrid
the driver default to accommodate connection to devices that require differen
MTU sizes. You can set the MTU to any value from 1 to 9188 octets.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Set the Enable/Disable parameter. Click 
on Help  or see the parameter description 
on page A-14.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.

Note: Some ATM devices do not negotiate MTU size. When connecting to 
such a device, Nortel Networks recommends that you specify an MTU size o
9188 octets for full compatibility with RFC 1577.
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Using the BCC

To change the MTU value of the ATM service record, navigate to the service 
record prompt (for example, box; atm/11/1; pvc-service/boston ) and enter:

mtu <integer>

integer is the MTU size in octets that you want the PVC service record to use

For example, the following command sets the service record MTU size to 91
octets:

pvc-service/boston#  mtu 9188
pvc-service/boston#

Using Site Manager

To change the MTU size for a service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Set the MTU parameter. Click on Help  or 
see the parameter description on 
page A-19.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Changing the Service Name

The service name is a value that uniquely defines each service record you cr
In the BCC, you enter the service name when you create the service record.
cannot change that name. To use a different service name, you must create 
service record.

In Site Manager, however, the router arbitrarily assigns a unique value to eac
service record you create. You can accept the value that the router assigns, o
change that value to any alphanumeric string. However, each service record 
have a unique service name.

Using the BCC

You cannot change the service name in the BCC after you use it to create a s
record. To use a different service name, you must create a new service recor
information about creating a service record using the BCC, see “Defining an A
Service Record” on page 2-3.

Using Site Manager

To change the service name, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the service record that you want 
to modify.

5. Set the Service Name parameter. Click on 
Help  or see the parameter description on 
page A-20.

6. Click on Done . You return to the Edit ATM Connector 
window.

(continued)
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Deleting a Service Record

You can use the BCC or Site Manager to delete a PVC service record.

Using the BCC

To delete a PVC service record, navigate to the service record prompt (for 
example, box; atm/11/1; pvc-service/boston ) and enter:

delete

For example, the following command deletes PVC service record boston:

pvc-service/boston# delete
atm/11/1#

Using Site Manager

To delete a PVC service record, complete the following tasks:

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to delete.

5. Click on Delete . Site Manager deletes the service record.

(continued)

Site Manager Procedure  (continued)

You do this System responds
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Designating a PVC as Hybrid/Bridged

PVCs do not typically allow for bridging in nonmeshed environments. If your 
network combines bridging and routing over the same interface, you need to
the service record portion of each PVC for routing, while at the same time 
allowing bridging to operate. To do this, you must define the PVC as a hybrid
bridged VC.

By default, a PVC does not operate as a hybrid/bridged VC. However, you ca
configure any PVC to operate as one.

For more information about PVC access methods, including hybrid access, s
“PVC Access Methods” on page 1-17.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.

Note: When you define a PVC as a hybrid/bridged VC, Site Manager provides
additional Bridge, Spanning Tree, Source Routing (SR), SR Spanning Tree, 
Translational/Learning bridge (Translate/LB), and Native Mode LAN (NML) 
protocol options. These protocols run on the PVC along with the protocols 
defined in the ATM service record.

Site Manager Procedure  (continued)

You do this System responds
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To designate a PVC as hybrid/bridged, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Set the Hybrid/Bridged VC parameter. 
Click on Help  or see the parameter 
description on page A-22.

7. Click on Done . You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Disabling and Reenabling a PVC

By default, a PVC is enabled (Up) when you add it to the service record. Howe
you can disable or reenable the PVC at any time.

When the PVC is enabled, traffic can flow over it. When the PVC is disabled,
traffic cannot flow over it.

Using the BCC

To disable a PVC, navigate to the PVC prompt (for example, box; atm/11/1; 
pvc-service/boston; pvc/11/1/0/32 ) and enter:

state disabled

For example, the following command disables the PVC:

pvc/11/1/0/32#  state disabled
pvc/11/1/0/32#

To reenable the PVC, navigate to the PVC prompt and enter:

state enabled

For example, the following command reenables the PVC:

pvc/11/1/0/32#  state enabled
pvc/11/1/0/32#

Using Site Manager

To disable or reenable a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

(continued)
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4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Administrative State parameter. 
Click on Help  or see the parameter 
description on page A-22.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Modifying ATM Traffic Parameters

You can modify the following traffic parameters for PVCs:

• Peak cell rate (PCR)

• Sustainable cell rate (SCR)

• Maximum burst size (MBS)

For additional information about traffic parameters, see “ATM Traffic Paramete
on page 1-23.

Setting the PCR

The peak cell rate (PCR) specifies the upper traffic limit, in cells/s, that the AT
connection can support.

By default, the PCR is set to 4716 cells/s. Table 5-1 lists the valid ranges for each
Nortel Networks ATM router.

For additional information about the PCR, see “Using the PCR” on page 1-24

Table 5-1. Valid PCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 128 to 353,207

Model 5782 VNR 128 to 353,207

ATM ARE DS-3 ILI pairs 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 128 to 72,000
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Using the BCC

To change the PCR value for a PVC, navigate to the PVC prompt (for examp
box; atm/11/1; pvc-service/boston; pvc/11/1/0/32 ) and enter:

pcr <integer>

integer is the PCR value that you want the PVC to use.

For example, the following command changes the PVC PCR value to 8000:

pvc/11/1/0/32#  pcr 8000
pvc/11/1/0/32#

Using Site Manager

To change the PVC PCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Xmit Peak Cell Rate (cells/s)  
parameter. Click on Help  or see the 
parameter description on page A-23.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

(continued)
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Setting the SCR

The sustainable cell rate (SCR) is the upper bound on the conforming averag
of an individual PVC or control VC. The average rate is the number of cells 
transmitted over the link divided by the duration of the connection. The duration 
of the connection is the total amount of time it takes from connection setup to 
connection release.

By default, the SCR is set to 4716 cells/s. Table 5-2 lists the valid ranges for each
Nortel Networks ATM router. To disable the SCR, set the value to 0.

For additional information about the SCR, see “Using the SCR” on page 1-25

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.

Table 5-2. Valid SCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 0, 128 to 353,207

Model 5782 0, 128 to 353,207

ATM ARE DS-3 ILI pairs 0, 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 0, 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 0, 128 to 72,000

Site Manager Procedure  (continued)

You do this System responds
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Using the BCC

To change the PVC SCR value, navigate to the PVC prompt (for example,
box; atm/11/1; pvc-service/boston; pvc/11/1/0/32 ) and enter:

scr <integer>

integer is the SCR value that you want the PVC to use.

For example, the following command changes the PVC SCR value to 8000:

pvc/11/1/0/32#  scr 8000
pvc/11/1/0/32#

Using Site Manager

To change the PVC SCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Xmit Sustainable Cell Rate 
(cells/s) parameter. Click on Help  or see 
the parameter description on page A-24.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

(continued)
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Setting the MBS

The maximum burst size (MBS) specifies the maximum number of sequentia
cells allowed on a VC before that VC must relinquish bandwidth to other VCs
waiting to transmit. This burst occurs at or close to the peak cell rate.

When setting the MBS, you should select a value larger than the largest pack
that the PVC can transmit (that is, the size of the maximum AAL CPCS trans
SDU). For example, if your PVC accepts packets that are less than 4608 byt
long (PVC default), set your MBS value between 45 and 50 cells.

By default, the MBS is set to 40 cells. However, you can set the MBS to any v
from 1 to 65,535 cells.

For additional information about the MBS, see “Using the MBS” on page 1-2
For information about setting the maximum AAL CPCS transmit SDU size, s
“Modifying the Maximum AAL CPCS SDU Size” on page 5-17.

Using the BCC

To change the PVC MBS value, navigate to the PVC prompt (for example,
box; atm/11/1; pvc-service/boston; pvc/11/1/0/32 ) and enter:

tx-burst-size <integer>

integer is the MBS value that you want the PVC to use.

For example, the following command changes the PVC MBS value to 80 cell

pvc/11/1/0/32#  tx-burst-size 80
pvc/11/1/0/32#

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the PVC MBS value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Xmit Burst Size (cells)  
parameter. Click on Help  or see the 
parameter description on page A-25.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.
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Modifying the Maximum AAL CPCS SDU Size

The maximum AAL common part convergence sublayer (CPCS) service data
(SDU) value defines the maximum packet size you intend the PVC to transm
receive.

Setting the Transmit SDU Size

Nortel Networks suggests that you accept the default value of 4608 bytes for
maximum AAL CPCS SDU size that the VC supports in the transmit direction
Most packet sizes fall well within this limit. However, you can set the transmit
SDU size to any value from 1 to 65,535 bytes.

Using the BCC

To change the transmit SDU size for the PVC, navigate to the PVC prompt (f
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32 ) and enter:

tx-sdu-maximum <integer>

integer is the maximum SDU size that you want the PVC to transmit.

For example, the following command changes the maximum transmit SDU siz
65,535 bytes:

pvc/11/1/0/32#  tx-sdu-maximum 65535
pvc/11/1/0/32#
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Using Site Manager

To change the maximum transmit SDU size for a PVC, complete the followin
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Maximum AAL CPCS Transmit 
SDU Size parameter. Click on Help  or see 
the parameter description on page A-25.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.
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Setting the Receive SDU Size

Nortel Networks suggests that you accept the default value of 4608 bytes for
maximum AAL CPCS SDU size that the PVC supports in the receive directio
Most packet sizes fall well within this limit. However, you can set the receive 
SDU size to any value from 1 to 65,535 bytes.

Using the BCC

To change the receive SDU size for the PVC, navigate to the PVC prompt (fo
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32 ) and enter:

rx-sdu-maximum <integer>

integer is the maximum SDU size that you want the PVC to receive.

For example, the following command changes the maximum receive SDU siz
65,535 bytes:

pvc/11/1/0/32#  rx-sdu-maximum 65535
pvc/11/1/0/32#

Using Site Manager

To change the maximum receive SDU size for a PVC, complete the following
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

(continued)
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Assigning a Data Encapsulation Type

You can choose LLC/SNAP (the default value), NULL, or NLPID data 
encapsulation to operate on the PVC. Assigning the data encapsulation type 
PVC level overrides the encapsulation type assigned at the service record le

For additional information about assigning data encapsulation types, see “Da
Encapsulation Methods” on page 1-13.

Using the BCC

To change the data encapsulation for a PVC, navigate to the PVC prompt (fo
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32 ) and enter:

encapsulation <type>

type is one of the following data encapsulation types:

• llc/snap

• null

• nlpid

7. Set the Maximum AAL CPCS Receive 
SDU Size parameter. Click on Help  or see 
the parameter description on page A-26.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.

Note: If you select NULL, the router interprets this as virtual, channel-based 
multiplexing, which is not supported for bridging.

Site Manager Procedure  (continued)

You do this System responds
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For example, the following command changes the data encapsulation type fo
PVC to NLPID encapsulation:

pvc/11/1/0/32#  encapsulation nlpid
pvc/11/1/0/32#

Using Site Manager

To change the PVC data encapsulation type, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Data Encapsulation Type  
parameter. Click on Help  or see the 
parameter description on page A-26.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.
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Changing PVC OAM Parameters

The Operations and Management (OAM) feature provides a mechanism by w
ATM devices can receive prompt notification of PVC failures. OAM uses spec
loopback cells or alarms to detect PVC failures. These mechanisms decreas
amount of time between an actual PVC failure and when the router is aware o
failure. When using OAM loopback cells, the time can decrease to only a few
seconds; when using OAM alarms, the detection is almost instantaneous.

To change the PVC OAM parameters, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set one or more of the following 
parameters:
• OAM Loopback Enable
• OAM Loopback Cell Interval
• OAM Threshold 1
• OAM Threshold 2
• OAM Alarm Enable
See the parameter descriptions beginning 
on page A-78.

8. Click on Apply .

9. Click on Done . You return to the ATM Service Records 
List window.

10. Click on Done . You return to the Edit ATM Connector 
window.

(continued)
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Copying a PVC

To copy an existing PVC, complete the following tasks:

11. Click on Done . You return to the Select Connection Type 
window.

12. Click on Done . You return to the Configuration Manager 
window.

Note: When copying a hybrid PVC, the copy function copies all existing 
PVC-specific information to the new PVC. However, this function does not 
copy the protocols that you selected and configured for that PVC. You must 
select and configure any protocols that you want to operate over the newly 
copied PVC.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record 
containing the PVC that you want to copy.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to copy.

7. Click on Copy. The ATM Virtual Channel Link 
Parameters window opens.

8. Set the VPI Number parameter. Click on 
Help  or see the parameter description on 
page A-21.

(continued)

Site Manager Procedure  (continued)

You do this System responds
308612-14.00 Rev 00 5-23



Configuring ATM Services

ord 
Deleting a PVC

You can use the BCC or Site Manager to delete a PVC.

Using the BCC

To delete a PVC, navigate to the PVC prompt (for example, box; atm/11/1; 
pvc-service/boston; pvc/11/1/0/32 ) and enter:

delete

For example, the following command deletes PVC 11/1/0/32 from service rec
boston:

pvc/11/1/0/32# delete
pvc-service/boston#

9. Set the VCI Number  parameter. Click on 
Help  or see the parameter description on 
page A-21.

10. Click on OK. You return to the ATM Virtual Channel 
Link window.

11. Click on Done . You return to the ATM Service Records 
List window.

12. Click on Done . You return to the Edit ATM Connector 
window.

13. Click on Done . You return to the Select Connection Type 
window.

14. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To delete a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the PVC service record 
containing the PVC that you want to 
delete.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to delete.

7. Click on Delete . Site Manager deletes the PVC.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.
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Use the following table to determine where to go next.

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for ATM WAN SVC service 
record and WAN SVC parameters.

Chapter 8

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 6
Customizing Classical IP Service Records

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change som
these values.

This chapter describes how to customize ATM classical IP service record 
parameters and includes the following information:

For general information about classical IP, see “Classical IP over ATM Conce
on page 1-28.

Topic Page

Disabling and Reenabling a Classical IP Service Record 6-2

Disabling and Reenabling User Part Autogeneration 6-4

Entering an ATM Address Network Prefix 6-6

Entering an ATM Address User Part 6-8

Deleting a Service Record 6-10

Where to Go Next 6-11
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Disabling and Reenabling a Classical IP Service Record

By default, you enable a classical IP service record when you add it to the 
interface. However, you can disable or reenable a specific service record at a
time. Disable the service record to stop traffic flow over it and any of its VCs.
Otherwise, enable the service record.

Using the BCC

To disable a classical IP service record, navigate to the service record promp
example, box; atm/11/1; classical-ip-service/dallas ) and enter:

state disabled

For example, the following command disables the service record:

classical-ip-service/dallas#  state disabled
classical-ip-service/dallas#

To reenable the service record, navigate to the prompt and enter:

state enabled

For example, the following command reenables the service record:

classical-ip-service/dallas#  state enabled
classical-ip-service/dallas#
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Using Site Manager

To disable or reenable a classical IP service record, complete the following ta

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to modify.

5. Set the Enable/Disable parameter. Click 
on Help  or see the parameter description 
on page A-14.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Disabling and Reenabling User Part Autogeneration

By default, when you add an SVC service record (that is, a LANE or classica
service record), the user part autogeneration feature is enabled. However, yo
disable or reenable this feature on an individual service record at any time.

For information about setting the end-station identifier for user part 
autogeneration, see “Autogenerating ATM Addresses” on page 3-18.

Using the BCC

To disable the user part autogeneration feature, navigate to the service recor
prompt (for example, box; atm/11/1; classical-ip-service/dallas ) and enter:

autogenerate disabled

For example, the following command disables user part autogeneration on th
service record:

classical-ip-service/dallas# autogenerate disabled
classical-ip-service/dallas#

To reenable user part autogeneration on the service record, navigate to the p
and enter:

autogenerate enabled

For example, the following command reenables user part autogeneration on 
service record:

classical-ip-service/dallas#  autogenerate enabled
classical-ip-service/dallas#

Note: If you disable autogeneration, you must manually enter an ATM address
user part. See “Entering an ATM Address User Part” on page 6-8.
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Using Site Manager

To disable or reenable user part autogeneration on a classical IP service rec
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to modify.

5. Set the User Part Autogeneration 
parameter. Click on Help  or see the 
parameter description on page A-16.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Entering an ATM Address Network Prefix

The ATM address network prefix specifies the ATM domain of which the serv
record is a part. This 13-byte portion of the ATM address can range from 
XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF.

The XX byte must contain 39, 45, or 47. These values define the authority an
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format the prefix uses. For more information abo
the AFI byte, refer to the ATM Forum UNI specification.

Entering an ATM address network prefix is optional. If you do not enter a netw
prefix in the specified range, the service record accepts the first prefix value th
receives from the switch.

Using the BCC

To assign an ATM address network prefix to a classical IP service record, nav
to the service record prompt (for example, box; atm/11/1; 
classical-ip-service/dallas ) and enter:

network-prefix <address>

address is the ATM address network prefix that you want the VCs on the serv
record to use.

For example, the following command defines the ATM address network prefix
the service record as 39000000000000000000000000:

classical-ip-service/dallas#  network-prefix 39000000000000000000000000
classical-ip-service/dallas#
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Using Site Manager

To assign an ATM address network prefix to a classical IP service record, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to modify.

5. Set the ATM Addr Net Prefix parameter. 
Click on Help  or see the parameter 
description on page A-17.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Entering an ATM Address User Part

The ATM address user part (suffix) consists of a 6-byte end-station identifier a
1-byte selector field. This 7-byte portion of the ATM address can range from 
00000000000000 to FEFFFFFFFFFFFF.

You can either autogenerate this value (see “Disabling and Reenabling User Part
Autogeneration” on page 6-4) or you can enter the value manually.

Using the BCC

To assign an ATM address user part to a classical IP service record, navigate
service record prompt (for example, box; atm/11/1; classical-ip-service/dallas ) 
and enter:

user-suffix <address>

address is the ATM address user part that you want the VCs on the service re
to use.

For example, the following command defines the ATM address user part on t
service record as 00000000000001:

classical-ip-service/dallas#  user-suffix 00000000000001
classical-ip-service/dallas#
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Using Site Manager

To assign an ATM address user part to a classical IP service record, complet
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to modify.

5. Set the ATM Addr User Part parameter. 
Click on Help  or see the parameter 
description on page A-16.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Deleting a Service Record

You can use the BCC or Site Manager to delete a classical IP service record

Using the BCC

To delete a classical IP service record, navigate to the service record prompt
(for example, box; atm/11/1; classical-ip-service/dallas ) and enter:

delete

For example, the following command deletes classical IP service record dalla

classical-ip-service/dallas# delete
atm/11/1#

Using Site Manager

To delete a classical IP service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to delete.

5. Click on Delete . Site Manager deletes the service record.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for ATM WAN SVC service 
record and WAN SVC parameters.

Chapter 8

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 7
Customizing LAN Emulation
Service Records and Clients

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change som
these values.

This chapter describes how to customize an existing LANE service record an
LAN emulation client (LEC) that operates on that service record. It includes t
following information:

Topic Page

Disabling and Reenabling a LANE Service Record 7-2

Disabling and Reenabling User Part Autogeneration 7-3

Entering an ATM Address Network Prefix 7-5

Entering an ATM Address User Part 7-6

Selecting a LEC Configuration Mode 7-8

Assigning an Emulated LAN Name 7-10

Assigning an Emulated LAN Type 7-12

Specifying an Emulated LAN Segment ID 7-14

Disabling and Reenabling the LANE Client 7-15

Specifying an Owner 7-16

Assigning ATM LES Addresses 7-17

Setting the Maximum Data Frame Size 7-26

Controlling Unknown Frame Distribution 7-28

Modifying LEC Timers and Retry Counters 7-32

(continued)
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For information about how to define a new LANE service record, see Chapte
“Customizing an ATM Interface.”

Disabling and Reenabling a LANE Service Record

By default, you enable a service record when you add it to the interface. How
you can disable and reenable a specific service record at any time. Enable th
service record to allow traffic to flow over it and any of its VCs. Otherwise, 
disable the service record.

Using the BCC

To disable a LANE service record, navigate to the LANE service record prom
(for example, box; atm/11/1; lec-service/newyork ) and enter:

state disabled

For example, the following command disables the LANE service record newy

lec-service/newyork#  state disabled
lec-service/newyork#

To reenable the LANE service record, navigate to the LANE service record 
prompt and enter:

state enabled

For example, the following command reenables the LANE service record 
newyork:

lec-service/newyork#  state enabled
lec-service/newyork#

Modifying Flush Protocol Variables 7-44

Specifying a LECS ATM Address 7-48

Enabling and Disabling LAN Emulation Version 2 7-49

Deleting a Service Record 7-50

Where to Go Next 7-52

Topic Page
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Using Site Manager

To disable or reenable a LANE service record, complete the following tasks:

Disabling and Reenabling User Part Autogeneration

By default, when you add an SVC service record (that is, a LANE or classica
service record), the user part autogeneration feature is enabled. However, yo
disable or reenable this feature on an individual service record at any time.

For information about setting the end-station identifier for user part 
autogeneration, see “Autogenerating ATM Addresses” on page 3-18.

Using the BCC

To disable the user part autogeneration feature, navigate to the LANE servic
record prompt (for example, box; atm/11/1; lec-service/newyork ) and enter:

autogenerate disabled

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the Enable/Disable parameter. Click 
on Help  or see the parameter description 
on page A-14.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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For example, the following command disables user part autogeneration on th
service record newyork:

lec-service/newyork#  autogenerate disabled
lec-service/newyork#

To reenable user part autogeneration on the service record, navigate to the L
service record prompt and enter:

autogenerate enabled

For example, the following command reenables user part autogeneration on 
service record newyork:

lec-service/newyork# autogenerate enabled
lec-service/newyork#

Using Site Manager

To disable or reenable user part autogeneration on a LANE service record, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the User Part Autogeneration 
parameter. Click on Help  or see the 
parameter description on page A-16.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Entering an ATM Address Network Prefix

The ATM address network prefix specifies the ATM domain of which the serv
record is a part. This 13-byte portion of the ATM address can range from 
XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF.

The XX byte must contain 39, 45, or 47. These values define the authority an
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format the prefix uses. For more information abo
the AFI byte, refer to the ATM Forum UNI specification.

Entering an ATM address network prefix is optional. If you do not enter a netw
prefix in the specified range, the service record accepts the first prefix value th
receives from the switch.

Using the BCC

To assign an ATM address network prefix to a service record, navigate to the
service record prompt (for example, box; atm/11/1; lec-service/newyork ) and 
enter:

network-prefix <address>

address is the ATM address network prefix that you want the service record to
use.

For example, the following command defines the ATM address network prefix
the service record as 39000000000000000000000000:

lec-service/newyork#  network-prefix 39000000000000000000000000
lec-service/newyork#
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Using Site Manager

To assign an ATM address network prefix to a LANE service record, complete
following tasks:

Entering an ATM Address User Part

The ATM address user part (suffix) consists of a 6-byte end-station identifier a
1-byte selector field. This 7-byte portion of the ATM address can range from 
00000000000000 to FEFFFFFFFFFFFF.

You can either autogenerate this value (see “Disabling and Reenabling User Part
Autogeneration” on page 7-3) or you can enter the value manually.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the ATM Addr Net Prefix parameter. 
Click on Help  or see the parameter 
description on page A-16.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Using the BCC

To assign an ATM address user part to a service record, navigate to the serv
record prompt (for example, box; atm/11/1; lec-service/newyork ) and enter:

user-part <address>

address is the ATM address user part that you want the VCs on the service re
to use.

For example, the following command defines the ATM address user part on t
service record as 00000000000001.

lec-service/newyork#  user-part 00000000000001
lec-service/newyork#

Using Site Manager

To assign an ATM address user part to a LANE service record, complete the
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the ATM Addr User Part parameter. 
Click on Help  or see the parameter 
description on page A-16.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Selecting a LEC Configuration Mode

A LEC can run in either automatic or manual mode. In automatic mode (the 
default selection), the LE client uses the LAN emulation server (LES) addres
receives from the LAN emulation configuration server (LECS) to join an ELAN

You can bypass the LECS by choosing manual mode. For manual mode, you
specify the LES address and the LAN type of the ELAN you want the LE clien
join. For information about LAN types, see “Assigning an Emulated LAN Type” 
on page 7-12. For information about configuring the LES address, see “Assigning 
ATM LES Addresses” on page 7-17.

Using the BCC

To change the LEC configuration mode, navigate to the service record promp
example, box; atm/11/1; lec-service/newyork ) and enter:

config-mode <mode>

mode is the configuration mode that you want the LEC to use, either manual 
automatic.

For example, the following command changes the LEC configuration mode to
manual:

lec-service/newyork#  config-mode manual
lec-service/newyork#
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Using Site Manager

To change the LEC configuration mode, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Configuration Mode parameter. 
Click on Help  or see the parameter 
description on page A-33.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Assigning an Emulated LAN Name

Emulated LAN (ELAN) names are optional values that provide administrative
assistance when you need to distinguish a LEC as belonging to one of sever
ELANs. You can specify an ELAN name up to 128 alphanumeric characters.

If you choose not to enter an ELAN name, the LECS assigns the LE client to
ELAN for this domain. However, because some switches do not support a de
emulated LAN, Nortel Networks recommends that you assign an ELAN nam
the LEC.

Using the BCC

To assign an emulated LAN name, navigate to the service record prompt (for
example, box; atm/11/1; lec-service/newyork ) and enter:

emulated-lan-name <value>

value is the alphanumeric string that identifies the emulated LAN that you wa
this LEC to join.

For example, the following command assigns the LEC to the emulated LAN 
marketing:

lec-service/newyork#  emulated-lan-name marketing
lec-service/newyork#
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Using Site Manager

To assign an emulated LAN name to a LEC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Emulated LAN Name parameter. 
Click on Help  or see the parameter 
description on page A-33.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Assigning an Emulated LAN Type

The emulated LAN type specifies the data frame format that the LEC uses wh
joins an emulated LAN. ATM allows you to choose from three emulated LAN
types: unspecified (the default), IEEE 802.3, or IEEE 802.5.

When you assign unspecified as the LAN type, the client obtains the ELAN ty
from the LECS when it joins an emulated LAN. When you assign IEEE 802.3
IEEE 802.5, the client joins only Ethernet or token ring ELANs (respectively).

Using the BCC

To change the emulated LAN type, navigate to the service record prompt (fo
example, box; atm/11/1; lec-service/newyork ) and enter:

lan-type <value>

value is the type of ELAN that you want this LEC to join: unspecified, ieee802
or ieee8025.

For example, the following command allows the LEC to join only Ethernet
(IEEE 802.3) emulated LANs:

lec-service/newyork#  lan-type ieee8023
lec-service/newyork#

Note: If you set the LE client to run in manual configuration mode (see 
“Selecting a LEC Configuration Mode” on page 7-8), you must specify an 
ELAN type of IEEE 802.3 or IEEE 802.5.
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Using Site Manager

To change the emulated LAN type for a LANE client, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Emulated LAN Type parameter. 
Click on Help  or see the parameter 
description on page A-33.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Specifying an Emulated LAN Segment ID

You must specify an emulated LAN segment ID when:

• The LANE client is a token ring end station. A LANE client is a token ring
end station when it resides at the edge of a token ring network.

• You are routing IP or IPX across a source route bridging (SRB) token ring
network.

The emulated LAN segment ID specifies the ring ID (in decimal) on which the
LANE client resides. By default, this value is set to 0. However, you can spec
value from 0 to 4095 for the token ring segment ID.

To change the emulated LAN segment ID, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Emulated LAN Segment ID 
parameter. Click on Help  or see the 
parameter description on page A-40.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Disabling and Reenabling the LANE Client

By default, the LANE client is enabled on a service record when you assign 
LANE data encapsulation to that service record. However, you can disable o
reenable the LANE client on a service record at any time.

To disable or reenable a LANE client, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Enable parameter. Click on Help  
or see the parameter description on 
page A-32.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Specifying an Owner

Specifying a LEC owner is optional. This entry (up to 128 alphanumeric 
characters) provides administrative assistance when distinguishing among L

To specify a LEC owner, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Owner parameter. Click on Help  
or see the parameter description on 
page A-32.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Assigning ATM LES Addresses

LE clients use the LAN emulation server (LES) to establish the control direct
VCC. The LEC must know the LES address to obtain this information before
can join an emulated LAN. The LES address consists of a user part and a ne
prefix.

If you select manual configuration mode, you must enter at least one LES ad
(see “Selecting a LEC Configuration Mode” on page 7-8). If you select automatic 
configuration mode, you do not need to enter a LES address. The LE client 
receives the LES ATM address from the LAN emulation configuration server 
(LECS).

You can configure a prioritized list of up to four LES addresses per LAN 
emulation client. After you assign the list of addresses, the LEC references th
and attempts to access the first LES address entry you created. If this attemp
unsuccessful, the LEC attempts to connect to the next LES address, and so 
When the LEC reaches the last address in the list, it starts again at the beginn
the list until it successfully joins an emulated LAN.

Using the BCC

To specify a LES address, navigate to the service record prompt (for exampl 
box; atm/11/1; lec-service/newyork ) and enter:

les name <name> address <address>

name is a text string that you assign to identify the LES.

address is the full LES ATM address.

For example, the following command creates a LES with the name primary a
the address 3900000000000000000000000000000000abcdef.

lec-service/newyork#  les name primary address 39000000000000000000 
00000000000000abcdef
les/primary#
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Using Site Manager

To specify a LES address, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Configuration Mode  parameter to 
Manual . Click on Help  or see the 
parameter description on page A-33.

7. Click on LES. The ATM LES List window opens.

8. Click on Add . The LANE Redundancy window opens.

9. Set the following parameters:
• LE Server ATM Address Network 

Prefix 
• LE Server ATM Address User Part 
Click on Help  or see the parameter 
descriptions beginning on page A-42.

10. Click on OK. You return to the ATM LES List window.

11. Click on Done . You return to the LAN Emulation 
Parameters window.

12. Click on OK. You return to the ATM Service Records 
List window.

13. Click on Done . You return to the Edit ATM Connector 
window.

14. Click on Done . You return to the Select Connection Type 
window.

15. Click on Done . You return to the Configuration Manager 
window.
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Disabling and Reenabling a LES Entry

By default, you enable a LES entry when you add it to the service record. 
However, you can disable or reenable a specific LES entry at any time. You en
the LES entry to allow a LEC to access that address for information. Otherwi
disable the LES entry.

Using the BCC

To disable a LES entry, navigate to the LES prompt (for example, box; atm/11/1; 
lec-service/newyork; les/primary ) and enter:

state disabled

For example, the following command disables the LES primary:

les/primary#  state disabled
les/primary#

To reenable a LES entry, navigate to the LES prompt and enter:

state enabled

For example, the following command reenables the LES primary:

les/primary# state enabled
les/primary#
308612-14.00 Rev 00 7-19



Configuring ATM Services
Using Site Manager

To disable or reenable a LES entry, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES that you want to modify.

8. Set the Enable  parameter. Click on Help  
or see the parameter description on 
page A-42.

9. Click on Done . You return to the LAN Emulation 
Parameters window.

10. Click on OK. You return to the ATM Service Records 
List window.

11. Click on Done . You return to the Edit ATM Connector 
window.

12. Click on Done . You return to the Select Connection Type 
window.

13. Click on Done . You return to the Configuration Manager 
window.
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Changing the LE Server Name

The LE server name is a value that uniquely defines each LAN emulation ser
(LES) that you create. In the BCC, you enter the LE server name when you c
the LES. You cannot change that name. To use a different name, you must a
new LE server to the configuration.

In Site Manager, however, the router arbitrarily assigns a unique value to eac
server that you add. You can accept the value that the router assigns, or cha
that value to any alphanumeric string. However, each LE server must have a
unique name.

Using the BCC

You cannot change the LE server name in the BCC after you use it to add a 
To use a different name, you must add a new LES to the configuration. For 
information about adding a LES using the BCC, see “Assigning ATM LES 
Addresses” on page 7-17.

Using Site Manager

To change the LE server name, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Set the LE Service Name parameter. 
Click on Help  or see the parameter 
description on page A-43.

(continued)
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Inserting a LES Address Out of Sequence

Using Site Manager, you can insert a LES address between two existing LES
addresses by completing the following tasks:

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.

Note: You cannot insert a LES address out of sequence using the BCC. The
BCC uses the first LES that you enter as the primary, the second LES as the
secondary, and so on.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES address in the list after 
which you want to add the new address.

The settings for this LES appear in the 
parameter boxes.

8. Click on Add After . The LANE Redundancy window opens.

(continued)

Site Manager Procedure  (continued)

You do this System responds
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Modifying a LES Entry

You can modify the parameters associated with a LES entry at any time. To 
modify a LES entry, complete the following tasks:

9. Set the following parameters:
• LE Server ATM Address Network 

Prefix 
• LE Server ATM Address User Part 
Click on Help  or see the parameter 
descriptions beginning on page A-42.

10. Click on OK. You return to the ATM LES List window.

11. Click on Done . You return to the LAN Emulation 
Parameters window.

12. Click on OK. You return to the ATM Service Records 
List window.

13. Click on Done . You return to the Edit ATM Connector 
window.

14. Click on Done . You return to the Select Connection Type 
window.

15. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

(continued)

Site Manager Procedure  (continued)

You do this System responds
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Deleting a LES Entry

You can delete a LES entry at any time.

Using the BCC

To delete a LES, navigate to the LES prompt (for example, box; atm/11/1; 
lec-service/newyork; les/primary ) and enter:

delete

For example, the following command deletes the LES primary:

les/primary#  delete
lec-service/newyork#

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES that you want to modify.

8. Set one or more of the following 
parameters:
• Enable
• LE Server ATM Address Network 

Prefix 
• LE Server ATM Address User Part 
Click on Help  or see the parameter 
descriptions beginning on page A-42.

9. Click on Done . You return to the LAN Emulation 
Parameters window.

10. Click on OK. You return to the ATM Service Records 
List window.

11. Click on Done . You return to the Edit ATM Connector 
window.

12. Click on Done . You return to the Select Connection Type 
window.

13. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To delete a LES address, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES address that you want to 
delete.

The settings for this LES appear in the 
parameter boxes.

8. Click on Delete .

9. Click on Done . You return to the LAN Emulation 
Parameters window.

10. Click on OK. You return to the ATM Service Records 
List window.

11. Click on Done . You return to the Edit ATM Connector 
window.

12. Click on Done . You return to the Select Connection Type 
window.

13. Click on Done . You return to the Configuration Manager 
window.
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Setting the Maximum Data Frame Size

The maximum data frame size is the largest frame that the LE client can:

• Send on the multicast send VCC.

• Receive on the multicast forward VCC.

• Send and receive on data direct VCCs.

When you accept the default, unspecified, the LEC obtains the maximum da
frame size when it joins an ELAN. However, you can limit the maximum data
frame size that the LEC can transmit or receive to 1516 octets.

Using the BCC

To change the maximum data frame size, navigate to the service record prom
(for example, box; atm/11/1; lec-service/newyork ) and enter:

maximum-data-frame-size <value>

value is the maximum data frame size that you want the LEC to transmit, eith
unspecified or 1516.

For example, the following command changes the maximum data frame size
1516 octets:

lec-service/newyork#  maximum-data-frame-size 1516
lec-service/newyork#
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Using Site Manager

To change the maximum data frame size, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Maximum Data Frame Size 
parameter. Click on Help  or see the 
parameter description on page A-34.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Controlling Unknown Frame Distribution

A frame is considered unknown when the LE client does not recognize the 
destination MAC address. An unknown frame goes to the broadcast and unk
server (BUS) for distribution. Setting unknown frame variables helps to limit 
unknown frame traffic to the BUS.

To control the distribution of unknown frames, you can specify the following:

• Maximum number of unknown frames that the LEC can send

• Amount of time allowed to send the unknown frames to the BUS

Setting a Maximum Unknown Frame Count

By default, a LEC can send only one unknown frame to the BUS within a 
specified unknown frame time (see the next section, “Specifying a Maximum 
Unknown Frame Time”). However, you can allow a LEC to send up to 10 
unknown frames to the BUS within the maximum unknown frame time.

Using the BCC

To change the maximum unknown frame count value, navigate to the service
record prompt (for example, box; atm/11/1; lec-service/newyork ) and enter:

maximum-unknown-frame <value>

value is the maximum number of unknown frames (from 1 to 10) that the LEC 
send to the BUS within the maximum unknown frame time.

For example, the following command changes the maximum unknown frame
count to 5:

lec-service/newyork#  maximum-unknown-frame 5
lec-service/newyork#
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Using Site Manager

To change the maximum unknown frame count, complete the following tasks

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Max Unknown Frame Count 
parameter. Click on Help  or see the 
parameter description on page A-36.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Specifying a Maximum Unknown Frame Time

The unknown frame time specifies the maximum amount of time allowed to s
unknown frames to the BUS. For instructions on setting the unknown frame co
see “Setting a Maximum Unknown Frame Count” on page 7-28. By default, the 
LEC can send the allowable number of unknown frames for a maximum of 1 
second. However, you can specify up to 60 seconds for the maximum unkno
frame time.

For example, if you accept the default values for the unknown frame count an
frame time, a LEC can send one unknown frame within 1 second for any give
MAC address without having to initiate the Address Resolution Protocol (ARP
resolve that MAC address.

Using the BCC

To change the maximum unknown frame time, navigate to the service record
prompt (for example, box; atm/11/1; lec-service/newyork ) and enter:

maximum-unknown-frame-time <value>

value is the maximum amount of time allowed (from 1 to 60 seconds) to send
number of unknown frames.

For example, the following command changes the maximum unknown frame 
to 10 seconds:

lec-service/newyork#  maximum-unknown-frame-time 5
lec-service/newyork#
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Using Site Manager

To change the maximum unknown frame time, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Max Unknown Frame Time 
parameter. Click on Help  or see the 
parameter description on page A-36.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Modifying LEC Timers and Retry Counters

You can modify the following timers and counters for each LEC:

• Control timeout

• VCC timeout period

• Maximum retry count

• Aging time

• Forward delay time

• Expected LE_ARP response time

• Path switching delay

Setting the Control Timeout

The control timeout parameter specifies the timeout period used for most req
response control frame interactions. The default timeout is 5 seconds, but yo
set it to any value from 5 to 32,767 seconds.

Using the BCC

To change the control timeout, navigate to the service record prompt (for exam 
box; atm/11/1; lec-service/newyork ) and enter:

control-timeout <value>

value is the timeout period you want the LEC to use for control frame interacti

For example, the following command changes the control timeout to 10 seco

lec-service/newyork#  control-timeout 10
lec-service/newyork#
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Using Site Manager

To change the control timeout, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Control Timeout parameter. Click 
on Help  or see the parameter description 
on page A-35.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Disabling and Reenabling the VCC Timeout Period

When you enable the VCC timeout period (the default setting), the LEC can 
release any unused data direct or multicast send VCCs after the VCC timeou
period expires. The ATM drivers provide a VCC timeout period of 20 minutes
you disable the VCC timeout period, the LEC does not release any unused d
direct or multicast send VCCs.

Using the BCC

To disable the VCC timeout period, navigate to the service record prompt (fo
example, box; atm/11/1; lec-service/newyork ) and enter:

vcc-timeout disabled

For example, the following command disables the VCC timeout period on LA
service record newyork:

lec-service/newyork#  vcc-timeout disabled
lec-service/newyork#

To reenable the VCC timeout period, navigate to the service record prompt a
enter:

vcc-timeout enabled

For example, the following command reenables the VCC timeout period on 
LANE service record newyork:

lec-service/newyork#  vcc-timeout enabled
lec-service/newyork#
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Using Site Manager

To disable or reenable the VCC timeout period, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the VCC Timeout Period Enable 
parameter. Click on Help  or see the 
parameter description on page A-37.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Setting the Maximum Retry Count

The maximum retry count specifies the maximum number of times a LEC ca
retry an LE_ARP_REQUEST (following the original request) for any given fram
MAC address. You can allow either one (the default) or two retries.

Using the BCC

To change the maximum retry count, navigate to the service record prompt (f
example, box; atm/11/1; lec-service/newyork ) and enter:

maximum-retry-count <value>

value is the maximum number of times (1 or 2) that you want the LEC to retry
LE_ARP_REQUEST for any given frame MAC address.

For example, the following command changes the maximum retry count to 2:

lec-service/newyork#  maximum-retry-count 2
lec-service/newyork#

Using Site Manager

To change the maximum retry count, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Max Retry Count parameter. Click 
on Help  or see the parameter description 
on page A-37.

(continued)
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Setting the Aging Time

The aging time specifies the maximum amount of time that a LEC can mainta
entry in its LE_ARP cache without having to verify the relationship of that ent

By default, the LEC maintains entries for 300 seconds. However, you can se
aging time to a value from 10 to 300 seconds.

Using the BCC

To change the aging time, navigate to the service record prompt (for example 
box; atm/11/1; lec-service/newyork ) and enter:

aging-time <value>

value is the number of seconds (from 10 to 300) that you want the LEC to 
maintain LE_ARP cache entries.

For example, the following command changes the aging time to 150 seconds

lec-service/newyork#  aging-time 150
lec-service/newyork#

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the aging time, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Aging Time parameter. Click on 
Help  or see the parameter description on 
page A-38.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Setting the Forward Delay Time

As long as there are no changes occurring in the network topology, the forwa
delay time parameter specifies the maximum amount of time that a LEC can
maintain an entry in its LE_ARP cache without having to verify the relationsh
of that entry.

By default, the LEC maintains entries for 15 seconds, as long as the network
topology does not change. However, you can set the forward delay time to a 
from 4 to 30 seconds.

Using the BCC

To change the forward delay time, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork ) and enter:

forward-delay-time <value>

value is the number of seconds (from 4 to 30) that you want the LEC to maint
LE_ARP cache entries.

For example, the following command changes the forward delay time to 15 
seconds:

lec-service/newyork# forward-delay-time 15
lec-service/newyork#

Using Site Manager

To change the forward delay time, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

(continued)
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Specifying the Expected LE_ARP Response Time

The expected LE_ARP response time specifies the amount of time that the L
expects an ARP request and ARP response cycle to take. The LEC uses this
during retries and verifications.

By default, the LEC expects an ARP request and ARP response cycle to take
maximum of 3 seconds. However, you can set the LE_ARP response time to
value from 1 to 30 seconds.

Using the BCC

To change the expected LE_ARP response time, navigate to the LANE servi
record prompt (for example, box; atm/11/1; lec-service/newyork ) and enter:

arp-response-time <value>

value is the number of seconds (from 1 to 30) that the LEC expects an ARP 
request and ARP response cycle to take.

For example, the following command changes the expected LE_ARP respon
time to 15 seconds:

lec-service/newyork#  arp-response-time 15
lec-service/newyork#

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Forward Delay Time parameter. 
Click on Help  or see the parameter 
description on page A-38.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the expected LE_ARP response time, complete the following task

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Expected LE_ARP Response 
Time parameter. Click on Help  or see the 
parameter description on page A-38.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Setting the Path Switching Delay

The path switching delay specifies the amount of time that the LEC waits afte
sending a frame over an existing VCC before it switches to a new VCC (this 
applies to multicast and data direct VCCs).

You can use the path switching delay parameter to bypass the flush protocol
When you disable the flush protocol, the data for a specific MAC address 
automatically begins flowing over a new VCC when the path switching delay t
elapses. (For instructions on disabling the flush protocol, see “Modifying Flush 
Protocol Variables” on page 7-44.)

By default, the LEC waits a maximum of 6 seconds after sending a frame ove
existing VCC before it switches to a new VCC. However, you can set the pat
switching delay to a value from 1 to 8 seconds.

Using the BCC

To change the path switching delay, navigate to the LANE service record pro
(for example, box; atm/11/1; lec-service/newyork ) and enter:

path-switching-delay <value>

value is the number of seconds (from 1 to 8) that you want the LEC to wait af
sending a frame over an existing VCC before switching to a new VCC.

For example, the following command changes the path switching delay to 8 
seconds:

lec-service/newyork#  path-switching-delay 8
lec-service/newyork#
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Using Site Manager

To change the path switching delay, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Path Switching Delay parameter. 
Click on Help  or see the parameter 
description on page A-39.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Modifying Flush Protocol Variables

The flush protocol ensures that data destined for a particular MAC address a
in sequence. This means that after the LEC issues a flush request, the flush 
protocol drops any cells it receives for the particular MAC address until:

• The LEC receives a flush response from that MAC address.

• The flush timeout expires for that MAC address.

If the client receives a flush response from the MAC address, the cells for thi
MAC address begin flowing over a new virtual circuit. However, if the flush 
timeout expires for this MAC address, the cells begin flowing to the BUS.

Disabling and Reenabling the Flush Protocol

You can disable or reenable the flush protocol for any LEC.

When enabled (the default), the flush protocol drops cells with the current 
destination MAC address until the LEC receives a flush response for that MA
address or the flush timeout expires (see “Setting the Flush Timeout” on 
page 7-46).

When the flush protocol is disabled, cells containing the destination MAC add
are dropped until the path switching delay times out. After the path switching
delay time elapses, the data automatically begins flowing over a new virtual 
circuit.
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Using the BCC

To disable the flush protocol, navigate to the LANE service record prompt (fo
example, box; atm/11/1; lec-service/newyork ) and enter:

flush-protocol disabled

For example, the following command disables the flush protocol on LANE 
service record newyork:

lec-service/newyork#  flush-protocol disabled
lec-service/newyork#

To reenable the flush protocol, navigate to the LANE service record prompt a
enter:

flush-protocol enabled

For example, the following command reenables the flush protocol on LANE 
service record newyork:

lec-service/newyork# flush-protocol enabled
lec-service/newyork#

Using Site Manager

To disable or reenable the flush protocol, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

(continued)
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Setting the Flush Timeout

The flush timeout specifies the amount of time that the LEC waits to receive 
flush response (after sending a flush request) before it takes recovery action
switching to the BUS.

By default, the LEC waits 4 seconds for a flush response. However, you can 
the flush timeout to a value from 1 to 4 seconds.

Using the BCC

To change the flush timeout value, navigate to the service record prompt (for
example, box; atm/11/1; lec-service/newyork ) and enter:

flush-timeout <value>

value is the number of seconds (from 1 to 4) that the LEC waits for a flush 
response.

For example, the following command changes the flush timeout value to 2 
seconds:

lec-service/newyork#  flush-timeout 2
lec-service/newyork#

6. Set the Flush Protocol parameter. Click 
on Help  or see the parameter description 
on page A-40.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To change the flush timeout value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Flush Timeout parameter. Click 
on Help  or see the parameter description 
on page A-39.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Specifying a LECS ATM Address

You can specify which LAN emulation configuration server (LECS) you want 
LE client to use when opening a configuration VCC to the configuration servi
Entering this ATM address is optional; if you do not enter an address, the LE
uses the well-known LECS ATM address to open a configuration VCC.

Using the BCC

To specify a LECS ATM address, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork ) and enter:

config-server-atm-address <address>

address is the ATM address of the LECS that you want the LEC to use.

For example, the following command specifies the LECS address 
3900000000000000000000000000000000000001 for LANE service record 
newyork:

lec-service/newyork#  config-server-atm-address 390000000000000000000 
0000000000000000001
lec-service/newyork#

Using Site Manager

To specify a LECS ATM address, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

(continued)
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Enabling and Disabling LAN Emulation Version 2

By default, LAN Emulation Version 2 is disabled on a service record. Howeve
you can enable or disable this function at any time.

If the LEC operates in an MPOA environment, you must enable the LAN 
Emulation Version 2 function. Otherwise, disable the function.

To enable or disable the LAN Emulation Version 2 function, complete the 
following tasks:

6. Set the LE Config Server ATM Address 
parameter. Click on Help  or see the 
parameter description on page A-41.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

(continued)

Site Manager Procedure  (continued)

You do this System responds
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Deleting a Service Record

You can use the BCC or Site Manager to delete a LANE service record.

Using the BCC

To delete a LANE service record, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork ) and enter:

delete

For example, the following command deletes the LANE service record newyo

lec-service/newyork#  delete
atm/11/1#

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the LAN Emulation Version 2 
parameter. Click on Help  or see the 
parameter description on page A-41.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.

Site Manager Procedure  (continued)

You do this System responds
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Using Site Manager

To delete a LANE service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the LAN emulation service record 
that you want to delete.

5. Click on Delete . Site Manager deletes the service record.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 8
Customizing WAN SVC Service

Records and WAN SVCs

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change som
these values.

This chapter describes how to customize WAN SVC service record paramete
and how to define the WAN SVCs that operate on WAN SVC service records
includes the following information:

This chapter describes how to customize existing WAN SVC service records 
WAN SVCs. For instructions on how to define a new WAN SVC service recor
and WAN SVC, see Chapter 2, “Starting ATM and ATM Router Redundancy.

Topic Page

Disabling and Reenabling a WAN SVC Service Record 8-2

Defining the Service Record MTU 8-3

Changing the Service Name 8-4

Changing the Routing Update Policy 8-5

Deleting a Service Record 8-7

Modifying ATM Traffic Parameters 8-7

Assigning a Data Encapsulation Type 8-14

Deleting a WAN SVC Service Record 8-14

Where to Go Next 8-15
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Disabling and Reenabling a WAN SVC Service Record

By default, you enable a service record when you add it to the interface. How
you can disable and reenable a specific service record at any time. Disable t
service record to stop traffic flow over it and any of its VCs. Otherwise, enable
service record.

To disable or reenable a WAN SVC service record, complete the following ta

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the Enable/Disable parameter. Click 
on Help  or see the parameter description 
on page A-14.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Defining the Service Record MTU

The MTU is the largest possible unit of data that the WAN SVC service record
transmit. By default, the service record allows an MTU size of 4608 octets. T
value can handle most packet sizes. 

The MTU size is typically determined by the driver. However, you can overrid
the driver default to accommodate connection to devices that require differen
MTU sizes. You can set the MTU to any value from 1 to 9188 octets.

To change the MTU size for a service record, complete the following tasks:

Note: Some ATM devices do not negotiate MTU size. When connecting to 
such a device, Nortel Networks recommends that you specify an MTU size o
9188 octets for full compatibility with RFC 1577.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the MTU parameter. Click on Help  or 
see the parameter description on 
page A-19.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Changing the Service Name

The service name is a value that uniquely defines each service record you cr
The router arbitrarily assigns a unique value to each service record you crea
You can accept the assigned value, or change that value to any alphanumeri
string. However, each service record must have a unique service name.

To change the service name, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the Service Name parameter. Click on 
Help  or see the parameter description on 
page A-20.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Changing the Routing Update Policy

With WAN SVCs, you can configure one or more adjacent hosts for each circ
The number of adjacent hosts that you configure determines the routing upd
policy you should use.

If you configure one adjacent host, you should choose the dial-optimized rou
policy. When you choose dial-optimized routing, Site manager automatically 
the RIP broadcast timers to 1 hour. You may want to change the RIP broadca
timer to a high value (for example, 8 hours) so that SVCs are not established
often. In this configuration, the router sends routing updates whenever a data
packet or a call from the other end causes ATM to establish an SVC to the 
adjacent host. Setting the RIP broadcast timer to a high value ensures that A
establishes an SVC primarily because the router needs to transmit data. 

If you configure more than one adjacent host, you should choose the normal
routing policy. When you choose the normal routing policy, Site Manager 
automatically sets the RIP broadcast timers to 30 seconds. You can accept t
value or change it to a higher value so that SVCs are not established as ofte
this type of configuration, when the broadcast timer expires, ATM establishes
nonexisting SVCs so that the router can send routing updates simultaneousl
each adjacent host.

For information on how to configure RIP timers for an IP interface, see 
Configuring IP, ARP, RARP, RIP, and OSPF Services. For information on how to 
configure RIP timers for an IPX interface, see Configuring IPX Services.
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To configure the routing policy, complete the following tasks: 

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the WAN SVC Routing Mode 
parameter. Click on Help  or see the 
parameter description on page A-20.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Deleting a Service Record

To delete a WAN SVC service record, complete the following tasks:

Modifying ATM Traffic Parameters

You can modify the following traffic parameters for WAN SVCs:

• Transmit and receive peak cell rate (PCR)

• Transmit and receive sustainable cell rate (SCR)

For additional information about traffic parameters, see “ATM Traffic Paramete
on page 1-23.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to delete.

5. Click on Delete . Site Manager deletes the service record.

6. Click on Done . You return to the Edit ATM Connector 
window.

7. Click on Done . You return to the Select Connection Type 
window.

8. Click on Done . You return to the Configuration Manager 
window.
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Enabling Traffic Parameters

To perform traffic shaping over the SVCs to any particluar adjacent host, comp
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Configure the following traffic shaping 
parameters:
• Enable/Disable
• Adjacent Host ATM Address
• Xmit Peak Cell Rate (cells/s)
• Xmit Sustainable Cell Rate (cells/s)
• Recv Peak Cell Rate (cells/s)
• Recv Sustainable Cell Rate (cells/s)
Click on Help or see the parameter 
descriptions beginning on page A-27.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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Specifying the Adjacent Host ATM Address

To perform traffic shaping for an adjacent host, you must enter the adjacent h
ATM address. The adjacent host ATM address is a 20-bit hexadecimal 
representation of the IP adjacent host address or IPX adjacent host address.

To set the adjacent host ATM address, complete the following tasks:

Note: To complete the WAN SVC configuration you must also configure IP or 
IPX adjacent host entries for all routers to be connected to this router with 
WAN SVCs. For information about how to configure an IP adjacent host, see
Configuring IP, ARP, RARP, RIP, and OSPF Services. For information about 
how to configure an IPX adjacent host, see Configuring IPX Services.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Click on Add. The WAN SVC Parameters window 
opens.

7. Set the Adjacent Host ATM Address 
parameter. Click on Help  or see the 
parameter description on page A-20.

8. Click on Done . You return to the Edit ATM Connector 
window.

9. Click on Done . You return to the Select Connection Type 
window.

10. Click on Done . You return to the Configuration Manager 
window.
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Setting the PCR

The peak cell rate (PCR) specifies the upper traffic limit, in cells/s, that the AT
connection can support.

By default, the PCR is 4716 cells/s for both the transmitting and receiving 
direction. Table 8-1 lists the valid ranges for each Nortel Networks ATM router.

For additional information about the PCR, see “Using the PCR” on page 1-24

Table 8-1. Valid PCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 128 to 353,207

Model 5782 VNR 128 to 353,207

ATM ARE DS-3 ILI pairs 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 128 to 72,000
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To change the WAN SVC PCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Click on the WAN SVC that you want to 
modify.

7. Set the Xmit Peak Cell Rate (cells/s) and 
Recv Peak Cell Rate (cells/s) parameters. 
Click on Help  or see the parameter 
description beginning on page A-23.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.
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Setting the SCR

The sustainable cell rate (SCR) is the upper bound on the conforming averag
of an individual WAN SVC or control VC. The average rate is the number of cells 
transmitted over the link divided by the duration of the connection. The duration 
of the connection is the total amount of time it takes from connection setup to 
connection release.

By default, the SCR is 4716 cells/s for both the transmitting and receiving 
direction. Table 8-2 lists the valid ranges for each Nortel Networks ATM router.
To disable the SCR, set the value to 0.

For additional information about the SCR, see “Using the SCR” on page 1-25

Table 8-2. Valid SCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 0, 128 to 353,207

Model 5782 0, 128 to 353,207

ATM ARE DS-3 ILI pairs 0, 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 0, 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 0, 128 to 72,000
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To change the WAN SVC SCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Click on the WAN SVC that you want to 
modify.

7. Set the Xmit Sustainable Cell Rate 
(cells/s) and Recv Sustainable Cell Rate 
(cells/s) parameter. Click on Help  or see 
the parameter descriptions beginning on 
page A-24.

8. Click on Done . You return to the ATM Service Records 
List window.

9. Click on Done . You return to the Edit ATM Connector 
window.

10. Click on Done . You return to the Select Connection Type 
window.

11. Click on Done . You return to the Configuration Manager 
window.
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Assigning a Data Encapsulation Type

You must use LLC/SNAP (the default value) data encapsulation to operate o
WAN SVC. You assign the LLC/SNAP data encapsulation type at service rec
level. See “Adding a Service Record for WAN SVCs” on page 2-11.

For additional information about assigning data encapsulation types, see “Da
Encapsulation Methods” on page 1-13.

Deleting a WAN SVC Service Record

To delete a WAN SVC service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes . The ATM Service Records List window 
opens.

4. Highlight the WAN SVC service record 
that you want to delete.

5. Click on Delete . Site Manager deletes the WAN SVC 
service record.

6. Click on Done . You return to the ATM Service Records 
List window.

7. Click on Done . You return to the Edit ATM Connector 
window.

8. Click on Done . You return to the Select Connection Type 
window.

9. Click on Done . You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next.

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for the ATM router 
redundancy parameter.

Chapter 9

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 9
Customizing ATM Router Redundancy

Nortel Networks routers support warm standby router redundancy. This type 
redundancy protects a network from the irrecoverable failure of an entire rou
For general information about router redundancy, see “ATM Router Redunda
Concepts” on page 1-39.

This chapter describes how to customize an ATM router redundancy 
configuration.
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Setting the ATM Router Redundancy Monitoring Timer

Nortel Networks ATM router redundancy uses only one ATM-specific Site 
Manager parameter: ATM Monitoring Timer.

The ATM monitoring timer specifies the amount of time in milliseconds (ms) t
the secondary router waits before beginning the process of becoming the pri
router. By default, if the primary router experiences a loss of signal, it waits 
3000 ms for the signal to return. If the signal does not return within that time,
secondary router begins the process of becoming the primary router.

You can set the ATM monitoring timer to any value from 1 to 65,535 ms.

To set the ATM monitoring timer, complete the following tasks:

Note: For instructions on how to start ATM router redundancy, see “Starting 
ATM Router Redundancy” on page 2-16. For instructions on how to customize
router redundancy parameters, see Configuring Interface and Router 
Redundancy.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Configure ATM Router 
Redundancy .

The Router Redundancy Circuit window 
opens.

4. Set the ATM Monitoring Timer 
parameter. Click on Help  or see the 
parameter description on page A-76.

5. Click on OK. You return to the Edit ATM Connector 
window.

6. Click on Done . You return to the Select Connection Type 
window.

7. Click on Done . You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface 
parameters.

Chapter 3

Change default settings for ATM signaling 
parameters.

Chapter 4

Change default settings for ATM PVC service record 
and PVC parameters.

Chapter 5

Change default settings for classical IP service 
record parameters.

Chapter 6

Change default settings for LAN Emulation client 
service record parameters.

Chapter 7

Change default settings for ATM WAN SVC service 
record and WAN SVC parameters.

Chapter 8

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Appendix A
Site Manager Parameters

After you enable an ATM circuit, you can use Site Manager to edit ATM 
parameters. Many ATM parameters are interdependent; how you edit some 
parameters depends on how you set others.

This appendix contains the Site Manager parameter descriptions for ATM 
services. You can display the same information using Site Manager online H

This appendix contains the following information:

Topic Page

Accessing ATM Parameters A-2

ATM Line Parameters A-5

ATM Interface Parameters A-11

ATM Service Record Parameters A-14

ATM Virtual Channel Link Parameters A-21

ATM WAN SVC Parameters A-27

LES Parameters A-42

ATM Signaling Parameters A-44

ATM ILMI Signaling Parameters A-64

Signaling and ILMI Control VC Parameters A-68

ATM Signaling AAL Parameters A-72

ATM Router Redundancy Parameter A-76

OAM Parameters A-77

ATMARP Parameters A-80

Adjacent Host Parameters A-82
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Accessing ATM Parameters

You can access ATM parameters using either:

• A window path 

• A menu path 

Both of these paths begin at the Configuration Manager window.

The window path provides detailed information about individual ATM interface
The menu path provides global information about all interfaces on the router.

Using the Window Path

ATM uses two main windows to access ATM parameters: the Select Connect
Type window and the Edit ATM Connector window.

Select Connection Type Window

To display the Select Connection Type window, click on an ATM link module 
interface (labeled ATM1) in the Configuration Manager window.

From the Select Connection Type window, you can do any of the following:

• Access ATM parameters.

• Access MPLS parameters.

• Access interface parameters.

• Access line parameters.

• Delete ATM or MPLS from the interface.

Note: For information about how to configure MPLS parameters, see 
Configuring MPLS Services.
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Edit ATM Connector Window

The Edit ATM Connector window acts as a control access point for all ATM 
parameters. This window provides information specific to each individual ATM
interface.

For any given interface, the Edit ATM Connector window provides the followin
attribute buttons:

• Service Attributes

• MPOA Server Attributes

• ATM Signaling

• Signaling AAL (SAAL)

• Interim Local Management Interface (ILMI)

• Configure ATM Router Redundancy

By clicking on any of these buttons, you can access and edit the parameters 
associated with that specific ATM interface (connector). 

To access parameters from the Edit ATM Connector window:

1. In the Configuration Manager window, click on an ATM link module 
interface (labeled ATM1).

The Select Connection Type window opens.

2. Click on ATM.

The Edit ATM Connector window opens.

3. Click on the appropriate attribute category.

Note: For information about how to configure MPOA parameters, see 
Configuring MPOA Services.
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Using the Menu Path

The Protocols menu in the Configuration Manager window provides global 
interface and signaling information about every ATM interface on the router. F
example, if you configure four ATM link modules on the router, and you selec
Protocols > ATM > Interfaces, the ATM Interface List window displays all four
ATM interfaces that you configured on the router.

Accessing Global ATM Signaling Attributes

To access global ATM signaling attributes:

1. In the Configuration Manager window, click on Protocols.

2. Click on ATM.

3. Click on ATM Signaling.

The ATM Signaling Records List window opens.

Accessing Global ATM Interface Attributes

To access global ATM interface attributes:

1. In the Configuration Manager window, click on Protocols.

2. Click on ATM.

3. Click on Interfaces.

The ATM Interface List window opens.

Note: Because MPLS uses ATM to operate, the ATM Interface List window 
also displays MPLS interfaces. However, you cannot edit MPLS interface 
parameters from this window. For information about how to edit MPLS 
interface parameters, see Configuring MPLS Services.
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ATM Line Parameters

The type of ATM link module you use determines the line details you can edi
This section describes how to edit the line details for ATM ARE link modules a
the Model 5782 ATM router.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: Enable
Options: Enable | Disable

Function: Enables or disables the line driver.
Instructions: Select Enable or Disable.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.2

Parameter: Interface MTU

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: 4608
Options: 1 to 9188

Function: Specifies the largest packet size (in octets) that the router can transmit on 
interface.

Instructions: Enter a value that is appropriate for the network.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.9
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Parameter: Data Path Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether or not the router disables the interface between the drive
the higher-level software (the data path interface) when you disconnect the
cable from the ATM module.

If you select Enable, then when you disconnect the cable from the ATM mod
the router disables the data path interface after the time you specify with th
Data Path Notify Timeout parameter.

If you select Disable, the router does not disable the data path interface wh
you disconnect the cable from the ATM module.

Instructions: Select Enable or Disable. If you select Enable, be sure to enter an approp
value for the Data Path Notify Timeout parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.11

Parameter: Data Path Notify Timeout

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: 1 second
Options: 0 to 3600 seconds

Function: Specifies the time that the router waits before disabling the data path inter
when you disconnect the cable from the ATM module, providing that you set
Data Path Enable parameter to Enable.

Instructions: Accept the default or enter an appropriate value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.12
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Parameter: SVC Inactivity Timeout Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: Enable
Options: Enable | Disable

Function: If you select Enable, the router disables any switched virtual circuits (SVCs
which the router receives or transmits no cells for the number of seconds y
specify using the SVC Inactivity Timeout (Secs) parameter.

If you select Disable, the router keeps SVCs open unless you close them b
another method.

Instructions: Select Enable or Disable.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.13

Parameter: SVC Inactivity Timeout (Secs)

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: 1200 seconds
Options: 60 to 3600 seconds

Function: If the router receives or transmits no cells on an SVC for this number of 
seconds, it closes the SVC, providing that you set the SVC Inactivity Timeo
Enable parameter to Enable.

Instructions: Enter an appropriate time, and be sure to set the SVC Inactivity Timeout E
parameter to Enable.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.14
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Parameter: Framing Mode

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: SONET (for OC-3 lines) | DS3_CBIT (for DS-3 lines) | E3_G832 (for E-3 lines)
Options: SDH | SONET | DS3_CBIT | CBITNOFALLBACK | CLEARCHANNEL | 

E3_G751 | E3_G832
Function: Specifies the transceiver mode for the physical interface.

Instructions: Select a transceiver mode as follows:

• SDH or SONET for OC-3 modules
• DS3_CBIT, CBITNOFALLBACK, or CLEARCHANNEL for DS-3 modules
• E3_G751 or E3_G832 for E-3 modules

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.17

Parameter: Clocking Signal Source

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: Internal
Options: Loop | Internal

Function: Specifies whether the platform uses its internal clock or derives timing sign
externally from an incoming clock on this interface.

Instructions: Select Loop to use external timing signals from an incoming clock; select 
Internal to use the clock in the platform.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.18
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Parameter: DS3 Line Build Out

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: Short
Options: Short | Long

Function: Conditions router signals to mitigate attenuation, which depends on the phy
length of the line.

You can set this parameter only for DS-3 modules.
Instructions: Select Short for lines shorter than 225 ft; select Long for lines 225 ft or lon

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.23

Parameter: DS3 Scrambling

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: On
Options: On | Off

Function: If you select On, the platform randomizes cell payload sufficiently to guara
cell synchronization. If you select Off, cell synchronization problems could 
occur.

Note that ATM devices with different settings for scrambling cannot 
communicate. For example, if you configure a router to enable scrambling 
configure a hub to disable scrambling, the router and the hub cannot 
communicate.

You can set this parameter only when using DS-3 modules.
Instructions: Select On or Off. If you select On, be sure to enable scrambling for all dev

on the network. If you select Off, be sure to disable scrambling for all device
the network.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.22
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Parameter: Per-VC Clipping

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > Line Attributes
Default: Disable
Options: Enable | Disable

Function: Enables or disables cell clipping on a per-VC basis. 
Instructions: Accept the default, Disable, for normal VC clipping. Enable this parameter

you want to clip cells on a per-VC basis.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.1.1.17
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ATM Interface Parameters

Interface parameters define the state of the ATM interface.

Parameter: Administrative State

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: Up
Options: Up | Down

Function: Specifies whether this interface is enabled or disabled.
Instructions: Accept the default, Up, if you want traffic to flow over this interface. Set the

state to Down if you do not want traffic to flow over this interface.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.3

Parameter: Enable ATM Signaling

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether ATM signaling is enabled or disabled for this interface.

Signaling allows you to configure switched features (for example, SVCs an
LANE) on the interface. 

If you do not intend to configure any switched features on this interface (tha
you want this interface to run only PVCs), disabling this parameter makes 
additional system resources available.

Instructions: Accept the default, Enable, if you want to enable signaling on this interface
the state to Disable if you want to disable signaling on this interface.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.16
308612-14.00 Rev 00 A-11
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Parameter: Use Hardware MAC Address

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether or not to use the hardware MAC address for this interfac

When enabled, the Configuration Manager uses the ATM hardware MAC 
address of the link module as the end-station identifier when automatically 
generating the user part (suffix) of an SVC service record ATM address.

When disabled, the Configuration Manager uses the value specified in the M
Address Override parameter to assign the end-station identifier when 
automatically generating the user part (suffix) of an SVC service record ATM
address.

Instructions: Accept the default, Enable, if you want to use the MAC address of the ATM
interface when automatically generating the end-station identifier portion of
ATM address user part.

Set this parameter to Disable if you want to use the MAC Address Override
value when automatically generating the end-station identifier portion of the
ATM address user part.

If you set this parameter to Disable, you must enter a value for the MAC 
Address Override parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.18
A-12 308612-14.00 Rev 00
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Parameter: MAC Address Override

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: None
Options: Any valid MAC address

Function: Specifies the hardware MAC address for this interface. Also defines the 
end-station identifier for this interface when automatically generating the us
part (suffix) of an SVC service record ATM address.

Using the MAC Address Override parameter is very helpful when you want
hot-swap ATM link modules. 

For example, when hot-swapping ATM link modules, you can enter the MA
address of the original ATM link module as the MAC Address Override valu
for the new ATM link module. This allows you to keep the information alrea
configured on the existing ATM link module while maintaining the integrity o
the existing client information on the network.

Instructions: Enter a valid MAC address.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.19
308612-14.00 Rev 00 A-13
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ATM Service Record Parameters

Service record parameters define the ATM service records for an interface. T
ATM Service Records List window also provides access to the following:

• PVC parameters (PVC service records only) in the ATM Virtual Channel L
window

• A list of all SVCs on that service record (SVC service records only) in the
ATM Switched Virtual Circuit List window

• LEC parameters (SVC service records using LANE data encapsulation) in
LAN Emulation Parameters window

Parameter: Enable/Disable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: Enable
Options: Enable | Disable

Function: Enables or disables this service record.
Instructions: Accept the default, Enable, if you want traffic to flow on this service record

its VCs. Set to Disable if you do not want traffic to flow on this service record
any of its VCs.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.2
A-14 308612-14.00 Rev 00
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Parameter: Data Encapsulation Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > Add

Default: LANE (signaling enabled) or LLC/SNAP (signaling disabled)
Options: LANE | LLC/SNAP | NLPID | NULL

Function: Identifies the data encapsulation type for this service record.

Select a data encapsulation type as follows:

• LLC/SNAP, NLPID, or NULL for service records containing PVCs
• LLC/SNAP for service records containing hybrid PVCs
• LANE for service records containing SVCs over which you want to run LA

emulation
• LLC/SNAP or NULL for WAN SVCs, or for service records containing SVC

over which you want to run classical IP (RFC 1577)

If you select NULL, the router interprets this as virtual, channel-based 
multiplexing, which is not supported for bridging.

Instructions: Select a data encapsulation type.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.5

Parameter: Virtual Connection Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > Add

Default: SVC (signaling enabled) or PVC (signaling disabled)
Options: PVC | SVC | MUXED_SVC

Function: Identifies the virtual connection type of this service record.
Instructions: Accept the default, SVC, if you want the service record to contain switched

virtual circuits. Select PVC if you want the service record to contain perman
virtual circuits. Select MUXED_SVC if you want the service record to conta
WAN switched virtual circuits.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.7
308612-14.00 Rev 00 A-15
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Parameter: User Part Autogeneration

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > Add

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: Enable
Options: Enable | Disable

Function: Enables or disables autogeneration of the ATM address user part. Depend
the settings in the ATM Interface Attributes window, the ATM address user p
is either the hardware MAC address or a MAC address override value.

Instructions: Accept the default, Enable, if you want the router to automatically generat
ATM address user part for the SVC service record.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.11

Parameter: ATM Addr User Part

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > Add

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: None
Options: 00000000000000 to FEFFFFFFFFFFFF

Function: The router allows you to autogenerate this parameter (see the User Part 
Autogeneration parameter on A-16). Depending on the settings in the ATM 
Interface Attributes window, this parameter autogenerates this address usin
either:

• The 6-byte hardware MAC address of the ATM interface
• A MAC address override value that you specify

In both cases, autogeneration creates a unique selector byte for each serv
record on the interface.

Instructions: Accept the default for autogeneration, or enter a value in the range specifi
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.9
A-16 308612-14.00 Rev 00
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Parameter: ATM Addr Net Prefix (Optional)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > Add

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: None
Options: XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF

where XX = 39, 45, or 47
Function: Specifies the network prefix of the ATM address for this service record. Th

network prefix specifies the ATM domain of which this service record is a pa

The XX byte must contain 39, 45, or 47. These values define the authority a
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format the prefix uses. For more information ab
the AFI byte, see the ATM Forum UNI specification.

Instructions: Setting this parameter is optional. If you do not enter an ATM address netw
prefix in the range specified above, the service record accepts the first pref
value that it receives from the switch.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.8
308612-14.00 Rev 00 A-17
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Parameter: Emulated LAN Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > Add

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > LEC

Default: Default ELAN
Options: Leave blank or enter up to 128 alphanumeric characters

Function: Specifies the name of the emulated LAN that this LE client joins when it jo
an emulated LAN. Clients that use automatic configuration mode use this 
parameter in their LE_CONFIGURE_REQUEST frames. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUES
frames.

Entering an ELAN name is optional. If you choose not to enter an ELAN na
the LAN emulation configuration server (LECS) assigns the LE client to an 
ELAN for this domain. However, because some switches do not support a 
default emulated LAN, Nortel Networks recommends that you assign an EL
name to the LE client.

Instructions: Either leave this parameter blank or enter an ELAN name (up to 128 
alphanumeric characters) that identifies the emulated LAN you want this cl
to join.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.8
A-18 308612-14.00 Rev 00
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Parameter: Emulated LAN Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > Add

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes  > LEC

Default: Unspecified
Options: Unspecified | IEEE8023 | IEEE8025

Function: Specifies the data frame format this client uses when it joins an emulated L
Clients that use automatic configuration mode use this parameter in their 
LE_CONFIGURE_REQUEST frames to specify the LAN type. Clients that u
manual configuration mode use this parameter in their LE_JOIN_REQUES
frames to specify the LAN type.

If you select manual configuration mode, you must set the emulated LAN ty
to either IEEE8023 or IEEE8025.

Instructions: Accept the default, Unspecified, if you want the client to obtain the LAN typ
from the LECS when it joins an emulated LAN. Select IEEE8023 if you wan
the client to join only Ethernet emulated LANs. Select IEEE8025 if you wan
the client to join only token ring emulated LANs.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.6

Parameter: MTU

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: 4608
Options: 0 to 9188

Function: Specifies the MTU, in bytes, that this service record can send. The MTU s
typically determined by the driver. However, this parameter allows you to 
override the driver default to accommodate connection to devices that requ
different MTU sizes.

Instructions: Accept the default or enter an MTU size for this service record.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.12
308612-14.00 Rev 00 A-19
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Note: Some ATM devices do not negotiate MTU size. When connecting to 
such a device, Nortel Networks recommends that you specify an MTU size o
9188 octets for full compatibility with RFC 1577.

Parameter: Service Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: Numeric value assigned by the router.
Options: Any alphanumeric string.

Function: Assigns a unique name to the service record.
Instructions: Accept the service name provided by the router or change the service nam

rename the service record.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.15

Parameter: WAN SVC Routing Mode

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes 

Default: Disabled
Options: Disabled | Normal | Dial-Optimized

Function: Assigns a routing mode to the WAN SVC.
Instructions: Accept the default, Disabled, to stop the router from sending RIP updates o

WAN SVC. Select Normal if you plan to have more than one adjacent host 
circuit or subnet. Select Dial-Optimized routing if you plan to have only one
adjacent host per circuit or subnet. 

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.16
A-20 308612-14.00 Rev 00
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ATM Virtual Channel Link Parameters

ATM virtual channel link parameters define PVCs in a PVC service record.

Note: ATM does not allow duplicate VPI/VCI pairs on the same physical 
interface. However, duplicate VPI/VCI pairs can exist on different physical 
interfaces.

Parameter: VPI Number

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC > Add

Default: None
Options: 0 to 255

Function: Identifies the virtual path of the PVC. The VPI is part of the cell header. Th
header can contain a maximum of 8 VPI bits for a UNI connection. This bit 
range allows for path identifiers from 0 to 255.

Instructions: Enter a value from 0 to 255.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.3

Parameter: VCI Number

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC > Add

Default: None
Options: 32 to 65535

Function: Identifies the virtual channel of the PVC. The VCI is part of the cell header.
header can contain a maximum of 16 VCI bits. This bit range allows for pat
identifiers from 0 to 65535.

Instructions: Enter a value from 32 to 65535.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.4

Note: Following the recommendation of the ATM Forum, virtual channel 
identifiers from 0 to 31 are reserved for signaling and added functionality.
308612-14.00 Rev 00 A-21
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Parameter: Hybrid/Bridged VC

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: No
Options: Yes | No

Function: Specifies whether the PVC is set to hybrid access mode.
Instructions: Accept the default, No, if you want the PVC to work in group access mode 

Set to Yes if you want the PVC to operate as a hybrid VC.

For more information about the group and hybrid access modes, see “PVC
Access Methods” on page 1-17 .

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.25

Parameter: Administrative State

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Up
Options: Up | Down 

Function: Specifies the administrative state of the PVC. The Up state indicates that t
flow is enabled on this PVC. The Down state indicates that traffic flow is 
disabled on this PVC.

Instructions: Accept the default, Up, if you want traffic to flow on this PVC. Set the state
Down if you do not want traffic to flow on this PVC.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.5
A-22 308612-14.00 Rev 00
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Parameter: Xmit Peak Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 2358
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can sub
How you set the peak cell rate depends on:

• The optical transmission rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the transmission rate of your ATM device, set the peak
rate within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.8
308612-14.00 Rev 00 A-23
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Parameter: Xmit Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 2358
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and 

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper limit of the ATM connection conforming average rate. T
average rate equals the total number of cells transmitted, divided by the dur
of the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of
VC in greater detail than by using only the peak cell rate.

For ATM ARE ILI pairs and Model 5782 ATM routers, the SCR maps direct
to the minimum cell rate (MCR). The MCR defines the minimum amount of
guaranteed bandwidth allowed for PVCs and control VCs on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR provides guaranteed bandwidth for PVCs and control VCs whil

allowing sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent high

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the transmission rate of your ATM device, set the 
sustainable cell rate within the specified range. Enter 0 to turn off this funct

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.9
A-24 308612-14.00 Rev 00
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Parameter: Xmit Burst Size (cells)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 40
Options: 1 to 65535

Function: Specifies the maximum number of sequential cells allowed on a VC, at the
cell rate, before the VC must relinquish bandwidth to other VCs.

When you set the MBS, you should select a value larger than the largest pa
your PVC or control VC can transmit (that is, the Maximum AAL CPCS 
Transmit SDU size). For example, if your VC accepts packets that are less
2358 bytes long (PVC default), set your MBS value from 45 to 50 cells.

Instructions: Set a value in the specified range.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.10

Parameter: Maximum AAL CPCS Transmit SDU Size

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC suppor
the transmit direction.

Instructions: Enter an octet value that represents the maximum packet size that you int
this VC to transmit. Nortel Networks recommends that you accept the defa
value of 4608 bytes. Most packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.17
308612-14.00 Rev 00 A-25
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Parameter: Maximum AAL CPCS Receive SDU Size

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC suppor
the receive direction.

Instructions: Enter an octet value that represents the maximum packet size that you int
this VC to receive. Nortel Networks recommends that you accept the defau
value of 4608 bytes. Most packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.18

Parameter: Data Encapsulation Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: LLC/SNAP
Options: LLC/SNAP | NLPID | NULL

Function: Specifies the type of data encapsulation that you want this PVC to use. Se
LLC/SNAP, NLPID, or NULL data encapsulation for:

• All PVCs on a service record
• Hybrid PVCs

Instructions: Nortel Networks recommends selecting LLC/SNAP. If you select NULL, th
router interprets this as virtual, channel-based multiplexing, which is not 
supported for bridging.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.19
A-26 308612-14.00 Rev 00
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ATM WAN SVC Parameters

ATM WAN SVC parameters define the traffic shaping options for a particular 
WAN SVC.

Parameter: Enable/Disable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: Enable
Options: Enable | Disable

Function: Enables or disables traffic shaping on this WAN SVC.
Instructions: Accept the default, Enable, if you want the router to use traffic shaping on

WAN SVC. Set to Disable if you do not want the router to use traffic shaping
this WAN SVC. 

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.2

Parameter: Adjacent Host ATM Address

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: None
Options: Any valid ATM address

Function: Identifies the ATM address of the IP or IPX adjacent host.
Instructions: Specify the ATM address of the IP or IPX adjacent host.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.2
308612-14.00 Rev 00 A-27
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Parameter: Xmit Peak Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4716
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can sub
How you set the peak cell rate depends on:

• The optical transmission rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the transmission rate of your ATM device, set the peak
rate within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.8
A-28 308612-14.00 Rev 00
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Parameter: Xmit Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4716
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and 

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper limit of the ATM connection conforming average rate. T
average rate equals the total number of cells transmitted, divided by the dur
of the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of
VC in greater detail than by using only the peak cell rate.

For ATM ARE ILI pairs and Model 5782 ATM routers, the SCR maps direct
to the minimum cell rate (MCR). The MCR defines the minimum amount of
guaranteed bandwidth allowed SVCs on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR allows sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent high

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the transmission rate of your ATM device, set the 
sustainable cell rate within the specified range. Enter 0 to turn off this funct

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.9
308612-14.00 Rev 00 A-29
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Parameter: Recv Peak Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4176
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can sub
How you set the peak cell rate depends on:

• The optical receive rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the receive rate of your ATM device, set the peak cell 
within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.8
A-30 308612-14.00 Rev 00
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Parameter: Recv Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4176
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and 

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper limit of the ATM connection conforming average rate. T
average rate equals the total number of cells received, divided by the durati
the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of
VC in greater detail than by using only the peak cell rate.

For ATM ARE ILI pairs and Model 5782 ATM routers, the SCR maps direct
to the minimum cell rate (MCR). The MCR defines the minimum amount of
guaranteed bandwidth allowed for SVCs on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR allows sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent high

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the receive rate of your ATM device, set the sustainabl
rate within the specified range. Enter 0 to turn off this function.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.9
308612-14.00 Rev 00 A-31
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LAN Emulation Parameters

LAN emulation parameters define LAN emulation clients in a LANE service 
record.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Enable
Options: Enable | Disable

Function: Enables or disables LAN emulation on this service record.
Instructions: Accept the default, Enable, if you want LAN emulation to remain enabled o

this service record. Select Disable if you do not want LAN emulation enable
this service record.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.2

Parameter: Owner

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: None
Options: Leave blank or enter up to 128 alphanumeric characters

Function: Identifies this LAN emulation client. This parameter is optional.
Instructions: Either leave this parameter blank or enter a text string (up to 128 alphanum

characters) to identify this LAN emulation client.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.4
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Parameter: Configuration Mode

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Automatic
Options: Automatic | Manual

Function: Indicates whether this LAN emulation client configures automatically (that 
uses information from the LECS) or manually (that is, uses information from
LAN Emulation Parameters window).

Instructions: Accept the default, Automatic, if you want this client to configure automatic
Select Manual if you do not want the router to autoconfigure.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.5

Parameter: Emulated LAN Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Unspecified
Options: Unspecified | IEEE8023 | IEEE8025

Function: Specifies the data frame format this client uses when it joins an emulated L
Clients that use automatic configuration mode use this parameter in their 
LE_CONFIGURE_REQUEST frames to specify the LAN type. Clients that u
manual configuration mode use this parameter in their LE_JOIN_REQUES
frames to specify the LAN type.

If you select manual configuration mode, you must set the emulated LAN ty
to either IEEE8023 or IEEE8025.

Instructions: Accept the default, Unspecified, if you want the client to obtain the LAN typ
from the LAN emulation configuration server (LECS) when it joins an emula
LAN. Select IEEE8023 if you want the client to join only Ethernet emulated
LANs. Select IEEE8025 if you want the client to join only token ring emulat
LANs.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.6
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Parameter: Maximum Data Frame Size

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Unspecified
Options: Unspecified | 1516

Function: Specifies the maximum data frame size (in octets) that this client uses whe
joins an emulated LAN. Clients that use automatic configuration mode use 
parameter in their LE_CONFIGURE_REQUEST frames. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUES
frames.

Accept the default, Unspecified, if you want the client to obtain the maximu
data frame size when it joins an emulated LAN. Select 1516 if you want to 
designate the maximum data frame size that this client can:

• Send on the multicast send VCC.
• Receive on the multicast forward VCC.
• Send and receive on data direct VCCs.

Selecting manual configuration mode automatically sets the maximum data
frame size to 1516.

Instructions: Accept the default, Unspecified, or select 1516.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.7
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Parameter: Emulated LAN Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Default ELAN
Options: Leave blank or enter up to 128 alphanumeric characters

Function: Specifies the name of the emulated LAN that this LE client joins when it jo
an emulated LAN. Clients that use automatic configuration mode use this 
parameter in their LE_CONFIGURE_REQUEST frames. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUES
frames.

Entering an ELAN name is optional. If you choose not to enter an ELAN na
the LAN emulation configuration server (LECS) assigns the LE client to an 
ELAN for this domain. However, because some switches do not support a 
default emulated LAN, Nortel Networks recommends that you assign an EL
name to the LE client.

Instructions: Either leave this parameter blank or enter an ELAN name (up to 128 
alphanumeric characters) that identifies the emulated LAN you want this cl
to join.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.8

Parameter: Control Timeout

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 5
Options: 5 to 32767

Function: Specifies the timeout period used for timing out most request/response co
frame interactions.

Instructions: Accept the default, 5, or enter a value from 5 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.10
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Parameter: Max Unknown Frame Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 1
Options: 1 to 10

Function: Specifies the maximum number of unknown frames an LE client can send
within the interval specified with the Max Unknown Frame Time parameter.
frame is considered unknown when the LE client does not recognize the 
destination MAC address. In this case, the unknown frame goes to the BUS
distribution.

Instructions: Accept the default, 1, or enter a value from 1 to 10.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.11

Parameter: Max Unknown Frame Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 1
Options: 1 to 60

Function: Specifies the maximum amount of time (in seconds) allowed to send the nu
of unknown frames specified with the Max Unknown Frame Count paramet

For example, if you use the defaults for these parameters, a LAN emulation
client can one unknown frame within 1 second for any given MAC address 
without having to initiate the Address Resolution Protocol (ARP) to resolve t
MAC address.

Instructions: Accept the default, 1, or enter a value from 1 to 60.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.12
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Parameter: VCC Timeout Period Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Enable
Options: Enable | Disable

Function: Disables or reenables the virtual channel connection (VCC) timeout period
When you enable this parameter, a LAN emulation client can release any un
data direct or multicast send VCCs after the VCC timeout period expires. T
ATM drivers support a timeout period of 20 minutes.

Instructions: Accept the default, Enable, if you want this LAN emulation client to release
unused data direct or multicast send VCCs after the VCC timeout period 
expires. Select Disable if you do not want this LAN emulation client to relea
unused data direct or multicast send VCCs after the timeout period expires

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.13

Parameter: Max Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 1
Options: 1 or 2

Function: Specifies the maximum number of times a LAN emulation client can retry a
LE_ARP_REQUEST (following the original request) for a given frame MAC
address.

Instructions: Accept the default, 1, or enter 2 as the new value.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.14
308612-14.00 Rev 00 A-37
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Parameter: Aging Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 300
Options: 10 to 300

Function: Specifies the maximum amount of time (in seconds) that a LAN emulation
client can maintain an entry in its LAN emulation ARP cache without verifyi
the relationship of that entry.

Instructions: Accept the default, 300, or enter a value from 10 to 300.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.15

Parameter: Forward Delay Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 15
Options: 4 to 30

Function: When there are no changes occurring in the network topology, this parame
specifies the maximum amount of time (in seconds) that a LAN emulation cl
can maintain an entry in its LAN emulation ARP cache without verifying the
relationship of that entry.

Instructions: Accept the default, 15, or enter a value from 4 to 30.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.16

Parameter: Expected LE_ARP Response Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 3
Options: 1 to 30

Function: Specifies the amount of time (in seconds) that the LAN emulation client exp
an ARP request and ARP response cycle to take. The LAN emulation client
this value during retries and verifications.

Instructions: Accept the default, 3, or enter a value from 1 to 30.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.1
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Parameter: Flush Timeout

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 4
Options: 1 to 4

Function: Specifies the amount of time (in seconds) that the LAN emulation client wa
receive a flush response (after sending a flush request) before it takes reco
action by switching to the BUS.

Instructions: Accept the default, 4, or enter a value from 1 to 4.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.18

Parameter: Path Switching Delay

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 6
Options: 1 to 8

Function: Specifies the amount of time (in seconds) that the LAN emulation client wa
after sending a frame over an existing VCC before it switches to a new VC
(this applies to multicast and data direct VCCs). You can use this paramete
bypass the flush protocol (that is, when you disable the Flush Protocol 
parameter, the data for a specific MAC address automatically begins flowin
over a new VCC when the path switching delay time elapses).

Instructions: Accept the default, 6, or enter a value from 1 to 8.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.19
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Parameter: Emulated LAN Segment ID

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 0
Options: 0 to 4095

Function: Specifies the ring ID (in decimal) on which this token ring client resides. Yo
need only set this parameter for IEEE 802.5 LANE clients that are:

• Token ring end stations
• Routing IP or IPX across an SRB token ring network

Instructions: Accept the default, 0, or enter a value from 0 to 4095.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.20

Parameter: Flush Protocol

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Enable
Options: Enable | Disable

Function: Enables or disables the flush protocol on this LE client.

The flush protocol ensures that data destined for a particular MAC address
arrives in sequence. Following a flush request, the flush protocol drops cell
this MAC address while waiting for:

• The flush response from that MAC address
• The flush timeout to expire for that MAC address

If the client receives a flush response for the MAC address, the cells for thi
MAC address begin flowing over a new virtual circuit. However, if the flush 
timeout expires for this MAC address, the cells begin flowing to the BUS.

When disabled, cells containing the same MAC address are dropped while
waiting for the Path Switching Delay parameter to time out. After the path 
switching delay time elapses, the data automatically begins flowing over a 
virtual circuit.

Instructions: Accept the default, Enable, if you want the flush protocol to operate on this
LAN emulation client. Select Disable if you do not want the flush protocol to
operate on this LAN emulation client.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.25
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Parameter: LE Config Server ATM Address

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: None
Options: Any valid LAN emulation configuration server (LECS) ATM address

Function: Specifies the LECS ATM address. Entering an address for this parameter i
optional. If you do not enter an address, the LE client uses the well-known 
LECS ATM address to open a configuration VCC to the configuration servic

Instructions: Leave blank or enter the ATM address of the LECS.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.30

Parameter: LAN Emulation Version 2

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Disable
Options: Enable | Disable

Function: Enables and disables LAN emulation Version 2.
Instructions: Accept the default, Disable, if this LAN emulation client operates in a stan

LAN emulation network. Select Enable if you want this LAN emulation clien
to operate in an MPOA network.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.30
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LES Parameters

LAN emulation server (LES) parameters define LAN emulation servers for LA
clients.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: Enable
Options: Enable | Disable

Function: Enables or disables the chosen LAN emulation server (LES) on this servic
record.

Instructions: Accept the default, Enable, if you want the LAN emulation client to use thi
LES address in the specified order of preference. Select Disable if you do n
want the LAN emulation client to consider this LES address.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.2

Parameter: LE Server ATM Address Network Prefix 

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: 39000000000000000000000000
Options: XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF

where XX = 39, 45, or 47
Function: Specifies the network prefix of the ATM address for this LAN emulation se

(LES). The network prefix specifies the ATM domain of which this LES is a 
part.

The XX byte must be 39, 45, or 47. This value defines the authority and form
identifier (AFI). The AFI byte identifies the group responsible for allocating t
prefix and the format the prefix uses. For more information about the AFI b
see the ATM Forum UNI specification.

Instructions: Accept the default network prefix, or if the LES resides in a different ATM 
domain, enter the network prefix for that domain.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.5
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Parameter: LE Server ATM Address User Part

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: None
Options: 00000000000000 to FFFFFFFFFFFFFF

Function: Specifies the user part (suffix) of the ATM address for a LAN emulation ser
(LES) on your network. The user part suffix consists of a 6-byte end-station
identifier and a 1-byte selector field.

The user part and the network prefix form a complete ATM address.
Instructions: Enter the ATM address user part of the LES.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.5

Parameter: LE Server Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: Numeric value assigned by the router.
Options: Any alphanumeric string.

Function: Assigns a unique name to the LAN emulation server (LES).
Instructions: Accept the LES name provide by the router or change the name to renam

server.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.6
308612-14.00 Rev 00 A-43
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ATM Signaling Parameters

ATM signaling parameters define the connection and timer limits the router u
to set up, maintain, and clear a switched connection.

The ATM Signaling Parameters window also provides access to the signaling
parameters. The signaling VC provides a dedicated VPI (0) and VCI (5) for A
signaling functions.

For control VC parameter descriptions, see “Signaling and ILMI Control VC 
Parameters” on A-68.

Parameter: Enable

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: Enable
Options: Enable | Disable

Function: Enables or disables ATM signaling on this interface.

When you disable signaling on the interface, the ATM Service Record 
Parameters window automatically sets the Data Encapsulation Type param
to LLC/SNAP and the Virtual Connection Type parameter to PVC.

Instructions: Accept the default, Enable, if you want signaling to remain enabled on this
interface. Set to Disable if you do not want signaling enabled on this interfa

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.2
A-44 308612-14.00 Rev 00
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Parameter: Protocol Standard

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: UNI_V30
Options: UNI_V30 | UNI_V31 | UNI_V40

Function: Specifies how the interface defines Service Specific Connection Oriented 
Protocol (SSCOP) frames. Version 3.0, Version 3.1, and Version 4.0 SSCO
frames are incompatible.

Instructions: You must assign the same protocol standard for both the router interface a
switch. Accept the default, UNI_V30, if the switch uses UNI Version 3.0 to 
define SSCOP frames. Select UNI_V31 if the switch uses UNI Version 3.1 
define SSCOP frames. Select UNI_V40 if the switch uses UNI Version 4.0 
define SSCOP frames.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.15

Parameter: Max Number of SVC Applications

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 20
Options: 1 to 32767

Function: Specifies the maximum number of SVC applications allowed for this circui
The number of SVC applications corresponds to the number of LAN emula
or IP (RFC 1577) clients allowed for the circuit.

Instructions: Accept the default, 20, or enter a value from 1 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.6
308612-14.00 Rev 00 A-45
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Parameter: Max Point to Point Connections

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 1000
Options: 0 to 32767

Function: Specifies the maximum number of simultaneous point-to-point connections
allowed for this circuit.

Instructions: Accept the default, 1000, or enter a value from 0 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.7

Parameter: Max Point to Multipoint Connections

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 40
Options: 0 to 32767

Function: Specifies the maximum number of simultaneous point-to-multipoint 
connections allowed for this circuit.

Instructions: Accept the default, 40, or enter a value from 0 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.8
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Parameter: Max Parties in Multipoint Connections

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 1
Options: 0 to 32767

Function: Specifies the maximum number of simultaneous parties in a point-to-multip
connection allowed for this circuit.

Instructions: Accept the default, 1, or enter a value from 0 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.9

Parameter: Min Memory Threshold

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 20%
Options: 10% | 20% | 30% | 40% | 50% | 60% | 70% | 80% | 90% | 100%

Function: Specifies the minimum percentage of buffer memory necessary to enable 
call.

Instructions: Accept the default, 20%, or select another percentage.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.11
308612-14.00 Rev 00 A-47
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Parameter: VPI

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 0
Options: 0 to 255

Function: Specifies the virtual path identifier (VPI) for the signaling VC. The signaling
VC is a dedicated VPI/VCI pair reserved for signaling messages.

Instructions: Accept the default value, 0, or enter a value from 0 to 255.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.13

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the AT
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.
A-48 308612-14.00 Rev 00
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Parameter: VCI

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 5
Options: 1 to 65535

Function: Specifies the virtual channel identifier (VCI) for the signaling VC. The 
signaling VC is a dedicated VPI/VCI pair reserved for signaling messages.

Instructions: Accept the default, 5, or enter a value from 1 to 65535.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.14

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the AT
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.
308612-14.00 Rev 00 A-49
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Parameter: T301

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 180
Options: 180 to 1024

Function: Specifies the Alert Received timer value (in seconds). This timer begins w
the circuit initiates a call/connection request by receiving an ALERT messa
over the signaling VC.

The Alert Received timer stops when the circuit receives a CONNECT mes
(indicating connection) from the network.

If the circuit does not receive a CONNECT message within the allotted time
clears the connection.

This timer can be used with UNI Version 4.0 and later.
Instructions: Accept the default, 180, or enter a value from 180 to 1024.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.41
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Parameter: T303

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Setup Sent timer value (in seconds). This timer begins when
circuit initiates a call/connection request by sending a SETUP message ove
signaling VC.

The Setup Sent timer stops when the circuit receives a CONNECT messag
(indicating connection), a CALL PROCEEDING message (indicating that th
network received the SETUP message), or a RELEASE COMPLETE mess
(indicating the rejection of the SETUP message) from the network.

If the circuit does not receive one of these messages within the allotted tim
transmits the SETUP message again. If the circuit still does not receive a 
response, it clears the connection.

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.25
308612-14.00 Rev 00 A-51
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Parameter: T304

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 30
Options: 30 to 120

Function: Specifies the Setup Acknowledgement timer value (in seconds). This time
begins when the circuit initiates a call/connection request by sending a SET
ACK message over the signaling VC.

The Setup Acknowledgement timer stops when the circuit receives a 
CONNECT message (indicating connection), a CALL PROCEEDING mess
(indicating that the network received the SETUP message), or an ALERT fr
the network.

If the circuit does not receive one of these messages within the allotted tim
clears the connection.

This timer can be used with UNI Version 4.0 and later.
Instructions: Accept the default, 30, or enter a value from 30 to 120.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.42
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Parameter: T308

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 30
Options: 1 to 180

Function: Specifies the Release Sent timer value (in seconds). This timer begins wh
circuit sends a RELEASE message to initiate clearing of an SVC. Sending 
RELEASE message places the network in the release request state.

The Release Sent timer stops when the circuit receives either a RELEASE
message (that is, both the circuit and the network sent RELEASE message
the same time) or a RELEASE COMPLETE message from the network.

If the timer expires before the circuit receives one of these messages, the c
transmits the RELEASE message again. If the circuit still does not receive 
response, the circuit releases the call reference and begins a restart proce

Instructions: Accept the default, 30, or enter a value from 1 to 180.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.26
308612-14.00 Rev 00 A-53



Configuring ATM Services

r 

AL 
s 

 the 

r 
 

his 
Parameter: T309

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 10
Options: 1 to 540

Function: Specifies the SAAL Data Link Connect timer value (in seconds). This time
begins when a signaling AAL malfunction occurs.

The SAAL Data Link Connect timer stops when the circuit reestablishes SA
(that is, when the circuit sends an AAL-ESTABLISH-REQUEST and receive
an AAL-ESTABLISH-CONFIRM message).

If the timer expires before the circuit can reestablish SAAL, the circuit clears
connection.

Instructions: Accept the default, 10, or enter a value from 1 to 540.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.27

Parameter: T310

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 10
Options: 1 to 60

Function: Specifies the Call Proceeding Received timer value (in seconds). This time
begins when the circuit receives a CALL PROCEEDING message from the
network.

If the router does not receive a CONNECT or RELEASE message before t
timer expires, it clears the connection for that virtual circuit.

Instructions: Accept the default, 10, or enter a value from 1 to 60.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.28
A-54 308612-14.00 Rev 00
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Parameter: T313

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Connect Sent timer value (in seconds). This timer begins whe
circuit sends a CONNECT message to the network.

The Connect Sent timer stops when the circuit receives a CONNECT 
ACKNOWLEDGE message from the network (indicating the completion of t
ATM connection for that interface).

If the timer expires before the circuit receives a CONNECT ACKNOWLEDG
message, the circuit clears the connection.

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.29
308612-14.00 Rev 00 A-55
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Parameter: T316

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 120
Options: 1 to 720

Function: Specifies the Restart Request Sent on Interface timer value (in seconds). 
timer begins when the circuit sends a RESTART message to the network. T
circuit uses the RESTART message to return all VCs on the interface to the
condition.

The Restart Request Sent on Interface timer stops when the circuit receive
RESTART ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a RESTART ACKNOWLEDG
message, the circuit can transmit as many RESTART messages as specifie
the Num Restarts ReXmitted parameter (see the parameter description on A-62). 
If the circuit still does not receive a response, the circuit enters the null stat
until the appropriate maintenance action is taken.

Instructions: Accept the default, 120, or enter a value from 1 to 720.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.30
A-56 308612-14.00 Rev 00
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Parameter: T316c

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 120
Options: 1 to 720

Function: Specifies the Restart Request Sent on Channel timer value (in seconds). T
timer begins when the circuit sends a RESTART message to the network. T
circuit uses the RESTART message to return this individual VC on the inter
to the idle condition.

The Restart Request Sent on Channel timer stops when the circuit receive
RESTART ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a RESTART ACKNOWLEDG
message, the circuit can transmit as many RESTART messages as specifie
the Num Restarts ReXmitted parameter (see the parameter description on A-62). 
If the circuit still does not receive a response, the circuit enters the null stat
until the appropriate maintenance action is taken.

Instructions: Accept the default, 120, or enter a value from 1 to 720.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.31
308612-14.00 Rev 00 A-57
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Parameter: T322

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Status Enquiry Sent timer value (in seconds). This timer beg
when the circuit sends a STATUS ENQUIRY message to the network. This
message checks the validity of a call by requesting the call state (that is, ac
in progress, or null). The Status Enquiry Sent timer stops when the circuit 
receives a STATUS message from the network.

If the timer expires before the circuit receives a STATUS message, the circ
can transmit as many STATUS ENQUIRY messages as specified with the N
Stat Enquiries ReXmitted parameter (see the parameter description on A-63). If 
the circuit still does not receive a response, the circuit clears the call.

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.32
A-58 308612-14.00 Rev 00
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Parameter: TDisc

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 180

Function: Specifies the SAAL Data Link Disconnect timer value (in seconds). This 
internal timer alerts upper layers that the link is down. The timer begins if th
entire link goes down for any reason.

When the link goes down, the SAAL sends a DISCONNECT REQUEST 
message to the upper-layer application manager. The SAAL sends a disco
request every time the SAAL Data Link Disconnect timer expires and contin
to send this message until the link becomes operational.

Instructions: Accept the default, 4, or enter a value from 1 to 180.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.33
308612-14.00 Rev 00 A-59
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Parameter: T397

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 180
Options: 180 to 1024

Function: Specifies the Alerting Received timer value (in seconds). This timer begins
when the circuit sends an ALERTING or ADD PARTY ALERTING message
a party (the receiver of the message) on the network.

The Alerting Received timer stops when the circuit receives a DROP PART
ACKNOWLEDGE message (indicating that the end point used for the party
been released) or a RELEASE message (indicating that the end point used
the party has been released and there are no remaining parties).

This timer can be used with UNI Version 4.0 and later.
Instructions: Accept the default, 180, or enter a value from 180 to 1024.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.43
A-60 308612-14.00 Rev 00
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Parameter: T398

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Drop Party Sent timer value (in seconds). This timer applies 
multipoint connections only and begins when the circuit sends a DROP PAR
message to a party (the receiver of the message) on the network.

The Drop Party Sent timer stops when the circuit receives a DROP PARTY
ACKNOWLEDGE message (indicating that the end point used for the party
been released) or a RELEASE message (indicating that the end point used
the party has been released and there are no remaining parties).

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.34
308612-14.00 Rev 00 A-61



Configuring ATM Services

o 
TY 

D 

ce of 

it 

 is 
Parameter: T399

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 14
Options: 1 to 84

Function: Specifies the Add Party Sent timer value (in seconds). This timer applies t
multipoint connections only and begins when the circuit sends an ADD PAR
message to a party (the receiver of the message) on the network.

The Add Party Sent timer stops when the circuit receives an ADD PARTY 
ACKNOWLEDGE message (indicating the connection to the party), an AD
PARTY REJECT message (indicating the inability to add the party), or a 
RELEASE message (indicating the inability to add the party and the absen
any remaining parties).

If the timer expires before the circuit receives an ADD PARTY 
ACKNOWLEDGE, ADD PARTY REJECT, or RELEASE message, the circu
clears the party.

Instructions: Accept the default, 14, or enter a value from 1 to 84.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.35

Parameter: Num Restarts ReXmitted

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 3
Options: 1 to 100

Function: Specifies the number of RESTART messages retransmitted before the link
considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.36
A-62 308612-14.00 Rev 00
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Parameter: Num Stat Enquiries ReXmitted

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 3
Options: 1 to 100

Function: Specifies the number of STATUS ENQUIRY messages retransmitted befor
link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.37

Parameter: Num Messages/Sec for Call Pacing

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 0
Options: 0 to 2147483647

Function: Specifies the maximum number of signaling messages the interface can tra
per second. The default value, 0, turns off this feature.

Instructions: Accept the default value, 0, or enter a value from 1 to 2147483647.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.40
308612-14.00 Rev 00 A-63
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ILMI signaling parameters define the SNMP timers and retry limits for 
registration with the ATM switch. For control VC parameter descriptions, see
“Signaling and ILMI Control VC Parameters” on A-68.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: Enable
Options: Enable | Disable

Function: Enables or disables ILMI on this interface.
Instructions: Accept the default, Enable, if you want ILMI to remain enabled on this 

interface. Select Disable if you do not want ILMI enabled on this interface.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.2

Parameter: ILMI VPI

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 0
Options: 0 to 255

Function: Specifies the virtual path identifier (VPI) for the ILMI VC.
Instructions: Accept the default, 0, or enter a value from 0 to 255.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.8

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the AT
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.
A-64 308612-14.00 Rev 00
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Parameter: ILMI VCI

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 16
Options: 1 to 65535

Function: Specifies the virtual channel identifier (VCI) for the ILMI VC.
Instructions: Accept the default, 16, or enter a value from 1 to 65535.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.9

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the AT
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.

Parameter: ILMI Get Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 120

Function: Specifies the ILMI Get Request timer value (in seconds). The Get Request
sets the amount of time allowed to receive a GET_RESPONSE message a
sending a GET_REQUEST message.

Instructions: Accept the default, 3, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.13
308612-14.00 Rev 00 A-65
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Parameter: ILMI Get Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 100

Function: Specifies the number of retransmissions of the ILMI GET_REQUEST mes
before the link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.14

Parameter: ILMI Get Next Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 120

Function: Specifies the ILMI Get Next Request timer value (in seconds). The Get Ne
Request timer sets the amount of time allowed to receive a 
GET_NEXT_RESPONSE message after sending a GET_NEXT_REQUES
message.

Instructions: Accept the default, 3, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.15

Parameter: ILMI Get Next Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 100

Function: Specifies the number of retransmissions of the ILMI GET_NEXT_REQUES
message before the link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.16
A-66 308612-14.00 Rev 00
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Parameter: ILMI Set Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 120

Function: Specifies the ILMI Set Request timer value (in seconds). The Set Request
sets the amount of time allowed to receive a SET_RESPONSE message a
sending a SET_REQUEST message.

Instructions: Accept the default, 3, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.17

Parameter: ILMI Set Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 100

Function: Specifies the number of retransmissions of the ILMI SET_REQUEST mes
before the link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.18
308612-14.00 Rev 00 A-67
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Signaling and ILMI Control VC Parameters

The parameters for signaling and ILMI control VCs are identical.

Parameter: Xmit Peak Cell Rate (cells/s)

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4716
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can supp
How you set the peak cell rate depends on:

• The optical transmission rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the transmission rate of your ATM device, set the pea
rate within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.8
A-68 308612-14.00 Rev 00



Site Manager Parameters
 

he 
ation 

 a 

the 
Cs 

e 

er 

ion.
Parameter: Xmit Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4716
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper limit of the ATM connection conforming average rate. T
average rate equals the total number of cells transmitted, divided by the dur
of the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of
VC in greater detail than by using only the peak cell rate.

The SCR maps directly to the minimum cell rate (MCR). The MCR defines 
minimum amount of guaranteed bandwidth allowed for PVCs and control V
on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR provides guaranteed bandwidth for PVCs and control VCs whil

allowing sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent high

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the transmission rate of your ATM device, set the 
sustainable cell rate within the specified range. Enter 0 to turn off this funct

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.9
308612-14.00 Rev 00 A-69
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Parameter: Xmit Burst Size (cells)

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 40
Options: 1 to 65535

Function: Specifies the maximum number of sequential cells allowed on a VC, at the
cell rate, before the VC must relinquish bandwidth to other VCs.

When setting the MBS, you should select a value larger than the largest pa
that your control VC can transmit (that is, the Maximum AAL CPCS Transm
SDU Size). For example, if your VC accepts packets that are less than 235
bytes long (PVC default), set your MBS value from 45 to 50 cells.

Instructions: Set a value in the specified range.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.10
A-70 308612-14.00 Rev 00
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Parameter: Maximum AAL CPCS Transmit SDU Size

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC suppor
the transmit direction.

Instructions: Enter the maximum packet size that you intend this VC to transmit. Nortel
Networks recommends that you accept the default value of 4608 bytes. Mo
packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.17

Parameter: Maximum AAL CPCS Receive SDU Size

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC suppor
the receive direction.

Instructions: Enter the maximum packet size that you intend this VC to receive. Nortel 
Networks recommends that you accept the default value of 4608 bytes. Mo
packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.18
308612-14.00 Rev 00 A-71
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ATM Signaling AAL Parameters

Signaling AAL (SAAL) parameters define the connection and timer settings t
router uses to maintain a switched connection. SAAL provides reliable transp
of signaling messages within the ATM protocol reference model.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: Enable
Options: Enable | Disable

Function: Enables or disables SAAL on this interface.
Instructions: Accept the default, Enable, if you want SAAL to remain enabled on this 

interface. Select Disable if you do not want SAAL enabled on this interface
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.2

Parameter: Link Connection Arbitration

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: Active
Options: Active | Passive

Function: Determines whether SAAL initiates link connections or waits for connectio
Instructions: Accept the default, Active, if you want this interface to initiate connections

Select Passive if you do not want this interface to initiate connections.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.8
A-72 308612-14.00 Rev 00
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Parameter: Poll Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 7
Options: 1 to 120

Function: Specifies the Service Specific Connection Oriented Protocol (SSCOP) pol
timer value (in tenths of a second). This value sets the allowable time betw
poll protocol data unit (PDU) transmissions.

The poll timer ensures that the receiver continues to return a solicited statu
(STAT) PDU to the sender on a regular basis. The timely receipt of STAT PD
restarts the poll timer and allows for more efficient transmission error recov

Instructions: Accept the default, 7, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.9

Parameter: Keep Alive Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 20
Options: 1 to 120

Function: Specifies the SSCOP keepalive timer value (in tenths of a second). This v
sets the allowable time between poll PDU transmissions if there are no pen
sequence data (SD) PDUs.

The keepalive timer is generally greater than the poll timer and greater than
length of one round-trip delay.

Instructions: Accept the default, 20, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.10
308612-14.00 Rev 00 A-73
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Parameter: No Response Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 70
Options: 1 to 120

Function: Specifies the SSCOP no response timer value (in tenths of a second). This
sets the allowable time between the receipt of STAT PDUs.

So as not to interrupt the flow of data, SSCOP does not require a reply to e
poll PDU. This can cause problems in detecting a failed connection. To allev
this problem, the no response timer runs parallel to the poll timer. If both th
response timer and the poll timer expire, SSCOP clears the connection.

The no response timer value must equal at least the sum of the keepalive t
plus the length of one round-trip delay.

Instructions: Accept the default, 70, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.11

Parameter: Connection Control Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 10
Options: 1 to 120

Function: Specifies the SSCOP connection control (CC) timer value (in tenths of a 
second). This value sets the allowable time between the transmission of be
(BGN), END, resynchronization (RS), and error recovery (ER) PDUs, so lo
as the sender has not received an acknowledgment to any of these PDUs.

The CC timer must equal at least the length of one round-trip delay.
Instructions: Accept the default, 10, or enter a value from 1 to 120.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.12
A-74 308612-14.00 Rev 00
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Parameter: Max Connection Control

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 4
Options: 1 to 20

Function: Specifies the SSCOP maximum connection control value. This value sets 
maximum number of times the sender can transmit a BGN, END, RS, or E
PDU.

Instructions: Accept the default, 4, or enter a value from 1 to 20.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.13

Parameter: Max PD Before Poll

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 25
Options: 1 to 120

Function: Specifies the SSCOP maximum poll data (PD) value. This value sets the 
maximum value of the poll data state variable before transmitting a poll PD
The poll data state variable increments upon transmission of a sequenced 
(SD) PDU and resets to 0 upon transmission of a poll PDU.

Instructions: Accept the default, 25, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.14
308612-14.00 Rev 00 A-75
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ATM Router Redundancy Parameter

This section describes the ATM Monitoring Timer parameter for implementing
ATM router redundancy. For information about all other router redundancy 
parameters, see Configuring Interface and Router Redundancy.

Parameter: Max STAT PDU Elements

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 67
Options: Odd integer from 3 to 119

Function: Specifies the SSCOP maximum STAT PDU value. This value sets the max
number of list elements allowed in a STAT PDU.

The sending device uses the value of this parameter for segmentation purp
When the number of list elements exceeds this value, the STAT message 
segments. As a general rule, the default value, 67, causes the STAT PDU t
six ATM cells using AAL 5.

Instructions: Accept the default, 67, or enter an odd integer from 3 to 119.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.15

Parameter: ATM Monitoring Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Configure 
ATM Router Redundancy

Default: 3000
Options: 1 to 65535

Function: Specifies the amount of time in milliseconds (ms) that the secondary route
waits before beginning the process of becoming the primary router. By defa
if the router experiences a loss of signal, it waits 3000 ms for the signal to 
return. If the signal does not return within that time, the secondary router be
the process of becoming the primary router.

Instructions: Accept the default, 3000, or enter another value.
MIB Object ID: 1.3.6.1.4.1.18.3.5.17.1.34
A-76 308612-14.00 Rev 00



Site Manager Parameters
 

ct 

ow 
OAM Parameters

This section describes ATM PVC Operations and Management (OAM) 
parameters.

Parameter: OAM Loopback Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > ATM  > Service 
Attributes  > PVC

Default: Disable
Options: Enable | Disable

Function: Specifies whether or not the ATM PVC sends OAM loopback cells.
Instructions: Select Enable if you want the ATM PVC to send OAM loopback cells. Sele

Disable if you do not want the ATM PVC to send OAM loopback cells.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.31

Note: You must configure OAM loopback on all PVCs on a service record for 
the feature to function properly. Service record status is based on the OAM 
loopback status of all PVCs on the service record. 

Parameter: OAM Loopback Cell Interval

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > ATM  > Service 
Attributes  > PVC

Default: 5
Options: 1 to 255 seconds

Function: Specifies the OAM loopback cell interval in seconds. This value specifies h
often an ATM PVC sends an OAM loopback cell in the data stream.

Instructions: Specify an interval from 1 to 255 seconds.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.32
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Parameter: OAM Threshold 1

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > ATM  > Service 
Attributes  > PVC

Default: 1
Options: 1 to 255

Function: Specifies the number of cells that the PVC can lose after not receiving an O
loopback response before declaring that the PVC service record is not 
operational.

Instructions: Specify a threshold value from 1 to 255 cells.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.33

Parameter: OAM Threshold 2

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > ATM  > Service 
Attributes  > PVC

Default: 2
Options: 1 to 255

Function: Specifies the number of OAM loopback response cells that the PVC servic
record must receive before declaring that the PVC is operational again.

Instructions: Specify a threshold value from 1 to 255 cells.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.34
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Parameter: OAM Alarm Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit  > ATM  > Service 
Attributes  > PVC

Default: Disable
Options: Enable | Disable

Function: When enabled, this parameter tells the upper-layer protocol that the PVC h
received an OAM alarm and that the service record is down. When disable
OAM alarms are ignored and no message is sent to the upper-layer protoc

Instructions: Select Enable if the connecting switch has OAM alarm capability, and if yo
want the ATM PVC to notify the upper-layer protocol of any OAM alarms. 
Select Disable if the connecting switch does not have OAM alarm capability
if you do not want the ATM PVC to notify the upper-layer protocol of any OA
alarms.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.35
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ATMARP Parameters

This section describes ATM-specific IP parameters for implementing classica
over ATM. For additional information about ATMARP, see Configuring IP, ARP, 
RIP, and OSPF Services.

Parameter: ATM ARP Mode

Path: Configuration Manager > Protocols > IP > Interfaces
Default: Client
Options: Client | Server | None

Function: Specifies whether ATMARP is running as a client or server on this interfac
Instructions: You must configure one ATMARP server for each LIS you define. When 

configuring a WAN SVC, select None.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.4.1.112

Parameter: ARP Server ATM Address Network Prefix

Path: Configuration Manager > Protocols > IP > Interfaces
Default: None
Options: XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF

where XX = 39, 45, or 47
Function: Specifies the ATM address network prefix of the ATMARP server on your 

network. The network prefix and the user part form a complete ATM addres

The XX byte must contain 39, 45, or 47. These values define the authority a
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format the prefix uses. For more information ab
the AFI byte, see the ATM Forum UNI specification.

Instructions: Enter the ATM address network prefix of the ATMARP server on your netw
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.4.1.113
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Parameter: ARP Server ATM Address User Part

Path: Configuration Manager > Protocols > IP > Interfaces
Default: None
Options: 00000000000000 to FEFFFFFFFFFFFF

Function: Specifies the user part (suffix) of the ATM address for the ATMARP server 
your network. The user part suffix consists of a 6-byte end-station identifier
a 1-byte selector field. The user part and the network prefix form a complet
ATM address.

Instructions: Enter the ATM address user part of the ATMARP server for your network.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.4.1.113

Parameter: Registration Refresh Interval

Path: Configuration Manager > Protocols > IP > Interfaces
Default: 900 seconds for a client

1200 seconds for a server
Options: Any interval (in seconds)

Function: For a client, this parameter specifies the interval between registration refre
For a server, this parameter specifies the duration for which the registration
valid.

Instructions: Determine whether ATMARP is running as a client or server on this interfa
and enter an appropriate value.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.4.1.115
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Adjacent Host Parameters

This section describes ATM IP parameters for creating adjacent hosts in a 
classical IP over ATM environment. For additional information about adjacent
hosts, see Configuring IP, ARP, RARP, RIP, and OSPF Services.

Parameter: Enable

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: Enable
Options: Enable | Disable

Function: Specifies the state (active or inactive) of the adjacent host in the IP routing
Instructions: Select Disable to make the adjacent host record inactive in the IP routing 

the IP router will not consider this adjacent host.

Select Enable to make the adjacent host record active again in the IP routin
table.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.2

Parameter: IP Adjacent Host Address

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: None
Options: Any valid IP address

Function: Specifies the IP address of the device that you want to configure as an ad
host.

Instructions: Enter the IP address in dotted-decimal notation.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.3

Parameter: Next Hop Interface Addr

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: 0.0.0.0
Options: Any valid IP address

Function: Specifies the IP address of the router’s network interface to the adjacent h
Instructions: Enter the IP address in dotted-decimal notation.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.4
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Parameter: MAC Address

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: None
Options: Depend on the data link you selected

Function: Specifies the MAC address of the adjacent host. This value can be any of 
following:

• A 48-bit physical address
• A 64-bit SMDS address
• An ATM VPI/VCI pair (for ATM PVCs)
• The ATM address of the ATM interface (for ATM SVCs)

Instructions: Enter the MAC address as a 12-digit hexadecimal number (canonical form
32-digit hexadecimal number (SMDS), a VPI/VCI pair (for example, 0/32), or a 
40-digit ATM address (for example, 
390000000000000000000000000000A20037B801).

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.6

Parameter: Host Encapsulation

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: Ethernet
Options: Ethernet | SNAP | PDN | DDN | SNAPIP | NULL

Function: Specifies the adjacent host’s encapsulation method.
Instructions: Select Ethernet or SNAP if you are defining a point-to-point network interfa

or if the adjacent host resides on an Ethernet. For an X.25 interface, select
Public Data Network (PDN) or Defense Data Network (DDN). For an adjac
host on an ATM logical IP subnet, select SNAP. (SNAPIP and NULL also 
specify host encapsulation methods for ATM networks.)

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.7
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Appendix B
Monitoring ATM Using the BCC show Command

This appendix describes how to use the BCC show command to obtain ATM, 
LANE, and classical IP statistical data from the management information bas
(MIB). The type and amount of data displayed depend on the specific ATM 
settings that you want to view. This appendix includes descriptions of the 
following show  commands:

Command Page

show atm interfaces B-2

show atm line B-3

show atm services B-6

show atm signaling B-6

show atm stats vcs B-7

show atm vcs B-8

show classical-ip configuration B-9

show classical-ip interface B-9

show classical-ip stats B-10

show classical-ip table B-10

show dsx3 circuits B-11

show dsx3 current B-12

show dsx3 history B-15

show lane clients B-19

show lane configuration B-20

show lane data-vcs B-20

show lane le-arp B-21

(continued)
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show atm interfaces

The show atm interfaces command displays the ATM interface table. This table conta
information about all ATM interfaces on the router or specific information based on th
filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

show lane le-rd-arp B-22

show lane les B-23

show lane mac B-23

show lane servers B-24

show lane stats B-25

show sonet circuits B-26

show sonet current B-27

show sonet history B-30

-slot  <slot>[/<connector>] Displays information about the specified slot or slot/connector pair 
only.

-enabled Displays information for only those interfaces enabled on the router 
or on the specified slot or slot/connector pair.

-disabled Displays information for only those interfaces disabled on the router 
or on the specified slot or slot/connector pair.

Slot Slot number on which the interface resides.

Conn Connector number of the interface.

Circuit Circuit name assigned to the interface.

State State of the ATM line: Up, Down, Init (initializing), Disabled, or 
Absent.

VPCs Maximum number of virtual path connections supported by the ATM 
interface.

VCCs Maximum number of virtual channel connections supported by the 
ATM interface.

Command Page
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show atm line

The show atm line command displays information about the ATM Adaptation Layer 
Controller (ALC) link module service.

The show atm line command supports the following subcommand options:

In addition, you can specify any of the following filters (flags) with the above 
subcommand options:

Addr Type Type of ATM address configured for use by the ATM interface: 
Private, NSAP E.164, Native E.164, Other, Null, or NotDefined.

Signaling Whether signaling is enabled or disabled on the ATM interface.

Sig Version The signaling standard configured for the ATM interface: UNI3.0 or 
UNI3.1.

errors phy errors

phy config stats

-slot  <slot>[/<connector>] Displays ATM line information for the specified slot or 
slot/connector pair only.

-enabled Displays ATM line information for enabled ATM lines only.

-disabled Displays ATM line information for disabled ATM lines only.

-sample Displays a snapshot of ATM line information taken at 10-second 
intervals.
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errors [-enabled | -disabled ] [-slot  <slot> | -slot  <slot>/<connector>] [-sample ]

Displays the ATM module physical interface errors table for the ATM routing engine 
(ARE).

The output includes the following line receive error statistics:

phy config [-enabled | -disabled ] [-slot  <slot> | -slot  <slot>/<connector>] 
[-sample ]

Displays the ATM module physical interface table for the ATM routing engine (ARE).

The output includes the following physical interface statistics:

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Invalid Headers Number of received cells dropped because of incorrect header 
format.

Over Sized SPDUs Number of packets dropped because their size was greater than the 
MTU specified for the interface.

Crc Errors Cyclical redundancy check errors.

Crc10 Errors Number of OAM cells dropped because they had an invalid CRC-10.

Rx Lack of Rsrcs Number of packets dropped because no host buffers were available 
to hold the incoming data. 

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Phy State Physical state of the ATM line (Up or Down).

Speed (Mbps) Estimate of the interface's current bandwidth: 155,520,000 Mb/s, 
140,000,000 Mb/s, 100,000,000 Mb/s, 44,736,000 Mb/s, or 
34,368,000 Mb/s.

Type Interface type: OC-3 MM (multimode), OC-3 SM (single mode), 
DS-3, or E-3.

Framing Mode Transceiver mode: SDH, SONET, CBIT, M23, G751, or G832.
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phy errors [-enabled | -disabled ] [-slot  <slot> | -slot  <slot>/<connector>] 
[-sample ]

Displays the ATM module physical interface errors table for the ATM routing engine 
(ARE).

The output includes the following physical interface error statistics:

stats [-enabled | -disabled ] [-slot  <slot> | -slot  <slot>/<connector>] [-sample ]

Displays the ATM module I/O statistics table for the ATM routing engine (ARE).

The output includes the following module I/O statistics:

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Tc. Alarm State State of the driver: Up, Down, Init (initializing), Download 
(downloading), Config (configuring), or Not Present. Note that this 
parameter does not represent the state of the physical interface.

HEC Detected Number of uncorrectable header error check (HEC) errors detected.

HEC Corrected Number of correctable HEC errors detected.

Out of Cell Delineation Number of times an out-of-cell delineation occurs. An out-of-cell 
delineation occurs when 7 consecutive ATM cells have HEC errors.

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Received Packets Number of packets received at the transceiver receive interface that 
have not been discarded. 

Transmitted Packets Number of packets transmitted at the transceiver transmit interface.

Invalid Headers Number of invalid headers detected by the transceiver interface.

Rx CRC Errors Number of receive CRC errors detected by the transceiver interface.

Total Errors Total number of errors detected by the transceiver interface.
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show atm services

The show atm services command displays all ATM service record instances or a sub
of service record instances, along with the AAL data encapsulation type, state, VC ty
and ATM address (a combination of network prefix and user part).

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

show atm signaling

The show atm signaling command displays all ATM interfaces, whether or not they ha
signaling enabled or disabled, and what version of signaling they are running.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

-slot  <slot>[/<connector>] Displays information about the specified slot or slot/connector pair 
only.

-service  <servicename> Displays information about the specified service record only.

Service Service name associated with this service record.

Encaps Encapsulation type of this VC: LAN Emulation, LLC/SNAP, NLPID, 
or NULL.

State State of the ATM line: Up, Down, Init (initializing), Reject, or Absent.

Type Type of virtual circuit: PVC or SVC.

ATM Address ATM address of this service record. This parameter applies only to 
SVC service records.

-slot  <slot>[/<connector>] Displays information about the specified slot or slot/connector pair 
only.

-service  <servicename> Displays information about the specified service record only.

Slot/<Module>/Conn The slot, module, and connector number of the ATM circuit.

Signaling Whether signaling is enabled or disabled on the interface.

Sig Version The signaling version that the interface is using.
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show atm stats vcs

The show atm stats vcs command displays the ATM interface VC statistics table for t
ATM routing engine (ARE). This table contains statistical information for all ATM VCs
on the router or specific information based on the filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

-slot  <slot>[/<connector>] Displays statistical information about the specified slot or
slot/connector pair only.

-service  <servicename> Displays statistical information about the specified service record 
only.

-vpi Displays statistical information for the specified virtual path 
identifier (VPI) only.

-vci Displays statistical information for the specified virtual channel 
identifier (VCI) only.

Service Name of the service record containing the virtual channel (VC).

VPI Virtual path identifier (VPI) of the VC.

VCI Virtual channel identifier (VCI) of the VC.

Cells Tx Number of assigned ATM layer cells transmitted at the transceiver 
transmit interface (T-count).

Cells Rx Number of ATM layer cells received at the transceiver receive 
interface that were not discarded (R-count).

Packets TX Number of packets transmitted at the transceiver transmit interface.

Packets Rx Number of packets received at the transceiver receive interface that 
were not discarded. 
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show atm vcs

The show atm vcs command displays the ATM interface VCL table. This table contain
information about all ATM virtual channel links on the router or specific information 
based on the filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

-slot  <slot>[/<connector>] Displays VC information about the specified slot or slot/connector 
pair only.

-service  <servicename> Displays VC information about the specified service record only.

-vpi Displays VC information for the specified virtual path identifier (VPI) 
only.

-vci Displays VC information for the specified virtual channel identifier 
(VCI) only.

Service Name of the service record containing the virtual channel (VC).

VPI Virtual path identifier (VPI) of the VC.

VCI Virtual channel identifier (VCI) of the VC.

Type Type of VC: SVC or PVC.

State State of the ATM line: Up, Down, Init (initializing), Disabled, or 
Absent.

Hybrid/Bridged VCs? Whether this is a hybrid/bridged VC. Yes means the VC operates as 
a hybrid access mode VC; No means the VC works in group access 
mode only.

AAL ATM Adaptation Layer type of this VC: AAL5.

Encaps Encapsulation type of this VC: LLC/SNAP, NULL, LANE8023, 
LANE8025, NLPID, Unknown, or OTHER.

Xmt PCR Transmit peak cell rate (PCR) for this VC (in cells/s).

Xmt SCR Transmit sustainable cell rate (SCR) for this VC (in cells/s).
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show classical-ip configuration

The show classical-ip configuration command displays information for all classical IP
interfaces on the ATM router or for one specific IP address. This command allows fo
following command filter (flag) and filter argument:

The output includes the following information:

show classical-ip interface

The show classical-ip interface command displays information for all classical IP 
interfaces on the ATM router or for one specific IP address. This command allows fo
following command filter (flag) and filter argument:

The output includes the following information:

-ipaddr  <ip_address> Displays information about the specified IP address only.

Interface The IP address of the classical IP interface.

Mode The mode of the classical IP interface (client or server).

Server Address (if client) The ATM address of the server with which the classical IP client 
communicates.

-ipaddr  <ip_address> Displays information about the specified IP address only.

Interface IP address of the classical IP interface.

Address ATM address of the server with which the classical IP client 
communicates.

Server Conn. State The state of the connection to the ATMARP server.
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show classical-ip stats

The show classical-ip stats command displays statistics for all classical IP interfaces 
the ATM router or for one specific IP address. This command allows for the following
command filter (flag) and filter argument:

The output includes the following information:

show classical-ip table

The show classical-ip table command displays information for each classical IP 
interface. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

-ipaddr  <ip_address> Displays statistical information about the specified IP address only.

Interface IP address of the classical IP interface.

Open SVCs Number of open SVCs. 

Calls Attempted Number of calls ATMARP has attempted.

Calls Succeeded Number of originated calls that have completed successfully.

Failed May Retry Number of attempted calls that failed but were retried.

Failed No Retry Number of attempted calls that failed but were not retried.

Calls Accepted Number of received calls that were accepted.

-ipaddr  <ip_address> Displays information about the specified IP address only.

IP Address IP address of the classical IP interface.

Life The interval between registration refreshes; the duration a 
registration is considered valid.

ATM Address ATM address associated with the classical IP client.

Vpi.Vci VPI/VCI pair associated with the classical IP client.
B-10 308612-14.00 Rev 00



Monitoring ATM Using the BCC show Command
 

 

show dsx3 circuits

The show dsx3 circuits command displays information about the DSX3 circuits in the
configuration.

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the DSX3 circuit.

Circuit The name of the circuit associated with this line.

Sec into Interval The number of seconds into the current 15-minute interval.

# of Intervals The number of complete 15-minute intervals. The value is 96 unless 
the interface was brought online within the last 24 hours. In that 
case, the value is the number of complete 15-minute intervals since 
the interface has been online.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3
The line coding specifies patterns of normal bits and bipolar 
violations used to replace sequences of zero bits of a certain length.

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI -  transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal
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show dsx3 current

The show dsx3 current command displays line, Pbit, Cbit, and Plcp statistics for the 
DSX3 circuits in the configuration.

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the DSX3 circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval The number of seconds into the current 15-minute interval.

# of Intervals The number of complete 15-minute intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal

Line Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

LESs The number of line errored seconds (LESs) in the current interval. 
An LES is a second in which one or more coding violations occurred 
or one or more LOS defects were detected.

SEFSs The number of severely errored framing seconds (SEFSs) in the 
current interval. An SEFS is a second with one or more OOF errors 
or an AIS defect.

UASs The number of unavailable seconds (UASs) in the current interval.

LCVs The number of line coding violations (LCVs) in the current interval. 
A line coding violation is a count of both bipolar violations (BPVs) 
and excessive zero (EXZ) error events.
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Pbit Status

Circuit Name of the circuit associated with this line.

Interval The current interval.

PESs The number of P-bit errored seconds (PESs) in the current interval. 
A PES is a second with one or more P-bit coding violations,            
one or more OOF defects, or a detected incoming AIS. The PES 
does not increment when counting UASs.

PSESs The number of P-bit severely errored seconds (PSESs) in the 
current interval. A PSES is a second with 44 or more PCVs, one or 
more OOF defects, or a detected incoming AIS. The PSES value 
does not increment when counting UASs.

UASs The number of unavailable seconds (UASs) in the current interval.

PCVs The number of P-bit coding violations (PCVs) in the current interval. 
For all DS3/E3 applications, a coding violation error event is a P-bit 
Parity Error event.  A P-bit Parity Error event occurs when the DS-3/
E-3 M-frame receives a P-bit code that is not identical to the 
corresponding locally calculated code.

Cbit Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs The number of C-bit errored seconds (CESs) in the current interval. 
A CES is a second with one or more CCVs, one or more OOF 
defects, or a detected incoming AIS. This count is only for the 
C-bit Parity DS3 applications. The CES value does not increment 
when counting UASs.

CSESs The number of C-bit severely errored seconds (CSESs) in the 
current interval. A CSES is a second with 44 or more CCVs, one or 
more OOF defects, or a detected incoming AIS. This count applies 
only to C-bit Parity DS3 applications. The CSES value does not 
increment when counting UASs.

UASs The number of unavailable seconds (UASs) in the current interval.

CCVs The number of C-bit coding violations (CCVs) in the current interval. 
For C-bit Parity and SYNTRAN DS3 applications, this is the count of 
coding violations reported via the C-bits. For C-bit Parity, it is a 
count of C-bit parity errors occurring in the accumulation interval.
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FarEnd Cbit Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs The number of C-bit errored seconds (CESs) in the current interval. 
A CES is a second with one or more CCVs, one or more OOF 
defects, or a detected incoming AIS. This count is only for C-bit 
Parity DS3 applications. The CES value does not increment when 
counting UASs.

CSESs The number of C-bit severely errored seconds (CSESs) in the 
current interval. A CSES is a second with 44 or more CCVs, one or 
more OOF defects, or a detected incoming AIS. This count applies 
only to C-bit Parity DS3 applications. The CSES value does not 
increment when counting UASs.

UASs The number of unavailable seconds (UASs) in the current interval.

CCVs The number of C-bit coding violations (CCVs) in the current interval. 
For C-bit Parity DS3 applications, this is the count of coding 
violations reported via the C-bits. For C-bit Parity, it is a count of 
C-bit parity errors occurring in the accumulation interval.

DS3 Plcp Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

SEFSs The number of severely errored framing seconds (SEFSs) in the 
current interval. An SEFS is a second with one or more OOF errors 
or an AIS defect.

UASs The number of unavailable seconds (UASs) in the current interval.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal
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show dsx3 history

The show dsx3 history command displays line, Pbit, Cbit, and Plcp statistics for the 
DSX3 circuits in the configuration over specific intervals.

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the DSX3 circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval The number of seconds into the current interval.

# of Intervals The number of complete intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal
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Line Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

LESs The number of line errored seconds (LESs) for each interval 
category.

SEFSs The number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

LCVs The number of line coding violations (LCVs) for each interval 
category.

Pbit Status

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

PESs The number of P-bit errored seconds (PESs) for each interval 
category.

PSESs The number of P-bit severely errored seconds (PSESs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

PCVs The number of P-bit coding violations (PCVs) for each interval 
category.
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Cbit Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs The number of C-bit errored seconds (CESs) for each interval 
category.

CSESs The number of C-bit severely errored seconds (CSESs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

CCVs The number of C-bit coding violations (CCVs) for each interval 
category.

FarEnd Cbit Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs The number of C-bit errored seconds (CESs) for each interval 
category.

CSESs The number of C-bit severely errored seconds (CSESs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

CCVs The number of C-bit coding violations (CCVs) for each interval 
category.
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DS3 Plcp Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

SEFSs The number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal
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g 
show lane clients

The show lane clients command displays the ATM LAN emulation client running confi
info table. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

-service  <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

LecID LEC ID that the LE server (LES) assigns during the join state.

State State for the LEC: INITIAL, LECSCONNECT, CONFIGURE, JOIN, 
INITIAL_REG, BUSCONNECT, or OPERATIONAL.

Fail Code Status code from the last failed configure or join response.

Cfg Src Indicates whether this LEC used the LAN emulation configuration 
server (LECS) and if so, what method is used to establish the 
configuration direct VCC: VIAILMI, KNOWNADR, CFGPVC, or NO 
LECS.

LAN type Data frame format this client is now using: Unspecified, IEEE 802.3, 
or IEEE 802.5.

Max Data Frm Size Maximum data frame size this client is now using: Unspecified, 
1516, 4544, 9234, or 18190.

ELAN Name The name of the emulated LAN (ELAN) that this client last joined.

Proxy Indicates whether the LEC acts as a proxy when it joins an ATM 
emulated LAN: 1 (true) or 2 (false).

Primary addr ATM address of the LEC.

Cfg Server addr ATM address of the LAN emulation configuration server.

LE Server addr ATM address of the LAN emulation server.
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t:
show lane configuration

The show lane configuration command displays portions of the ATM LAN emulation 
client table. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

show lane data-vcs

The show lane data-vcs command displays portions of the ATM LAN emulation client
table. This command allows for the following command filter (flag) and filter argumen

The output includes the following information:

-service  <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

LAN Name Emulated LAN name this client will use the next time it returns to the 
initial state.

LAN Type Data frame format that this client will use the next time it returns to 
the initial state: Unspecified, IEEE 802.3, or IEEE 802.5.

State State of the LEC: INITIAL, LECSCONNECT, CONFIGURE, JOIN, 
INITIAL_REG, BUSCONNECT, or OPERATIONAL.

Mode The configuration mode of the LAN emulation client: AUTO or 
MANUAL.

LECS ATM addr Configured ATM address of the LAN emulation configuration server.

-service  <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

Data Direct The VPI/VCI pair that identifies the data direct VCCs (if they exist) at 
the point where they connect to this LEC.
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show lane le-arp

The show lane le-arp command displays the ATM LAN emulation client MAC-to-ATM 
cache table. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

-service  <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

IsRemote Indicates whether the MAC address belongs to a remote client.

EntryType Indicates how this table entry was created: LEARNED, LEARNED 
CTRL, LEARNED DATA, STATIC VOL, STATIC NONVOL, or 
OTHER.

For the router, the LEC always learns this entry using the control 
VCC; the entry type is never STATIC.

Status Row status: ENABLE or DISABLE. For the router, the status is 
always ENABLE.

VPI Virtual path identifier (VPI) associated with this MAC address.

VCI Virtual channel identifier (VCI) associated with this MAC address.

MAC Address Remote MAC address.

ATM Address ATM address representing the MAC address.
308612-14.00 Rev 00 B-21



Configuring ATM Services

 
lter 
show lane le-rd-arp

The show lane le-rd-arp command displays the ATM LAN emulation client RD-to-ATM
ARP cache table. This command allows for the following command filter (flag) and fi
argument:

The output includes the following information:

-service  <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

EntryType Indicates how this table entry was created: LEARNED, LEARNED 
CTRL, LEARNED DATA, STATIC VOL, STATIC NONVOL, or 
OTHER.

For the router, the LEC always learns this entry using the control 
VCC; the entry type is never STATIC.

Status Row status: ENABLE or DISABLE. For the router, the status is 
always ENABLE.

VPI The virtual path identifier (VPI) for the LEC.

VCI The virtual channel identifier (VCI) for the LEC.

SEG ID The segment ID on which the LEC resides.

Br# The bridge number on which the LEC resides.

ATM Address The ATM address associated with the LEC.
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t:
show lane les

The show lane les  command displays the ATM LAN emulation servers in the order th
were configured.

The output includes the following information:

show lane mac

The show lane macs command displays the ATM LAN emulation client MAC address
table. This command allows for the following command filter (flag) and filter argumen

The output includes the following information:

Slot/Module/Connector The slot location of the ATM module within the chassis, the module 
number (System 5000 platforms only), and the connector number.

Service Name of the service record containing the client.

LES Name Name you assigned to the LAN emulation server entry.

State State of the LES entry: enabled or disabled.

LES Address The LAN emulation server ATM address.

-service  <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

MAC Address The local MAC address on this ATM interface that the LEC uses.

ATM address registered for 
MAC address

The ATM address configured for the service record that this LEC 
uses.
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show lane servers

The show lane servers command displays the ATM LAN emulation client server VCC
table. This command allows for the following command filter (flag) and filter argumen

The output includes the following information:

-service  <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

Config Direct VPI The virtual path identifier (VPI) that identifies the configuration direct 
VCC (if it exists) at the point where it connects to this LEC.

Config Direct VCI The virtual channel identifier (VCI) that identifies the configuration 
direct VCC (if it exists) at the point where it connects to this LEC.

Control Direct VPI The VPI that identifies the control direct VCC (if it exists) at the point 
where it connects to this LEC.

Control Direct VCI The VCI that identifies the control direct VCC (if it exists) at the point 
where it connects to this LEC.

Control Distributed VPI The VPI that identifies the control distributed VCC (if it exists) at the 
point where it connects to this LEC.

Control Distributed VCI The VCI that identifies the control distributed VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Send VPI The VPI that identifies the multicast send VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Send VCI The VCI that identifies the multicast send VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Forward VPI The VPI that identifies the multicast forward VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Forward VCI The VCI that identifies the multicast forward VCC (if it exists) at the 
point where it connects to this LEC.
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show lane stats

The show lane stats command displays the ATM LAN emulation statistics table. This
command allows for the following command filter (flag) and filter argument:

The output includes the following information:

-service  <servicename> Displays statistical information about the specified service record 
only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

Req Out Number of MAC-to-ATM ARP requests this LEC sent over the 
logical user-to-network interface (LUNI) associated with this 
emulated packet interface.

Req In Number of MAC-to-ATM ARP requests this LEC received over the 
LUNI associated with this emulated packet interface.

ReplyOut Number of MAC-to-ATM ARP replies this LEC sent over the LUNI 
associated with this emulated packet interface.

ReplyIn Number of MAC-to-ATM ARP replies this LEC received over the 
LUNI associated with this emulated packet interface.

FrameOut Total number of control packets this LEC sent over the LUNI 
associated with this emulated packet interface.

FrameIn Total number of control packets this LEC received over the LUNI 
associated with this emulated packet interface.

SVCFails Number of SVCs this LEC unsuccessfully tried to open.
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show sonet circuits

The show sonet circuits command displays portions of the SONET entries table. 

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit The name of the circuit associated with this line.

Sec into Interval The number of seconds into the current 15-minute interval.

# of Intervals The number of complete 15-minute intervals. The value is 96 unless 
the interface was brought online within the last 24 hours. In that 
case, the value is the number of complete 15-minute intervals since 
the interface has been online.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3
The line coding specifies patterns of normal bits and bipolar 
violations used to replace sequences of zero bits of a certain length.

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI -  transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal
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show sonet current

The show sonet current command displays portions of the SONET entries table. 

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval The number of seconds into the current 15-minute interval.

# of Intervals The number of complete 15-minute intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal

Line Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

LESs The number of line errored seconds (LESs) in the current interval. 
An LES is a second in which one or more coding violations occurred 
or one or more LOS defects were detected.

SEFSs The number of severely errored framing seconds (SEFSs) in the 
current interval. An SEFS is a second with one or more OOF errors 
or an AIS defect.

UASs The number of unavailable seconds (UASs) in the current interval.

LCVs The number of line coding violations (LCVs) in the current interval. 
A line coding violation is a count of both bipolar violations (BPVs) 
and excessive zero (EXZ) error events.
308612-14.00 Rev 00 B-27



Configuring ATM Services
Pbit Status

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

PESs The number of P-bit errored seconds (PESs) in the current interval. 
A PES is a second with one or more P-bit coding violations,            
one or more OOF defects, or a detected incoming AIS. The PES 
does not increment when counting UASs.

PSESs The number of P-bit severely errored seconds (PSESs) in the 
current interval. A PSES is a second with 44 or more PCVs, one or 
more OOF defects, or a detected incoming AIS. The PSES value 
does not increment when counting UASs.

UASs The number of unavailable seconds (UASs) in the current interval.

PCVs The number of P-bit coding violations (PCVs) in the current interval. 
For all SONET applications, a coding violation error event is a P-bit 
Parity Error event.  A P-bit Parity Error event occurs when the 
SONET M-frame receives a P-bit code that is not identical to the 
corresponding locally calculated code.

Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs The number of C-bit errored seconds (CESs) in the current interval. 
A CES is a second with one or more CCVs, one or more OOF 
defects, or a detected incoming AIS. This count is only for the 
C-bit Parity SONET applications. The CES value does not 
increment when counting UASs.

CSESs The number of C-bit severely errored seconds (CSESs) in the 
current interval. A CSES is a second with 44 or more CCVs, one or 
more OOF defects, or a detected incoming AIS. This count applies 
only to C-bit Parity SONET applications. The CSES value does not 
increment when counting UASs.

UASs The number of unavailable seconds (UASs) in the current interval.

CCVs The number of C-bit coding violations (CCVs) in the current interval. 
For C-bit Parity and SONET applications, this is the count of coding 
violations reported via the C-bits. For C-bit Parity, it is a count of 
CP-bit parity errors occurring in the accumulation interval.
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FarEnd Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs The number of C-bit errored seconds (CESs) in the current interval. 
A CES is a second with one or more CCVs, one or more OOF 
defects, or a detected incoming AIS. This count is only for C-bit 
Parity DS3 applications. The CES value does not increment when 
counting UASs.

CSESs The number of C-bit severely errored seconds (CSESs) in the 
current interval. A CSES is a second with 44 or more CCVs, one or 
more OOF defects, or a detected incoming AIS. This count applies 
only to C-bit Parity DS3 applications. The CSES value does not 
increment when counting UASs.

UASs The number of unavailable seconds (UASs) in the current interval.

CCVs The number of C-bit coding violations (CCVs) in the current interval. 
For C-bit Parity SONET applications, this is the count of coding 
violations reported via the C-bits. For C-bit Parity, it is a count of 
CP-bit parity errors occurring in the accumulation interval.

DS3 Plcp Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

SEFSs The number of severely errored framing seconds (SEFSs) in the 
current interval. An SEFS is a second with one or more OOF errors 
or an AIS defect.
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show sonet history

The show sonet history command displays portions of the SONET entries table. 

The output includes the following information:

UASs The number of unavailable seconds (UASs) in the current interval.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval The number of seconds into the current interval.

# of Intervals The number of complete intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal
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Line Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

LESs The number of line errored seconds (LESs) for each interval 
category.

SEFSs The number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

LCVs The number of line coding violations (LCVs) for each interval 
category.

Pbit Status

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

PESs The number of P-bit errored seconds (PESs) for each interval 
category.

PSESs The number of P-bit severely errored seconds (PSESs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

PCVs The number of P-bit coding violations (PCVs) for each interval 
category.
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Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs The number of C-bit errored seconds (CESs) for each interval 
category.

CSESs The number of C-bit severely errored seconds (CSESs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

CCVs The number of C-bit coding violations (CCVs) for each interval 
category.

FarEnd Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs The number of C-bit errored seconds (CESs) for each interval 
category.

CSESs The number of C-bit severely errored seconds (CSESs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

CCVs The number of C-bit coding violations (CCVs) for each interval 
category.
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SONET Plcp Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

SEFSs The number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs The number of unavailable seconds (UASs) for each interval 
category.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm - no alarm present
• RRAI - receiving yellow remote alarm indication
• TRAI - transmitting yellow remote alarm indication
• RAIS - receiving Alarm Indications Signal (AIS) failure state
• TAIS - transmitting AIS failure state
• LOF - receiving Loss of Frame (LOF) failure state
• LOS - receiving Loss of Signal (LOS) failure state
• Loopback - looping the received signal
• TestCode - receiving a test pattern
• LowSignal - low signal
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Index
A

AAL CPCS Receive SDU Size
parameter description

control VCs, A-71
PVCs, A-26

setting
control VCs, 4-58
PVCs, 5-19

AAL CPCS Transmit SDU Size
parameter description

control VCs, A-71
PVCs, A-25

setting
control VCs, 4-55
PVCs, 5-17

AAL, described, 1-8

accessing
ATM networks

PVCs, 1-17 to 1-20
SVCs, 1-22

ATM windows, A-2

acronyms, xxi

Add Party Sent timer. See T399

adding
ATM circuit, 2-7
ATM to the router, 2-15
protocols

to existing service record, 2-14
to new service record, 2-13

PVCs, 2-15
service records

classical IP, 2-10
LANE, 2-11
PVC, 2-9
WAN SVC, 2-12

address resolution, ATM, 1-31
308612-14.00 Rev 00
addresses
assigning, 1-22
autogenerating, 3-18, 6-4, 7-3
parts of, 1-22

Adjacent Host ATM Address
parameter description, A-27

adjacent host parameters, descriptions of, A-82

adjacent hosts, defined, 1-33

Administrative State
assigning to

interfaces, 3-15
PVCs, 5-9

parameter description, A-11, A-22

Aging Time
parameter description, A-38
setting, 7-37

ARP Server ATM Address Network Prefix parameter,
A-80

ARP Server ATM Address User Part parameter, A-81

ARP support, 1-27

ATM
address resolution, 1-31
addresses

assigning, 1-22
autogenerating, 3-18, 6-4, 7-3
parts of, 1-22

cell
described, 1-2
switching, 1-4
technology, 1-2

circuit, adding, 2-7
concepts, 1-2 to 1-6
data transmission, 1-4
deleting from router, 2-22
interface, customizing, 3-1
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layers
AAL 5, 1-9
ATM Adaptation Layer (AAL), 1-7
in protocol reference model, 1-6 to 1-9

router redundancy
customizing, 9-1
described, 1-39
parameter, description of, A-76
starting, 2-1, 2-16

signaling support, 4-2
starting

configuration tools, 2-1
router redundancy, 2-16
with BCC, 2-2
with Site Manager, 2-7

traffic parameters, modifying
control VCs, 4-45
PVCs, 5-11
WAN SVCs, 8-7

windows, accessing, A-2

ATM Addr Net Prefix
entering a value for, 1-23
parameter description, A-17
service record

classical IP, 6-6
LEC/LANE, 7-5

ATM Addr User Part
entering a value for, 1-23
parameter description, A-16
service record

classical IP, 6-8
LEC/LANE, 7-6

ATM ARP Mode parameter, A-80

ATM layer, described, 1-8

ATM Monitoring Timer
parameter description, A-76
setting, 9-2

ATMARP
configuring, 1-32
defined, 1-31
parameters, descriptions of, A-80

B

BCC
adding IP with, 2-6
adding IPX with, 2-6
protocols supported, 2-6
show commands, B-1
starting ATM with, 2-2

Broadband Integrated Services Digital Network 
(B-ISDN), 1-2

broadcast and unknown server (BUS), described, 1-3

Burst Size, setting
control VCs, 4-51
PVCs, 5-15

BUS connect state, LAN emulation, 1-38

C

Call Proceeding Received timer. See T310

calls, pacing, 4-28

cells
converting to, 1-27
header, 1-3
information field, 1-4

classical IP
concepts, 1-28 to 1-31
defining service records for, 2-4

Clear function, router redundancy, 2-16

Clocking Signal Source
defining, 3-10
parameter description, A-8

commands, show, B-1

configuration files, router redundancy
creating group, 2-17
creating member, 2-19
downloading, 2-21

Configuration Manager Protocols menu, using, A-4

Configuration Mode
LEC, selecting, 7-8
parameter description, A-33

configure state, LAN emulation, 1-37

Connect Sent Timer. See T313
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Connection Control Timer
parameter description, A-74
setting, 4-67

connections
memory, 4-14
setting thresholds, 4-9

Control Timeout
parameter description, A-35
setting, 7-32

control VCs
customizing

ILMI, 4-58
signaling, 4-58

defining, 4-39
parameters

descriptions of, A-68
Maximum AAL CPCS Receive SDU Size, A-71
Maximum AAL CPCS Transmit SDU Size, A-71
Xmit Sustainable Cell Rate, A-69

traffic parameters, 4-45

conventions, text, xx

convergence sublayer (CS), described, 1-8

counters, modifying ILMI, 4-31 to 4-38

customer support, xxvi

customizing
control VCs

ILMI, 4-58
signaling, 4-58

ILMI, 4-29 to 4-38
LE clients, 7-48
PVCs, 5-1
SAAL, 4-61 to 4-70
SSCOP, 4-61 to 4-71

customizing WAN SVCs, 8-1

D

data encapsulation
assigning, PVCs, 5-20
assigning, WAN SVCs, 8-14
methods of, 1-13
rules for PVCs, 1-16
selecting, 1-15

Data Encapsulation Type
assigning

PVCs, 5-20
WAN SVCs, 8-14

parameter description
PVCs, A-26
service record, A-15

data frame size, setting, 7-26

Data Link Connection timer. See T309

Data Link Disconnect timer. See TDisc

Data Path Enable, parameter description, A-6

Data Path Notify Timeout
parameter description, A-6
specifying, 3-5

data path notify, enabling/disabling, 3-5

data transmission, described, 1-4

Drop Party Sent Timer. See T398

DS3 Line Build Out
parameter description, A-9
specifying, 3-11

DS3 Scrambling
parameter description, A-9
turning on/off, 3-12

E

Edit ATM Connector window, using, A-3

Emulated LAN Name
entering, 7-10
parameter description, A-18, A-35

Emulated LAN Segment ID
parameter description, A-40
specifying, 7-14

Emulated LAN Type
defining, 7-12
parameter description, A-19, A-33

Enable ATM Signaling parameter, A-11

Enable parameter
adjacent host, A-82
ILMI

description, A-64
using, 4-29
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, 
LANE
description, A-32
using, 7-15

LES/BUS address, description, A-42
line

description, A-5
using, 3-2

SAAL
description, A-72
using, 4-62

signaling
description, A-44
using, 4-3

SSCOP, using, 4-62

Enable/Disable (service record)
parameter description, A-14, A-27
using, 5-2, 6-2, 7-2, 8-2

encapsulation, multiprotocol, 1-13

error checking, 1-27

Expected LE_ARP Response Time
parameter description, A-38
specifying, 7-40

F

Flush Protocol
defined, 7-44
enabling/disabling, 7-44
parameter description, A-40

Flush Timeout
parameter description, A-39
setting, 7-46

Forward Delay Time
parameter description, A-38
setting, 7-39

Framing Mode
assigning, 3-9
parameter description, A-8

G

Get Next Retry Count. See ILMI Get Next Retry Count

Get Next Timer. See ILMI Get Next Timer

Get Retry Count. See ILMI Get Retry Count

Get Timer. See ILMI Get Timer

group configuration files, router redundancy, creating
2-17

H

Hardware MAC Address
enabling/disabling, 3-18
parameter description, A-12

Host Encapsulation parameter, A-83

hybrid access (PVCs)
described, 1-19 to 1-21
designating, 5-7

Hybrid/Bridged VC parameter, A-22

I

ILMI
control VCs, customizing, 4-58
customizing, 4-29 to 4-38
enabling/disabling, 4-29
parameters, descriptions of, A-64
support, 4-29

ILMI Get Next Retry Count
parameter description, A-66
setting, 4-35

ILMI Get Next Timer
parameter description, A-66
setting, 4-34

ILMI Get Retry Count
parameter description, A-66
setting, 4-33

ILMI Get Timer
parameter description, A-65
setting, 4-31

ILMI Set Retry Count
parameter description, A-67
setting, 4-38

ILMI Set Timer
parameter description, A-67
setting, 4-37

ILMI VCI
changing, 4-42
parameter description, A-65
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ILMI VPI
changing, 4-40
parameter description, A-64

Initial Registration State, LAN emulation, 1-38

initial state, LAN emulation, 1-37

Interface MTU
defining, 3-3
parameter description, A-5
See also MTU

interface parameters, descriptions of, A-11 to A-13

interface, enabling/disabling, 3-15

Interim Local Management Interface. See ILMI

Inverse ARP support, 1-27

IP adjacent host
Enable parameter, A-82
Host Encapsulation parameter, A-83
IP Adjacent Host Address parameter, A-82
MAC Address parameter, A-83
Next Hop Interface Addr parameter, A-82

IP Adjacent Host Address parameter, A-82

ISDN protocol model, 1-6

J

join state, LAN emulation, 1-37

K

Keep Alive Timer
modifying, 4-65
parameter description, A-73

L

LAN emulation
broadcast and unknown server (BUS), described, 

1-35
BUS connect state, 1-38
client. See  LEC
components, 1-34
concepts, 1-33 to 1-38, 1-40 to ??
Configuration Server (LECS), described, 1-34
customizing, 7-48
enabling protocols for, 1-12
parameters, descriptions of, A-32 to A-41

retry counters, modifying, 7-32 to 7-42
server (LES), described, 1-34
states, 1-36 to 1-38
timers, modifying, 7-32 to 7-42

LAN emulation configuration server, described, 1-34

LAN emulation server. See LES

LAN Emulation Version 2
enabling/disabling, 7-49
parameter description, A-41

LANE encapsulation, defined, 1-13
See also data encapsulation

LE client. See LEC

LE Config Server ATM Address
parameter description, A-41
specifying for LEC, 7-48

LE Server ATM Address Network Prefix parameter, 
A-42

LE Server ATM Address User Part parameter, A-43

LE Server ATM Address, entering, 7-17

LE Server Name parameter, A-43

LE server name, changing, 7-21

LEC
described, 1-34
enabling/disabling, 7-15
LE Server ATM Address, assigning, 7-17
owner, specifying, 7-16
service records, defining, 2-4

LECS address
described, 1-34
specifying for LEC service, 7-48

LECS connect state, LAN emulation, 1-37

LES
assigning, 7-17
deleting, 7-24
described, 1-34
enabling/disabling, 7-19
inserting out of sequence, 7-22
modifying, 7-23
parameters, descriptions of, A-42
redundant, 1-35

line parameters, descriptions of, A-5 to A-10
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Link Connection Arbitration
defining, 4-63
parameter description, A-72

LLC/SNAP encapsulation, defined, 1-14
See also data encapsulation

M

MAC address
enabling/disabling, 3-18
override value, entering, 3-19

MAC Address Override parameter, A-13

MAC Address parameter, A-83

Max Connection Control
parameter description, A-75
setting, 4-67

Max Number of SVC Applications
parameter description, A-45
specifying, 4-7

Max Parties in Multipoint Connections
parameter description, A-47
setting, 4-13

Max PD Before Poll
parameter description, A-75
setting, 4-69

Max Point to Multipoint Connections
parameter description, A-46
setting, 4-11

Max Point to Point Connections
defining, 4-9
parameter description, A-46

Max Retry Count
parameter description, A-37
setting, 7-36

Max STAT PDU Elements
parameter description, A-76
setting, 4-70

Max Unknown Frame Count
parameter description, A-36
setting, 7-28

Max Unknown Frame Time
parameter description, A-36
specifying, 7-30

Maximum AAL CPCS Receive SDU Size
parameter description

control VCs, A-71
PVCs, A-26

setting
control VCs, 4-58
PVCs, 5-19

Maximum AAL CPCS Transmit SDU Size
parameter description

control VCs, A-71
PVCs, A-25

setting
control VCs, 4-55
PVCs, 5-17

Maximum Burst Size
described, 1-26, 4-51, 5-15
formula for calculating, 4-51, 5-15
parameter description

control VCs, A-70
PVCs, A-25

setting
control VCs, 4-51
PVCs, 5-15

Maximum Data Frame Size
parameter description, A-34
setting, 7-26

maximum transmission unit. See MTU

MBS. See Maximum Burst Size

member configuration files, router redundancy, 
creating, 2-19

menu path, using, A-4

messages, retransmitting, 4-25

Min Memory Threshold parameter, A-47

minimum memory threshold, setting, 4-14

Monitoring Timer
parameter description, A-76
setting, 9-2

MTU
defining, 3-3, 5-3, 8-3
parameter description, A-19

multicast packet support, purpose, 1-27

multiprotocol encapsulation support, 1-13
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N

Next Hop Interface Addr parameter, A-82

NLPID
See also data encapsulation

NLPID, defined, 1-14

No Response Timer
modifying, 4-66
parameter description, A-74

NULL encapsulation
See also data encapsulation

NULL encapsulation, defined, 1-14

Num Messages/Sec for Call Pacing parameter, A-63

Num Restarts ReXmitted
parameter description, A-62
setting, 4-25

Num Stat Enquiries ReXmitted
parameter description, A-63
setting, 4-26

O

OAM Alarm Enable parameter, A-79

OAM Loopback Cell Interval parameter, A-77

OAM Loopback Enable parameter, A-77

OAM parameters, changing, 5-22

OAM parameters, descriptions of, A-77

OAM Threshold 1 parameter, A-78

OAM Threshold 2 parameter, A-78

operational state, LAN emulation, 1-38

Operations and Management parameters, descriptions 
of, A-77

Owner
parameter description, A-32
specifying, 7-16

P

pacing calls, 4-28

parameter descriptions, Site Manager, A-1

parties, defining, 4-9

Path Switching Delay
parameter description, A-39
setting, 7-42

PCR. See Peak Cell Rate

PDU values, defining, 4-67

Peak Cell Rate
described, 1-24, 4-45, 5-11, 8-10
See also Xmit Peak Cell Rate
setting

control VCs, 4-45
PVCs, 5-11
WAN SVCs, 8-10

Per-VC Clipping
enabling/disabling, 3-14
parameter description, A-10

physical layer, described, 1-7

Poll Timer
modifying, 4-65
parameter description, A-73

primary configuration files, router redundancy, 
creating, 2-19

prioritizing traffic, 1-6

priority queueing, 1-6

product support, xxvi

protocol prioritization, 1-6

Protocol Standard
assigning, 4-5
parameter description, A-45

protocols
adding

to existing service record, 2-14
to new service record, 2-13

enabling for
hybrid access (nonbridging), 1-12
LAN emulation, 1-12
PVCs, 2-13, 2-14
WAN SVCs, 2-14

supported, 1-10

publications
hard copy, xxv

PVC parameters, descriptions of, A-21 to A-26

PVCs
access methods for, 1-17 to 1-20
adding, 2-4, 2-15
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and service records, 1-10
copying, 5-23
customizing, 5-1
defining service records for, 2-3
deleting, 5-24
enabling/disabling, 5-9
encapsulation methods, 1-13 to 1-16
hybrid access, 1-19 to 1-21
multiple per service record, 1-17
one per service record, 1-18

R

Recv Peak Cell Rate, parameter description
WAN SVC, A-30

Recvt Sustainable Cell Rate, parameter description
WAN SVC, A-31

redundant LESs, 7-17

Registration Refresh Interval parameter, A-81

Release Sent timer. See T308

response time, LE_ARP. See Expected LE_ARP 
Response Time

Restart Request Sent on Channel timer. See T316c

Restart Request Sent on Interface timer. See T316

restarts, enabling/disabling, 4-27

retransmissions, defining, 4-25

router redundancy, ATM
customizing, 9-1
described, 1-39
starting, 2-1

router redundancy, requirements, 1-40

S

SAAL
customizing, 4-61 to 4-70
Data Link Connect timer. See T309
Data Link Disconnect timer. See TDisc
enabling/disabling, 4-62
parameters, A-72 to A-76

SCR. See Sustainable Cell Rate

SDU size, setting
receive

control VCs, 4-58
PVCs, 5-19

transmit
control VCs, 4-55
PVCs, 5-17

secondary configuration files, creating, 2-20

segmentation and reassembly (SAR) sublayer, 1-8

Select Connection Typre window, using, A-2

Server (LES), redundant, 1-35

Service Name parameter, A-20

service record parameters, descriptions of, A-14 to 
A-20

service records
adding (classical IP), 2-10
adding (LANE), 2-11
adding (PVC), 2-9
adding (WAN SVC), 2-12
customizing

classical IP, 6-1
LEC/LANE, 7-1
PVC, 5-1
WAN SVC, 8-1

data encapsulation types for, 2-8
defined, 1-10
defining

classical IP, 2-4
LEC, 2-4
PVC, 2-3

deleting
classical IP, 6-10
LEC/LANE, 7-50
PVC, 5-6
WAN SVC, 8-7

enabling/disabling
classical IP, 6-2
LEC/LANE, 7-2
PVC, 5-2
WAN SVC, 8-2

Set Retry Count. See ILMI Set Retry Count

Set Timer. See ILMI Set Timer

Setup Sent timer. See T303

show atm interfaces command, B-2

show atm line command, B-3
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show atm services command, B-6

show atm signaling command, B-6

show atm stats vcs command, B-7

show atm vcs command, B-8

show classical-ip configuration command, B-9

show classical-ip interface command, B-9

show classical-ip stats command, B-10

show classical-ip table command, B-10

show commands, B-1

show dsx3 circuits command, B-11

show dsx3 current command, B-12

show dsx3 history command, B-15

show lane configuration command, B-20

show lane data-vcs command, B-20

show lane le-arp command, B-21

show lane le-rd-arp command, B-22

show lane les command, B-23

show lane macs command, B-23

show lane servers command, B-24

show lane stats command, B-25

show sonet circuits command, B-26

show sonet current command, B-27

show sonet history command, B-30

signaling
customizing, 4-1
enabling initially, 2-3
enabling/disabling, 3-17, 4-3
parameters, descriptions of, A-44 to A-63
support, 4-2
timer resolution, defining, 4-15
VCI, changing, 4-42
VPI, changing, 4-40

Signaling AAL. See SAAL

Site Manager, starting ATM with, 2-7

SSCOP
connection control, 4-67
customizing, 4-61 to 4-71
enabling/disabling, 4-62
poll data, 4-69
STAT PDU elements, 4-70
support, 4-61

starting ATM services, 2-1

Status Enquiry Sent timer. See T322

support, Nortel Networks, xxvi

Sustainable Cell Rate
described, 1-25
setting

control VC, 4-49
PVCs, 5-13
WAN SVCs, 8-12

SVC applications, specifying number of, 4-7

SVC Inactivity Timeout
enabling/disabling, 3-7
parameter description, A-7
specifying, 3-7

SVC Inactivity Timeout Enable parameter, A-7

SVCs
access methods, 1-22
and service records, 1-10
encapsulation methods, 1-13 to 1-16

T

T303
parameter description, A-50, A-51, A-52, A-60

T308
parameter description, A-53
setting, 4-18

T309
parameter description, A-54
setting, 4-18

T310
parameter description, A-54
setting, 4-18

T313
parameter description, A-55
setting, 4-19

T316
parameter description, A-56
setting, 4-19

T316c
parameter description, A-57
setting, 4-20
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T322
parameter description, A-58
setting, 4-20

T398
parameter description, A-61
setting, 4-22

T399
parameter description, A-62
setting, 4-22

TDisc
parameter description, A-59
setting, 4-21

technical publications, xxv

technical support, xxvi

template, group configuration file, creating, 2-16

text conventions, xx

thresholds, connection, 4-9

timer resolution, defining, 4-15

timers, modifying
ILMI, 4-31 to 4-38
LEC/LANE, 7-32 to 7-42
See also specific timer
signaling, 4-16 to 4-23
SSCOP/SAAL, 4-65

traffic parameters, modifying
control VCs, 4-45
PVCs, 5-11
WAN SVCs, 8-7

traffic priorities, 1-6

transmission path, defined, 1-5

U

UNI version, assigning, 4-5

unknown frames, controlling, 7-28

User Part Autogeneration
enabling/disabling, 6-4, 7-3
parameter description, A-16

V

VCC Timeout Period Enable
enabling/disabling, 7-34
parameter description, A-37

VCCs, defining maximum number of, 3-21

VCI (signaling)
See also ILMI VCI

VCI Number parameter, A-21

VCI parameter (signaling), A-49

virtual channel identifier (VCI), defined, 1-4

virtual channel, defined, 1-4

virtual circuits. See PVCs or SVCs

Virtual Connection Type parameter, A-15

virtual connections, compared, 1-6

virtual path identifier (VPI), defined, 1-5

virtual path, defined, 1-5

VPCs, defining maximum number of, 3-21

VPI (signaling)
parameter description, A-48
See also ILMI VPI

VPI Number parameter, A-21

VPI/VCI pairs, setting, 2-4
See also VPI Number or VCI Number

W

WAN SVC Routing Mode,parameter description, A-2

WAN SVCs
customizing, 8-1

window path, using, A-2, A-3

windows, accessing, A-2

X

Xmit Burst Size, parameter description
control VCs, A-70
PVCs, A-25

Xmit Peak Cell Rate, parameter description
control VC, A-68
PVC, A-23
WAN SVC, A-28

Xmit Sustainable Cell Rate, parameter description
control VC, A-69
PVC, A-24
WAN SVC, A-29
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